Lucent Technologies
Bell Labs Innovations

DEFINITY ONE™ Communications System
Release 2.0

Installation and Upgrades

555-233-109
Comcode 108671397
Issue Issue 2

June 2000



Copyright O 2000, L ucent Technologies
All Rights Reserved
Printed in U.S.A.

Notice
Every effort was made to ensure that the information in this book was complete
and accurate at the time of printing. However, information is subject to change.

Preventing Toll Fraud

Toll Fraud is the unauthorized use of your telecommunications system by an
unauthorized party (for example, a person who is not a corporate employee,
agent, subcontractor, or working on your company’s behalf). Be aware that there
isarisk of toll fraud associated with your system and that, if toll fraud occurs, it
can result in substantial additional charges for your telecommunications services.

L ucent Technologies Fraud Intervention

If you suspect that you are being victimized by toll fraud and you need technical
assistance or support, call the Technical Service Center’s Toll Fraud Intervention
Hotline at 1-800 643-2353.

Providing Telecommunications Security

Telecommunications security (of voice, data, and/or video communications) is
the prevention of any type of intrusion to (that is, either unauthorized or mali-
cious access to or use of your company’s telecommunications equipment) by
some party.

Your company’s “telecommunications equipment” includes both this Lucent
product and any other voice/data/video equipment that could be accessed viathis
Lucent product (that is, “networked equipment”).

An “outside party” is anyone who is not a corporate employee, agent, subcontrac-
tor, or working on your company’s behalf. Whereas, &’ malicious party” is any-
one (including someone who may be otherwise authorized) who accesses your
telecommuni cations equipment with either malicious or mischievous intent.

Such intrusions may be either to/through synchronous (time multiplexed and/or
circuit-based) or asynchronous (character-, message-, or packet-based) equip-
ment or interfaces for reasons of:

m  Utilization (of capabilities special to the accessed equipment)

m  Theft (such as, of intellectual property, financial assets, or toll -facility
access)

m  Eavesdropping (privacy invasions to humans)
= Mischief (troubling, but apparently innocuous, tampering)

m  Harm such as harmful tampering, dataloss or ateration, regardless of
motive or intent.

Be aware that there may be arisk of unauthorized or maliciousintrusions
associated with your system and/or its networked equipment. Also realize that, if
such an intrusion should occur, it could result in avariety of losses to your
company (including but not limited to, human/data privacy, intellectual property,
material assets, financial resources, labor costs, and/or legal costs).

Your Responsibility for Your Company’s Telecommunications Security
Thefinal responsibility for securing both this system and its networked equip-
ment rests with you - a Lucent customer’s system administrator, your telecommu-
nications peers, and your managers. Base the fulfillment of your responsibility on
acquired knowledge and resources from avariety of sources including but not
limited to:

n Installation documents

n System administration documents

n Security documents

n Hardware-/software-based security tools

n Shared information between you and your peers
n Telecommunications security experts

To prevent intrusions to your tel ecommuni cations equipment, you and your peers
should carefully program and configure your:

= Lucent provided telecommunications system and their interfaces

= Lucent provided software applications, as well as their underlying
hardware/software platforms and interfaces

= Any other equipment networked to your Lucent products

Federal Communications Commission Statement

Part 15: Class A Statement. This equipment has been tested and found to com-
ply with the limits for aClass A digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonabl e protection against harmful
interference when the equipment is operated in acommercial environment. This
equipment generates, uses, and can radiate radio-frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful inter-
ference to radio communications. Operation of this equipment in aresidential
areaislikely to cause harmful interference, in which case the user will be
required to correct the interference at his own expense.

Part 68: Network Registration Number. This equipment is registered with the
FCC in accordance with Part 68 of the FCC Rules. It isidentified by FCC regis-
tration number AS593M-13283-MF-E. Refer to[' Federal Communications Com- |
[mission Statement]’ in “ About This Book” for more information regarding Part
68.

Canadian Department of Communications (DOC)

Interference Information

This digital apparatus does not exceed the Class A limits for radio noise emis-
sions set out in the radio interference regulations of the Canadian Department of
Communications.

Le Présent Appareil Nomérique n’ émet pas de bruits radioél ectriques dépassant
les limites applicables aux appareils numériques de laclass A préscrites dansle
reglement sur le brouillage radioél ectrique édicté par le ministére des Communi-
cations du Canada.

Trademarks

See|'About This Book.”

Ordering Information

Call: L ucent Technologies Publications Center

Voice 1 800 457-1235International Voice 317 361-5353
Fax 1 800 457-1764International Fax 317 361-5355

L ucent Technologies Publications Center

PO. Box 4100

Crawfordsville, IN 47933

Document No. 555-233-109

Comcode 108671397
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Write:

Order:

For additional documents, refer to the section in “About This Book” entitled

You can be placed on a standing order list for this and other documents you may
need. Standing order will enable you to automatically receive updated versions of
individual documents or document sets, billed to account information that you
provide. For more information on standing orders, or to be put on alist to receive
future issues of this document, contact the Lucent Technologies Publications
Center.

European Union Declaration of Conformity
The“CE" mark affixed to the DEFINITY ONE equipment described in this book
indicates that the equipment conforms to the following European Union (EU)
Directives:

= Electromagnetic Compatibility (89/336/EEC)

= Low Voltage (73/23/EEC)

= Telecommunications Terminal Equipment (TTE) i-CTR3 BRI and i-CTR4

PRI

For more information on standards compliance, contact your local distributor.
Comments

To comment on this document, return the comment card at the end of the docu-
ment.
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Conventions used in this book XV
About This Book

This document provides procedures to install, upgrade, or add to a DEFINITY
ONE™ Communications System (hereafter referred to as DEFINITY ONE), using
the compact modular cabinet (CMC) with the TN795 circuit pack.

This document is intended for use by trained installation technicians who have
Windows NT and local area network (LAN) training.

DEFINITY ONE is a high-functionality communications system for customers in
the 25-40 line size or smaller with growth potential to 168 stations. This offer
provides DEFINITY® software, INTUITY® AUDIX® messaging, and DEFINITY Site
Administration (DSA) on a single hardware platform.

Conventions used in this book

Circuit pack codes (such as TN763D) are shown with the minimum acceptable
alphabetic suffix (like the “D” in the code TN763D).

Generally, an alphabetic suffix higher than that shown is also acceptable.
However, not every vintage of either the minimum suffix or a higher suffix code is
necessarily acceptable.

=>» NOTE:

Refer to Technical Monthly: Reference Guide for Circuit Pack
Vintages and Change Notices for current information about usable
vintages of specific circuit pack codes (including the suffix).

The following conventions describe the systems referred to in this document.

» System is a general term encompassing Release 2.0 and includes
references to DEFINITY ONE.

» Information is applicable for Release 2.0 unless otherwise specified
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Related documents

XVi

DEFINITY ONE Communications System is abbreviated as DEFINITY
ONE.

Physical dimensions in this book are in inches followed by metric
centimeters (cm) in parentheses. Wire gauge measurements are in
American Wire Gauge (AWG) followed by the cross-sectional area in
squared millimeters (mmz) in parentheses.

Related documents

The following documents provide supplemental information when installing a
DEFINITY ONE Release 2.0 system:

BCS Products Security Handbook (555-025-600)
BCS Products Security Handbook Addendum (555-025-600ADD)

DEFINITY Enterprise Communications Server Release 8.2 Installation for
Adjuncts and Peripherals (555-233-116)

DEFINITY Enterprise Communications Server Release 8.2 Administrator’s
Guide (555-233-506)

DEFINITY Enterprise Communications System Release 8.2 Administration
for Network Connectivity (555-233-504)

DEFINITY ONE Communications System Release 2.0 Maintenance
(555-233-111)

DEFINITY ONE Communications System Release 2.0 Overview
(555-233-001)

DEFINITY Enterprise Communications Server Release 8.2 System
Description (555-230-211)

DEFINITY Communications System Terminals and Adjuncts, Reference
(555-015-201)

DEFINITY ONE Communications System Release 2.0 Installation Quick
Reference (555-233-738)

How to order documentation

You can order documentation directly from the Lucent Technologies Business
Communications System Publications Fulfillment Center at 1-317-322-6791 or toll
free at 1-800-457-1235, or at www.lucent.com/enterprise/documentation.
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How to comment on this book
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XVii

Lucent Technologies welcomes your feedback. Please complete the reader
comment card at the front of this book and return it. Your comments are of great

value and will help us improve our documentation.

If the reader comment card is missing, fax your comments to 1-732-817-4009 or
to your Lucent Technologies representative, and specify this document’s name
and number, DEFINITY ONE Communications System Release 2.0 Installation

and Upgrades, (555-233-109).

Where to call for technical support

Telephone number

Streamlined Implementation (for missing equipment)

1-800-772-5409

USA/Canada Technical Service Center

1-800-248-1234

Technical Service Center Initialization and Database
Administration System (INADS)

1-800-248-1111

International Technical Assistance Center

1-720-444-9990

DEFINITY Helpline (software assistance)

1-800-225-7585

Lucent Technologies Toll Fraud Intervention

1-800-643-2353

Lucent Technologies Technical Care Center

1-800-242-2121

DEFINITY Site Administration (DSA) Domestic

1-800-242-2121

INTUITY AUDIX Helpline

1-800-242-2121

TSC Repair

1-800-242-2121

DEFINITY Maintenance and Service

1-800-242-2121

Call Accounting support

1-800-242-2121

UPS support

1-800-242-2121
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Security issues

To assist customers with security issues, Lucent Technologies offers services that
can reduce toll-fraud liabilities. For more information, contact your Lucent
Technologies representative.

=> NOTE:
Login security is an attribute of the DEFINITY ONE Release 2.0 software.

Trademarks

This document contains references to the following Lucent Technologies
trademarked products:

« AUDIX®

= CallVisor®

« DEFINITY®

» DEFINITY ONE™ Communications System
= INTUTY®

« CentreVu®
=« BCMSW®

The following products are trademarked by their appropriate vendor:
» LINX™ is a trademark of lllinois Tool Works, Incorporated

» Netscape Navigator® is a registered trademark of Netscape
Communications Corporation

. pcAnyWhere® is a registered trademark of Dynamic Microprocessor
Associates

= Windows NT™ is a trademark, and Windows® is a registered trademark,
of Microsoft Corporation.

» Paradyne™ is a trademark of Paradyne Corporation

= U.S. Robotics®is a registered trademark of U.S. Robotics Corporation.
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Standards compliance

The equipment presented in this document complies with the following

standards:

For more information, contact your Lucent Technologies representative.

ITU-T (Formerly CCITT)
IPNS

DPNSS

National ISDN-1
National ISDN-2
ISO-9000

ANSI

FCC Part 15 and Part 68
EN55022

EN50081

EN50082

CISPR22

IEC 825

IEC 950

UL 1459

UL 1950

UL19501

CSA C222 Number 225
TS001

Australia AS3548 (AS/NZ3548)

ECMA

Issue 2
June 2000
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Electromagnetic compatibility standards XX

Electromagnetic compatibility
standards

This product complies with and conforms to the following standards:

= Limits and Methods of Measurements of Radio Interference
Characteristics of Information Technology Equipment, EN55022
(CISPR22), 1993

» EN50082-1, European Generic Immunity Standard

» FCC Part 15

= Australia AS3548

=>» NOTE:

The system conforms to Class A (industrial) equipment. Voice
terminals meet Class B requirements.

» Electrostatic Discharge (ESD) IEC 1000-4-2

» Radiated radio frequency field IEC 1000-4-3

» Electrical Fast Transient IEC 1000-4-4

The system conforms to the following standards:

» Electromagnetic compatibility General Immunity Standard, part 1;
residential, commercial, light industry, EN50082-1, CENELEC, 1991

» Issue 1 (1984) and Issue 2 (1992), Electrostatic discharge immunity
requirements IEC 1000-4-2

» Radiated radio frequency field immunity requirements IEC 1000-4-3
» Electrical fast transient/burst immunity requirements IEC 1000-4-4
=« Power Harmonics IEC 61000-3-2, 1995

Anti-static protection

A CAUTION:

When handling circuit packs or any components of a DEFINITY ONE
system, always wear an anti-static wrist ground strap. Connect the strap to
an approved ground such as an unpainted metal surface on the DEFINITY
ONE system.
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Remove/install circuit packs

A CAUTION:

The control circuit packs with white labels cannot be removed or installed
when the power is on. The port circuit packs with gray labels (older version
circuit packs had purple labels) can be removed or installed when the
power is on.

Federal Communications Commission
statement

Part 68: Statement

Part 68: Answer-Supervision Signaling. Allowing this equipment to be operated in
a manner that does not provide proper answer-supervision signaling is in
violation of Part 68 rules. This equipment returns answer-supervision signals to
the public switched network when:

» Answered by the called station
» Answered by the attendant

» Routed to a recorded announcement that can be administered by the
Customer-premises equipment (CPE) user

This equipment returns answer-supervision signals on all Direct Inward Dialing
(DID) calls forwarded back to the public switched telephone network.
Permissible exceptions are:

» Acallis unanswered.
= A busy tone is received.

= Areorder tone is received.

Lucent Technologies attests that this registered equipment is capable of
providing users access to interstate providers of operator services through the
use of access codes. Modification of this equipment by call aggregators to block
access dialing codes is a violation of the Telephone Operator Consumers Act of
1990.

This equipment complies with Part 68 of the FCC Rules. A label is provided on
this equipment that contains, among other information, the Federal
Communications Commission (FCC) registration number and ringer equivalence
number (REN) for this equipment. If requested, this information must be provided
to the telephone company.
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The REN is used to determine the quantity of devices which may be connected
to the telephone line. Excessive RENs on the telephone line may result in devices
not ringing in response to an incoming call. In most, but not all areas, the sum of
RENSs should not exceed 5.0. To be certain of the number of devices that may be
connected to a line, as determined by the total RENs, contact the local telephone
company.

=>» NOTE:

The REN is not required for some types of analog or digital facilities.

Means of Connection (U.S))

Connection of this equipment to the U.S. telephone network is shown in the
following table.

SOC/REN/

Manufacturer’s Port Identifier | FIC Code A.S. Code Network jacks
Off/On Premises Station OL13C 9.0F RJ2GX, RJ21X,

RJ11C
DID Trunk 02RV2-T 0.0B RJI2GX, RJ21X
central office (CO) Trunk 02GS2 0.3A RJ21X
CO Trunk 02LS2 0.3A RJ21X
Tie Trunk TL31M 9.0F RJ2GX
1.544 Mbps Digital Interface 04DU9-B,C 6.0P RJ48C, RJ48M
1.544 Mbps Digital Interface 04DU9-BN,KN 6.0P RJ48C, RJ48M
120A2 Channel Service Unit 04DU9-DN 6.0P RJ48C

If the terminal equipment (DEFINITY ONE system) causes harm to the telephone
network, the telephone company will notify you in advance that temporary
discontinuance of service may be required. But, if advance notice is not
practical, the telephone company will notify the customer as soon as possible.
Also, you will be advised of your right to file a complaint with the FCC if you
believe it is necessary.

The telephone company may make changes in its facilities, equipment,
operations or procedures that could affect the operation of the equipment. If this
happens, the telephone company will provide advance notice so you can make
necessary modifications to maintain uninterrupted service.
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If trouble is experienced with this equipment, please contact the Technical
Service Center at 1-800-242-2121 for repair or warranty information. If the
equipment is causing harm to the telephone network, the telephone company
may request that you disconnect the equipment until the problem is resolved.

It is recommended that repairs be performed by Lucent Technologies certified
technicians.

The equipment cannot be used on public coin phone service or on party-line
service provided by the telephone company. Connection to party line service is
subject to state tariffs. Contact the state public utility commission, public service
commission or corporation commission for information.

This equipment is hearing-aid compatible when used with a telephone receiver.
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Install and Cable the Cabinet

This chapter describes the process for installing and cabling the cabinet to
physically connect and access DEFINITY ONE.

=>» NOTE:
Physical installation and cabling of the cabinet is basically the same as the
ProLogix cabinet and cabling, with exception of the processor interface
cable (multileg cable) and absence of the system access terminal (SAT).
Software, such as DEFINITY, should not be accessed until cabling and
installation of the cabinet is completed. Only 1 cabinet is supported.

This chapter is organized as follows:

= [‘Check customer’s order”’|on page 1-2
= |‘Correct shipping errors”|on page 1-2

= [|‘Unpack and inspect”|on page 1-2

= |‘Install the system cabinet”|on page 1-6

= |‘Check AC power and ground’fon page 1-12

= |‘Cable the system”|on page 1-20

» [“Install main distribution frame (MDF) and external modem”Jon page 1-21
« [“Install equipment room hardware”|on page 1-24

= |‘Setringing option”’jon page 1-38

= |‘Install and wire telephones and other equipment”jon page 1-40

= [‘Connect external alarms and auxiliary connections’”lon page 1-53

= |‘Install the BRI terminating resistor”jon page 1-56

= |‘“Install multi-point adapters’”|lon page 1-60
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« [“Install off-premises station wiring” [on page 1-63

« [“Install emergency transfer panel and associated telephones”lon page
1-68

« [‘Connect modem”|on page 1-77

« [‘Connect modem to telephone network’ [on page 1-76

« [‘Set neon voltage to prevent ring ping”jon page 1-78

« [‘Complete installation”[on page 1-79

« [‘View LEDs to determine power and fan alarm state”|on page 1-79

Check customer’s order

1. Check the customer’s order and the shipping packing lists to confirm that
all equipment is included.

2. Report missing equipment to a Lucent Technologies representative.

3. Check the system adjuncts for damage and report all damage according
to local shipping instructions.

Correct shipping errors

1. Red-tag all defective equipment and over-shipped equipment and return
according to the nearest Material Stocking Location (MSL) instructions.

2. Direct all short-shipped reports to the nearest MSL. Contact the
appropriate location for specific instructions. For streamlined
implementation, call 1-800-772-5409.

Unpack and inspect

A CAUTION:

Use lifting precautions! A fully loaded system weighs 58 Ibs (26.3 kg). If the doors,
power unit, and circuit packs are removed, the unit weighs only 29 Ibs (13.1 kg).

1. Verify the equipment received. See Actual equipment may vary
in appearance and may ship in separate packages. Equipment comcodes

are listed in|Table 1-1.

2. Before mounting the cabinet, remove the cabinet doors by opening them
and lifting them straight up and off the hinge pins.
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Figure notes

1.
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Left panel (also acts as a wall-mount template 7. Processor interface cable
and as a floor mount pedestal) 8. single-point ground block
- CMC cabinet 9. 14-inch (35.5 cm) 6 AWG (#40) (16
. Right panel mm2) ground wire
. External modem (not shipped with all systems) 10. Flash disk (backup)
. #12 x 1-inch shoulder screws
. AC power cord (NEMA 5-15P or IEC 320)

Figure 1-1.

Equipment packed with the compact modular cabinet (CMC)
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Table 1-1 lists the comcodes for equipment used with the CMC. If “Optional” is
checked, the equipment may or may not be necessary, depending on the site

configuration.
Table 1-1. Comcodes for equipment used with the CMC
Comcode Description Optional

847951662 | Left Panel

847951670 | Right Panel

847915238 | Right Door

847915246 | Left Door

601929763 | Processor Interface Cable (Multileg cable)

103557484 | TN795 Processor Circuit Pack

848320800 | Hard Disk Programmed

40763399 External Modem X

601929920 | Software CDs

408276897 | PCMCIA Ethernet Adapter Card

408166783 | Flash Disk (For Backup)

105631527 | time-division multiplexing/local area network (TDM/LAN)
Bus Terminator (AHF110)

706827717 | Single-Point Ground Block

H600-487 14-inch (35.5 cm) 6 AWG (#40) (16 mm2) Green Ground
Wire

847987187 | CMC 110 Cross-Connect Assembly (Main Distribution X
Frame) - Recommended

407676691 | 120 VAC Power Distribution Unit (145D 6-AC) X

107949364 | 650A Power Supply

848082715 | Fan Assembly

407745009 | Fan Air Filter

848477634 | LAN Crossover Cable (RJ45), 12-foot

405362641 | 120 VAC Power Cord

106278062 | Apparatus Blank (Circuit Pack Blank) (158P)

106606536 | Integrated Channel Service Unit (ICSU) (120A2)

107988867 | DS1 Loopback Jack (T1 Only) (700A)

Continued on next page
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Table 1-1. Comcodes for equipment used with the CMC — Continued
Comcode Description Optional
107152969 | 75 Ohm DS1 Coaxial Adapter (888B) X
403613003 | 157B Connecting Block (“sheak current protectors”) X
406948976 | 6SCP-110 Protector X
107435091 | 507B Sneak Current Fuse Panel X
407216316 | 220029 Sneak Current Fuse X
103970000 | Main Distribution Frame Label (Code 220A) X
104307327 | C6C cable — 50-foot (15.2 m) shielded Digital Signal X
Level 1 (DS1) cable with 50-pin male to 15-pin male
104307376 | C6D cable — 50-foot (15.2 m) shielded DS1 cable with X
50-pin male on each end
104307434 | C6E cable — 100-foot (30.5 m) shielded DS1 cable with | X
50-pin male to 50-pin female
104307475 | C6F cable — 50-foot (15.2 m) shielded DS1 cable with X
50-pin male to 3 inch (7.62 cm) stub
102381779 | 3B1A Carbon Block X
104410147 | 3B1E-W Wide Gap Gas Tube X
105514756 | 3C1S Analog Line Protector - Solid State X
102904893 | 4B1C Carbon Block with Heat Coll X
104401856 | 4B1E-W Wide Gap Gas Tube w/Heat Coil X
104386545 | 4C1S Analog Line Protector - Solid State with Heat Coil X
105581086 | 4C3S-75 Digital Voice Circuit Protector - Solid State X
406144907 | ITW LINX Gas Tube, Avalanche Suppress X
901007120 | ITW Linx Ground Bar (used with above) X
406304816 | ITW Linx Replacement Fuse X
103972758 | Data Link Protector (1 circuit) X
103972733 | Data Link Protector (8 circuits) X
407063478 | Electrostatic Discharge (ESD) Wrist Strap
107949364 | Lucent online 650A UPS
407691401 | 23A2 Alarm Adapter
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Install the system cabinet

The cabinet can be installed either floor-mounted or wall-mounted. Set the
Carrier Address ID as per Figure 1-2 before installing the cabinet.

Verify the carrier address 1D

swdmdip2 KLC 051399

Figure 1-2. Setting carrier address ID (right side)

Proceed to either|[“Eloor-mount the cabinet’|on page 1-7 or to|“Wall-mount the|
cabinet”|on page 1-8.
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Floor-mount the cabinet

The cabinet dimensions (with floor pedestal) are 28.5 in. (72.4 cm) high, 24.5 in.
(62.2 cm) wide, and 12 in. (30.5 cm) deep. Maintain a service clearance of 12 in.
(30.5 cm) on the left, right, and front of the cabinet.

1. Floor-mount the cabinet as per Figure 1-3.

Cé) indmflor KLC 110397

Figure notes

1. Left panel (floor-mount pedestal) 3. 12 inches (30.5 cm) minimum from
nearest object (required to service

2. #12 x 1-inch shoulder screws o
the circuit packs)

Figure 1-3. Typical floor mount installation

2. Proceed to|“Cable the system’|on page 1-20.
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Wall-mount the cabinet

A CAUTION:
A fully loaded system weighs 58 Ibs (26.3 kg). Use lifting precautions. The unit weighs
29 Ibs (13.1 kg) with the doors, power unit, and circuit packs removed.

Install plywood backing on wall. The install technician must provide the plywood
and the hardware for mounting.

=>» NOTE:

The following plywood dimensions account for the extra space needed to
install the panels on each side of the cabinet. The cabinet is 24 inches
(0.6 m) wide and each panel is 12 inches (0.3 m) wide.

1. Install a 3/4-inch (2 cm) thick sheet of 2 x 4-foot (0.6 x 1.2 m) plywood
horizontally onto the wall. See

2. Ensure that the top of the plywood is at least 54 inches (137 cm) from the
floor.
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Install cabin

et — wall-mount

(30.5 cm)

A" T T eI i e

54"
(137 cm)
5" (12.7 cm)
\ 4
indmpnl3 KLC 110397
Figure 1-4. Left panel used as mounting template

The following are procedures for wall mounting the cabinet:

Place the template on the wall with the top surface level.

Mark two 1/8-inch (0.3-cm) pilot holes in the mounting hole locations.
Remove the template from the wall.

Drill the two pilot holes.

I A

Thread two #12 x 1-inch shoulder screws partially into the holes.
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6. Set the cabinet onto the wall and align the slots with the shoulder screws.
See Figure 1-5. Slide the cabinet to the left to hold it in place. Tighten the
screws securely.

Figure notes

1. #12 x 1-inch shoulder screws 2. #12 x 1-inch safety screw

Figure 1-5. Typical wall-mount installation

7. Drill 2 lower mounting holes using the cabinet as a template.

8. Thread the 2 lower screws and tighten.

A CAUTION:
Ensure the right bottom safety screw is in place and tight.
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Install left and right panels — wall-mount

—

o

indmins3 KLC 091197

Figure notes

1. Left panel 2. Right panel

Figure 1-6. Left and right panel installation

1. Align the cutouts in the panels with the cabinet hinges.

2. Drill a 1/8-inch (0.3 cm) pilot hole into the wall and secure the panels with
the #12 x 1-inch shoulder screws.
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Check AC power and ground

A CAUTION:
The alternating current (AC) power circuit must be dedicated to the system. The circuit
must not be shared with other equipment and must not be controlled by a wall switch.
The AC receptacle must not be located under the Main Distribution Frame and must
be easily accessible.

A CAUTION:

The latch only removes direct current (DC) power from the cabinet. Unseating the
power supply removes AC power from the power supply, but not from the cabinet. To
remove AC power from the cabinet, pull the AC power cord from the AC appliance
connector on the rear of the cabinet.

A CAUTION:
System grounding must comply with the general rules for grounding provided in Article
250 of the National Electrical Code (NEC), National Fire Protection Agency (NFPA) 70,
or the applicable electric code in the country of installation.

A CAUTION:
AC mains wiring and testing must be performed by a qualified electrician and must
conform to Article 250 of the NEC, NFPA 70, or the applicable electric code in the
country of installation.

Check AC power

Each CMC uses an auto-ranging (85 to 264 VAC) power supply, 47 to 63 Hz, 330
Watts, 4.5 Amps (100-120 VAC) or 2.3 Amps (200 to 240 VAC), at 500 VoltAmps
(VA).

The AC power source can be 1 phase of 120 VAC with neutral (100 VAC for
Japan) with 15-Amp circuit breaker, or 1 phase of 220 or 240 VAC (200 VAC for
Japan) with 10-Amp circuit breaker. The AC cord uses a NEMA 5-15P plug or an
IEC 320 plug.

Before powering up the system, check the AC power in the equipment room
using a KS-20599 digital voltmeter (DVM) (or equivalent).

1. Measure the AC voltage between the hot and neutral sides of the
receptacle.

2. Depending on the AC power source, verify that the meter reads 90 to 132
VAC or 180 to 264 VAC. If not, have a qualified electrician correct the
problem.
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3. Measure the voltage between the neutral and ground sides of the
receptacle.

4. Verify that the meter reads 0 VAC. If not, have a qualified electrician
correct the problem.

5. When finished, set the AC main circuit breakers to OFF.

Approved grounds

An approved ground is the closest acceptable medium for grounding the
building entrance protector, entrance cable shield, or single-point ground of
electronic telephony equipment. If more than 1 type of approved ground is
available on the premises, the grounds must be bonded together as required in
Section 250-81 of the National Electrical Code.

Grounded Building Steel — The metal frame of the building where it is
effectively grounded by 1 of the following grounds: acceptable metallic water
pipe, concrete encased ground, or a ground ring.

Acceptable Water Pipe — A metal underground water pipe, at least 1/2 inch
(1.3 cm) in diameter, in direct contact with the earth for at least 10 feet (3 m). The
pipe must be electrically continuous (or made electrically continuous by bonding
around insulated joints, plastic pipe, or plastic water meters) to the point where
the protector ground wire connects. A metallic underground water pipe must be
supplemented by the metal frame of the building, a concrete-encased ground, or
a ground ring. If these grounds are not available, the water pipe ground can be
supplemented by 1 of the following types of grounds:

» Other local metal underground systems or structures — Local
underground structures such as tanks and piping systems

» Rod and pipe electrodes — A 5/8-inch (1.6-cm) solid rod or 3/4-inch
(2-cm) conduit or pipe electrode driven to a minimum depth of 8 feet (2.4
m)

» Plate electrodes — Must have a minimum of 2 square feet
(0.185 square m) of metallic surface exposed to the exterior soil

Concrete Encased Ground — An electrode encased by at least 2 inches

(5.1 cm) of concrete and located within and near the bottom of a concrete
foundation or footing in direct contact with the earth. The electrode must be at
least 20 feet (6.1 m) of 1 or more steel reinforcing bars or rods 1/2-inch (1.3 cm)
in diameter, or at least 20 feet (6.1 m) of bare, solid copper, 4 AWG (26 mmz)
wire.

Ground Ring — A buried ground that encircles a building or structure at a depth
of at least 2.5 feet (0.76 m) below the earth’s surface. The ground ring must be at
least 20 feet (6.1 m) of 2 AWG (35 mmz), bare, copper wire.
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Approved floor grounds

A cauTion:

If the approved ground is inside a dedicated equipment room, then these
connections must be made by a qualified electrician.

Floor grounds are those grounds on each floor of a high-rise building that are
suitable for connection to the ground terminal in the riser closet and to the
cabinet single-point ground terminal. Approved floor grounds may include:

Building steel

The grounding conductor for the secondary side of the power transformer
feeding the floor

Metallic water pipes
Power-feed metallic conduit supplying panel boards on the floor

A grounding point specifically provided in the building for the purpose

Uninterruptible power supply

A recommended UPS (Uninterruptible Power Supply) may be used for power
holdover. The type of UPS depends on the holdover requirements. Total holdover
provides for times that vary from less than 10 minutes to up to 8 hours. The UPS
must provide surge protection for the CMC cabinet.

1.

Connect the UPS to an electrical outlet capable of handling the power
requirements of the cabinets:

a. 100 VAC, 4.5 Amps.
b. 120 VAC, 3.8 Amps.
c. 200 VAC, 2.3 Amps.
d. 220-240 VAC, 2.0 Amps.

Ensure the cabinet is connected to an “unswitched” or “always on”
electrical outlet on the UPS.

. Connect and administer the UPS. See [‘Connect external alarms and|

[auxiliary connections”|on page 1-53.

=>» NOTE:

If the UPS is wired as recommended, holdover time for each power outage
is 1 minute before an automatic shutdown. UPS may handle any
subsequent power outage based on its total battery capacity.
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Cabinet power switch

A cauTion:
The latch acts as the DC power switch and only removes DC power from
the cabinet, not AC power. To remove AC power, pull the AC power cord
from the appliance inlet. See Figure 1-7.

I evdmrin2 EWS 042500

Figure 1-7. CMC power supply

Figure notes
1. Latch
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Connect cabinet grounds and other grounds

Follow these additional grounding requirements:

= The approved ground wire must be green, 6 AWG (#40) (16 mmz), coppet,
stranded wire. This is in addition to the ground wire in the AC power cord.

= Bond all approved grounds at the single-point ground to form a single
grounding electrode system.

Install the ground block
1. Mount the ground block as shown in Figure 1-8.
2. Connect the cable as shown in
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indmingb RPY 012398
Figure notes
1. #12 x 1-inch shoulder screws 2. Single-point ground block

Figure 1-8. Ground block installation to right panel
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Figure notes
1. 6 AWG (#40) (16 mm?) cabinet 4. 10 AWG (#25) (6 mm?) wire to
ground wire coupled bonding conductor (CBC)
2. Single-point ground block 5. 6 AWG (#40) (16 mm?) ground wire

from single-point ground block to the

3. AC load center single-point AC load center single-point ground

ground

Figure 1-9. Typical cabinet grounding
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Install coupled bonding conductor

The Coupled Bonding Conductor (CBC) provides mutual inductance coupling
between the CBC and the telephone cables exposed to lightning. The conductor
can be a 10 AWG (#25) (6 mmz) wire tie wrapped to the exposed cables, a metal
cable shield around the exposed cables, or 6 spare pairs from the exposed
cable.

For a high rise building, connect the CBC to an approved building ground on
each floor. To provide the coupled bonding protection:

1. Connect 1 end of the conductor to a telephone cable building entrance
protector ground that is connected to an approved ground.

2. Route the conductor next to the exposed telephone cables being
protected until it reaches the cross-connect nearest to the telephone
system.

3. Position the non-exposed telephone cables at least 12 inches (30.5 cm)
away from exposed telephone cables whenever possible.

4. Terminate the other end to the single-point ground block provided for the
telephone system.

Connect and route the power cords

A CAUTION:
The AC power cord may connect to a properly rated power distribution unit,
individual AC power receptacles, or to a UPS. See|Figure 1-10.
1. Ensure the circuit breakers at the AC load center are OFF.

2. Connect the cabinet to an “unswitched” or “always on” electrical outlet.



DEFINITY ONE™ Communications System Release 2.0 Issue 2

Installation and Upgrades 555-233-109 June 2000
Install and Cable the Cabinet
Check AC power and ground 1-19

o (J
)
(==
e &
G, B
'
e
o)
| T
pcdmécme KLC 091499

Figure notes

1. Cabinet AC power cord 2. Surge-protected AC power
distribution unit (120 VAC
systems) (optional)

Figure 1-10. Routing AC power cords to a power distribution unit
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Cable the system

See Figure 1-11 while performing this procedure.

Install Processor Interface cable and TDM/LAN
bus terminators

cadm2mds KLC 051499

Figure notes
1. TDM/LAN bus terminator 2. Processor interface cable (slot 2)

Figure 1-11. System cable connections

1. Install the TDM/LAN bus terminators.

2. Connect the Processor Interface Cable to the slot 2 connector behind the
cabinet. See Figure 1-11.
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Install main distribution frame
(MDF) and external modem

Install the MDF

A CAUTION:
The optional MDF is a special 110 cross-connect field that is smaller than the standard
110 cross-connect hardware. Do not install standard 110 hardware inside the right
panel.

=>» NOTE:

The depth of any equipment installed inside the right panel must not exceed 2.5
inches (6.3 cm), or the right cover panel will not fit over the right panel.
The optional MDF represents the trunk/auxiliary field.

= Mount the optional MDF to the right panel using the following procedure:

Bottom-mounted MDF with modem

1. On the rear of the MDF, cut the cable tie securing the top 5 cables to the
MDF mounting frame.

2. Mount the MDF to the right panel. See|Figure 1-12.

3. Secure all 10 cables to the bottom left bracket on the MDF with a cable tie.
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Figure notes
1. Main distribution frame (MDF)

2. External modem

=>

NOTE:
The right cover will not fit if a

cable is plugged into slot 1,
even though one is shown in

Figure 1-12

cadmrpn4 KLC 051399

3. Processor interface cable (connect P2
to modem)
4. #12 x 1-inch shoulder screw

Figure 1-12. Typical bottom-mount MDF and modem cable routing
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Install the external modem

The U.S. Robotics external modem is the recommended external modem.
DEFINITY ONE systems operate with this modem set to factory default settings.

=>» NOTE:
You may use a locally obtained, type-approved external modem (33.6 Kbps
or higher and V.34 protocol). Contact your Lucent Technologies
representative for more information.

A WARNING:
If you use a modem other than the U.S. Robotics modem, it must be
configured in NT.

1. Use the hardware provided with the modem. See|Eigure 1-12 |If
top-mounting MDFs, mount the external modem to the plywood in a
location which allows the standard connection to the modem cable.

2. Route the modem cable (P2) from the Processor Interface Cable through
the cable trough and to the modem.

3. Connect the cable to the modem. See|ADDendix A,|“Cab|e Pinouts” for the
pinout of the modem cable.

4. Plug the modem power cord into an electrical outlet and turn on the
modem.

[“Modem configuration and administration” lon page 9-5 describes information
about modem setup, administration, settings, and testing.
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See DEFINITY Communications System Generic 1 and Generic 3 Main
Distribution Field Design, 555-230-630, for more information.

Cross-connect the cabinet to the MDF

1. Cross-connect the ports on the trunk and line circuit packs to the MDF as

required. See|Eigure 1-14.

Allowable and non-allowable circuit packs

Table 1-2 lists the circuit packs that can and cannot be used with Release 2.0 of
DEFINITY ONE.

Table 1-2. Circuit packs and circuit modules

Apparatus

code Name Allowable

650A AC Power Unit Yes

982LS Current Limiter No

CFY1B Current Limiter No

CPP1 Memory Expansion No

ED-1E546 DEFINITY AUDIX R3 System No

(TN566)

(TN567)

ED-1E546 CallVisor Adjunct-Switch Application Interface (ASAI) | No

(TN2208) over the DEFINITY (LAN) Gateway R1

(TN2170)

J58890M-1 CallVisor ASAIl/Call Visor PC/LAN over the DEFINITY No

(TN801) LAN Gateway Release 2.0

NAA1 Fiber Optic Cable Adapter Circuit Pack Yes

TN417 Auxiliary Trunk Yes

TN419B Tone-Clock No

TN420B/C Tone Detector No

TN429/B/C/D Analog Direct Inward/Outward Dialing (DIOD) Central | Yes
Office Trunk

TN429C Analog Central Office Trunk Yes

Continued on next page
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Table 1-2. Circuit packs and circuit modules — Continued
Apparatus
code Name Allowable
TN429D Analog DIOD Trunk - Analog Loop Start Yes
TN433 Speech Synthesizer Yes
TN436B Direct Inward Dialing Trunk Yes
TN437B Tie Trunk Australia (future availability) Yes
TN438B Central Office Trunk Yes
TN439 Tie Trunk Yes
TN447 Central Office Trunk Yes
TN457 Speech Synthesizer Yes
TN459B Direct Inward Dialing Trunk Yes
TN464F DS1 Interface - T1, 24 Channel - E1, 32 Channel Yes
TN465B/C Central Office Trunk Yes
TN467 Analog Line Yes
TN468B Analog Line Yes
TN479 Analog Line Yes
TN553 Packet Data Line Yes
TN556C/D Integrated Services Digital Network -Basic Rate Yes
Interface 4-Wire S/T-NT Interface (ISDN-BRI)
TN568 DEFINITY AUDIX Slim No
TN570B/C Expansion Interface No
TN572 Switch Node Clock No
TN573B Switch Node Interface No
TN574 DS1 Converter - T1, 24 Channel No
TN577 Packet Gateway No
TN722B DS1 Tie Trunk Yes
TN725B Speech Synthesizer Yes
TN726B Data Line Yes
TN735 Multibutton Electronic Telephone (MET) Line Yes
TN742 Analog Line Yes

Continued on next page
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Table 1-2. Circuit packs and circuit modules — Continued
Apparatus
code Name Allowable
TN744B/C Call Classifier No
TN744D Call Classifier - Detector Yes
TN746B Analog Line Yes
TN747/B Central Office Trunk Yes
TN748B/C/D Tone Detector No
TN750B Announcement No
TN750C Announcement Yes
TN753/B Direct Inward Dialing Trunk Yes
TN754/B/C Digital Line 4-Wire DCP Yes
TN755/B Neon Power Unit No
TN756 Tone Detector/Generator No
TN758 Pooled Modem Yes
TN760B/C/D/E | Tie Trunk Yes
TN762/B Hybrid Line Yes
TN763B/C/D Aucxiliary Trunk Yes
TN765 Processor Interface No
TN767B/C/D/E | DS1 Interface - T1, 24 Channel Yes
TN768 Tone-Clock No
TN769 Analog Line Yes
TN771/D Maintenance/Test No
TN772 Duplication Interface No
TN775/B/C Maintenance No
TN776 Expansion Interface No
TN777B Network Control No
TN778 Packet Control No
TN780 Tone-Clock No
TN787F/G/HIJ/K | Multimedia Interface No
TN788B Multimedia Voice Conditioner No

Continued on next page
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Table 1-2. Circuit packs and circuit modules — Continued
Apparatus
code Name Allowable
TN789 Radio Controller Yes
TN790B Processor No
TN791 Analog Line Yes
TN792 Duplication Interface No
TN793 Analog Line, 24-Port, 2-Wire Yes
TN794 Network Control/Packet Interface (NetPkt) No
TN795 Processor Yes
TN798B Processor No
TN799/B Control LAN (C-LAN) Yes
TN801 LAN Gateway Interface No
TN802/B Internet Protocol (IP) Trunk Yes
TN1648/B System Access/Maintenance No
TN1650B Memory No
TN1654 DS1 Converter - T1, 24 Channel/E1, 32 Channel No
TN1655 Packet Interface No
TN1656 Tape Drive No
TN1657 Disk Drive No
TN2135 Analog Line Yes
TN2136 Digital Line 2-Wire DCP Yes
TN2138 Central Office Trunk Yes
TN2139 Direct Inward Dialing Trunk Yes
TN2140B Tie Trunk - Hungary, Italy Yes
TN2144 Analog Line Yes
TN2146 Direct Inward Dialing Trunk Yes
TN2147C Central Office Trunk Yes
TN2149 Analog Line Yes
TN2180 Analog Line Yes
TN2181 Digital Line 2-Wire DCP Yes

Continued on next page
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Table 1-2. Circuit packs and circuit modules — Continued

Apparatus

code Name Allowable
TN2182/B Tone-Clock - Tone Detector and Call Classifier No
TN2183 Analog Line Yes
TN2184 DIOD Trunk Yes
TN2185/B ISDN-BRI 4-Wire S/T-TE Interface (Trunk Side) Yes
TN2198 ISDN-BRI 2-Wire U Interface No
TN2199 Central Office Trunk Yes
TN2202 Ring Generator No
TN2207 DS1 Interface - (T1) 24 Channel and (E1) 32 Channel | Yes
TN2210 Tone Generator No
TN2214/B Digital Line, 24-Port, 2-Wire DCP - Category B only No
TN2215 Analog Line, 16-Port 2-Wire - Category B only No
TN2224/B Digital Line, 24-Port, 2-Wire DCP Yes
TN2238 ATM Trunk Interface (Multi-Mode) No
TN2242 TTC Japanese 2Mbit Trunk Yes
TN2301 Survivable Remote Logic Switch No
TN2305 Asynchronous Transfer Mode (ATM) Trunk Yes
TN2306 ATM Interface (Single-Mode) No
TN2308 Direct Inward Dialing Trunk No
TN2464 DS1 Interface - T1, 24 Channel - E1, 32 Channel Yes
TN2793/B Analog Line 24-Port Yes
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Circuit pack installation

A cauTion:
When handling circuit packs or any components of a DEFINITY ONE
system, always wear an authorized wrist ground strap.Connect the strap to
the ground connector provided on the system cabinet.

=>» NOTE:

All of the circuit pack slots in the CMC are “universal slots.” Any slot can
contain any type of port circuit pack.

Circuit pack slot loading

1. Install the TN795 Processor circuit pack in slot 2 of the cabinet. See
[1-13]

2. A TN744D Call Classifier/Tone Detector circuit pack is required. Install the
TN744D into any port slot except for slots 1 and 2 (slot 3 is preferred but
not required.)

3. Load all port circuit packs. See [Table 1-3|for the recommended circuit
pack layout
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1.Slots1-5 3. 650 A Power Unit
2. Slots 6 - 10 4. For Flash Disk
(PCMCIA)

Figure 1-13. Cabinet and slot numbering
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Function Apparatus code Load from Notes
Processor TN795 Slot 1 and 2
Call Classifier/Tone TN744 Slot 3
Detector
Announcement TN750C Any slot
Speech Synthesizer | TN725B Any slot
DS1/E1, ISDN PRI TN464F, TN767E, Lower Right Maximum of 7 ISDN-PRI. Total
TN2242, TN2464 number of ISDN-PRI plus
number of ISDN-BRI circuit
packs must not exceed 7.
ISDN-BRI Trunk TN2185 Lower Right Maximum of 4
CO Trunk TN747B, TN465C, Lower Right
TN2199, TN2147C,
TN2138, TN438B
DID Trunk TN753, TN2139, TN2146, Lower Right
TN436B, TN459B
Tie Trunk TN760E, TN458, TN497, Lower Right
TN2140B
Auxiliary Trunk TN417 Lower Right
Modem Pool TN758 Lower Right
Data Line TN726 Upper Left
Digital Line TN754C, TN2181, Upper Left
TN2224/B,
Analog Line TN746B, TN2135, TN467, Upper Left
TN2144,TN2149, TN2180,
TN2183, TN2215,
TN468B,TN791, TN793,
TN2793,TN2214
Hybrid Line TN762B Upper Left
MET Line TN735 Upper Left
Radio Controller TN789 Upper Left
ISDN-BRI 4-Wire TN556C/D Upper Left
SIT-NT Line (A-Law) | tn744D

1. Cross-connect the port circuit packs to the MDF. See|Figure 1-14.
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Off-premises circuit protection

Protection from hazardous voltages and currents is required for all off-premises
(out of building) trunks, lines, and terminal installations. Both over-voltage
protection (lightning, power induction, and so forth), and sneak current
protection are required. Sneak current protectors must be either UL listed/CSA
certified, or must comply with local safety standards.

Sneak current protectors must have a maximum rating of 350 mA and a minimum
voltage rating of 600V, or as required by local regulations. The following devices
protect the system from over-voltages:

= Analog trunks use the 507B sheak protector or equivalent. Over-voltage
protection is normally provided by the local telephone company.

= Analog voice terminals use one of the following types of combined
over-voltage and sneak current protection, or equivalent:

— Carbon block with heat coil for UL code 4B1C
— Gas tube with heat coil for UL code 4B1E-W
— Solid state with heat coil for UL code 4C1S

= DCP and ISDN-BRI terminals use the solid state 4C3S-75 with heat coil
protector, or equivalent.

» DS1/T1 circuits require isolation from exposed facilities. This isolation may
be provided by a channel service unit (CSU) (T1), or other equipment that
provides equivalent protection.



DEFINITY ONE™ Communications System Release 2.0 Issue 2

Installation and Upgrades 555-233-109 June 2000
Install and Cable the Cabinet
Install equipment room hardware 1-34

Install sneak fuse panels

Sneak current protection is required between the incoming RJ21X or RJ2GX
network interface and the system for both trunk and off-premises circuit packs.
The model 507B sneak current fuse panel, or equivalent, is recommended for
sneak current protection. See Figure 1-15.

5 &

Sneak
Current
Protector

507B

D)

i [H-

STy

Figure notes

1. 507B Sneak current 3. 25-pair female connector (Out) (Comcode
protector (price element 846300994)

code: Comcode 107435091) 4. 220029 fuses (inside panel). Use a small

2. 25-pair male connector (In) screwdriver to pry top cover off
(Comcode 846300994)

Figure 1-15. Model 507B sneak fuse panel
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Each column of sneak fuse panels requires approximately 8 inches (20 cm) of
horizontal wall space. Connector cables connect the network interface to the
sneak fuse panel. Also, use 157B connecting blocks equipped with SCP-110
protectors for sneak current protection.

=>» NOTE:
Sneak current protectors with a rating of 350 mA at 600 Volts must be UL
listed for United States installations and Canadian Safety Association (CSA)
certified for Canadian installations. The panel contains two 25-pair
connectors, fuse removal tool, and fifty 220029 Sneak Fuses (and 2
spares). Use the SCP-110 protectors with 110-type hardware and on the
507B Sneak Fuse Panel. The SCP-110 Protectors can be ordered
separately and installed on the 157B connecting block. Fifty protectors are
required per block.

1. Install the 507B near the network interface or MDF with locally-obtained
#12 x 3/4-inch screws (or equivalent).
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Table 1-4 is a pinout of the cable wiring and associated fuse numbers.

Table 1-4. Sneak fuse connector pinout

Connector Pin | Pair/Fuse
Numbers Number
26/1 1
2712 2
28/3 3
29/4 4
30/5 5
31/6 6
32/7 7
33/8 8
34/9 9
35/10 10
36/11 11
37/12 12
38/13 13
39/14 14
40/15 15
41/16 16
42/17 17
43/18 18
44/19 19
45/20 20
46/21 21
47/22 22
48/23 23
49/34 24
50/25 25
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Label the main distribution frame

Figure 1-16 shows the graphic symbols used on the supplied labels for the
system, cross-connections, information outlets, and cables.

1. Write the floor and building identification on each label as required.
2. Insert the labels into the plastic holders.

3. Snap the holders into the appropriate locations on the MDF.

Gk
=Hé
1l €
™€
R
= @
R :
° A -

Figure notes

1. Floor and building identification 6. Site/satellite closet
2. Cabinet 7. Tie circuit

3. Carrier 8. Floor

4. Slot 9. Building

5. Information outlet

Figure 1-16. Label graphic symbols and nomenclature

4. Label the cables as required using the supplied labels. Label code
number 220A (comcode 103970000) contains all required labels.
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Set ringing option

P evdmrin2 EWS 042500

Figure notes

2 - Ringing option switch

=—>» NOTE:

Look at the label on the side of the power supply to see how to set switch.

Figure 1-17. Ringing option selection
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L1 1

—Do Not Remove When In Use

In Use
Maj Alarm
Min Alarm
Clock

6 0000

i S

Emergency
Transfer
On
Auto
off
Complete

Shutdown

600

A

Do Not Remove Board Unitl
Shutdown Is Complete

ckdfpcm3 EWS 040300

Figure notes

1. PCMCIA slots 6. Emergency Transfer Switch

2. Red LED 7. Shutdown Complete — safe to pull
board when green LED is on

3. Green LED

8. Shutdown Switch — gracefully shuts

4. Amber LED
down system

5. PCMCIA In-Use LED

Figure 1-18. TN795 circuit pack faceplate
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Install and wire telephones and other
equipment

=>» NOTE:

Only 1 pair of wires is available for emergency transfer, and 1 pair of wires
is available for Attendant Console power.

The wiring procedures are similar for most DEFINITY system telephones and
other equipment.This chapter provides wiring examples for similar installation
procedures. Actual wiring procedures may vary at each site.

The system can connect to all DTE terminals. The system can have RS-232 (or
EIA-232) or DCP interfaces.

All wiring pinouts for port circuit packs are in the tables at the end of this chapter.

See|Figure 1-32[for punch-down information for common circuit packs. The figure
shows the colors of the punch-downs and is best viewed from CD-ROM or
on-line.

After installing the hardware, the data for the system and telephone features is
administered. These procedures are provided in DEFINITY Enterprise
Communications Server Release 8.2 Administrator's Guide, 555-233-506.

Telephone connection examples
The 302C1 Attendant Console (AC) describes a typical telephone connection.
This information is typical of the 603E, 84xx (4-wire), and 94xx telephones. The
AC always requires auxiliary (adjunct) power (-48 VDC). See [Figure 1-19.|0Only 1
console can be powered by the system through the auxiliary (AUX) connector.

The primary console should be powered from the system so it has the same
power failure backup as the system.

The maximum cabling distance for the console powered from the cabinet is 350
feet (100 meters) using 24 AWG (#5) (0.26 mm2) wire.
The general steps to connect a telephone are:

1. Choose a device to connect such as a 302C1 Attendant Console.

2. Choose the port circuit pack and its carrier and slot number, such as
TN754C, Carrier A, Slot 06.

3. Choose a port circuit on the port circuit pack, such as Port 05.

4. Install cross-connect jumpers to wire the terminal to the port circuit pack.

See|[Figure 1-19.| This pinout is for a 4-wire Digital Line circuit pack.
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TXT 1 €< >— 39 TXT5
TXR 2 €— >—» 14 TXRS
PXT 3 €— >— 40 PXT5
PXR 6 €—< >—» 15 PXR5
7 < —> €
B« >
Figure notes
1. 302C1 Attendant Console 3. -48 VDC from adjunct power
2. 4-wire digital line circuit pack 4. Ground from adjunct power

Figure 1-19. 302CL1 to digital line circuit pack wiring
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Connect adjunct power

The 400B2 adapter is convenient for connecting local -48 VDC power to a
modular plug. See Figure 1-20.

o

749428 RPY 012098

Figure notes

1. Surface-mounted information outlet 4. To telephone
2. To individual power unit (such as 5. Destination service access
1151A or 1151A2) point (DSAP) power cord

3. 400B2 adapter

Figure 1-20. 400B2 adapter connecting to a modular plug

Adjunct power can be provided from the equipment room or equipment closet
with 1145B power unit. The AUX connector (J1) on the processor interface cable
can provide power for 1 Attendant Console.

Adjunct power can be provided locally at the telephone or console by the 1151A
or 1151A2 Power Supply.
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Install and wire telephones and other equipment

Station wiring examples
This section shows the wiring connections for the various types of stations. See
Figure 1-43,[Table 1-44 |and [Table 1-44

A | Wall Jack (103A)

BRI e
’—<
J@HBE@H@LWW

2-wireDCP Ry |

—

T

4-wire R>——7—"—
DCP T1
R1

B | Wall Jack (103A) H@HGH@H@H

C 111

HBH@H@

T R T2 R2
T1R1 T3 R3

Figure 1-21. Typical station wiring connections
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Table 1-5.  Wiring color code

Station Type Wire Color
(Tip/Ring)
Analog yellow/blue
2-wire DCP white/orange
4-wire DCP red/blue
red/orange
Hybrid white/blue
white/orange
white/green
Power white/red

Table 1-6. Stations connections

Station Type Connector
Analog or 2-wire T=1, R=26
DCP
BRI T=1, R=26
T1=3, R1=28
4-wire DCP T=2, R=27
T1=3, R1=28
Hybrid T=1, R=26
T1=2, R1=27
T2=3, R2=28
Power 4,29
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Analog tie trunk example

L4 ©

Tl 26 €< >—» 29 T2
Rl 1€ >—» 4 R2
T11 274 >—» 30 T12
R1l 2 €«—< >—» 5 R12
El 28€—< >—» 31 E2
M1 3 €< >—» 6 M2

tie_wire RBP 040596

Figure notes

1. External trunk or adapter 2. Tie trunk circuit pack

Figure 1-22. Analog tie trunk cross-connect

1. Before installing the Tie Trunk circuit pack, set the option switches as
described in[Chapter 1]“Install and Cable the Cabinet”.

2. Install cross-connect jumpers to connect the pins from the Tie Trunk circuit
pack to the appropriate leads on the external tie trunk. Determine names
of the tie trunk leads from the manufacturer or supplier of the external
trunk circuit. The example in Figure 1-22 shows a DEFINITY System tie
trunk connected to a DEFINITY System tie trunk.

3. Administer on the Trunk Group Screen. See DEFINITY Enterprise
Communications Server Release 8.2 Administrator’s Guide, 555-233-506.
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Digital tie trunk example

dig_tie RBP 040596

Figure notes
1. External trunk 4. LO (Balanced output pair)

2. DS1 interface circuit pack, position 5. LI
1CA06

3.LO

6. LI (Balanced input pair)

Figure 1-23. Digital tie trunk wiring

1. Before installing the DS1 Interface circuit pack, set the option switches as
shown in[Chapter 1,]“Install and Cable the Cabinet”.

2. Install cross-connect jumpers to connect the pins from the digital trunk
circuit pack to appropriate pins on the external digital trunk.

3. Administer the DS1 Interface circuit pack on the DS1 and Trunk Group
Screens. See DEFINITY Enterprise Communications Server Release 8.2
Administrator’s Guide, 555-233-506.
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Cable examples for tie trunk connectivity

DS1 tie trunks provide a 1.544 Mbps (T1) or 2.048 Mbps (E1) digital data service
between 2 collocated systems or between the system and a data network. The
following cables can be used:

C6C connector cable — 50-foot (15.2-m) shielded cable with a 50-pin
male connector on 1 end and a 15-pin male connector on the other end.
Use to connect a DS1 tie trunk circuit pack to a Channel Service Unit.

C6D connector cable — 50-foot (15.2-m) shielded cable with a 50-pin
male connector on each end. Use to connect a DS1 tie trunks in
collocated cabinets.

C6E connector cable — 100-foot (30.5-m) shielded cable with a 50-pin
male connector on 1 end and a 50-pin female connector on the other end.
Use as an “extension” cable between the DS1 tie trunk circuit pack and
other connector cables.

C6F connector cable — 50-foot (15.2-m) shielded cable with a 50-pin
male connector on 1 end and a 3 inch (7.62-cm) stub on the other end.
Use to connect the DS1 tie trunk circuit pack to channel multiplexers
requiring hardwired connections. See Table 1-7 for a pinout.

Table 1-7. Pinout of C6F cable

Wire color Lead designation Eljnmber
White/Green LI (High Side) a7
Green LI 22
White/Brown LO 48
Brown LO (High Side) 23
White/Slate LBACK2 49
Slate LBACK1 24

DSl tie trunks between collocated systems

Two DS1 tie trunk circuit packs can exist in collocated systems. A DS1 tie trunk
circuit pack in 1 system can connect to a DS1 tie trunk in another system. Use a
C6D cable if the distance is less than 50 feet (15.24 m). If the distance is greater
than 50 feet (15.24 m), use a C6E cable.

=>» NOTE:

The maximum distance between cabinets is 1310 feet (399.3 m).
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DS1 tie trunks using t1 channel service unit

Figure 1-24 shows a DSL1 tie trunk connected to an external T1 Channel Service
Unit (CSU). A 120A2 enhanced Integrated Channel Service Unit (ICSU) can be
used in place of a T1 external CSU. The CSU or ICSU interfaces the DS1 tie
trunks with the 1.544 Mbps digital facility. Contact your Lucent Technologies
representative for maximum cabling distances.
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Figure notes
1. To DSL1 tie trunk circuit pack 5. Ring (R)

2. C6C cable (If distance is over 50 6. Tip 1(T1)
feet (15.24 m), use C6E cable.) 7. Ringl (R1)

3. T1 external CSU or 120A2 ICSU 8. 1.544 Mbps T1 interface

4. Tip (T) 9. To T1 carrier

Figure 1-24. Typical connections to channel service unit
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3-pair and 4-pair modularity

Figure 1-25 shows 3-pair and 4-pair modularity from the port circuit pack to the
voice or data terminal. Most terminals connect to an information outlet (modular
jack) installed at the work location.
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0 widf3pm RPY 012098

Figure notes

1. Port circuit pack 5. Output from information outlet (4-pair
2. 25-pair connector pins (3-pair modularity)

modularity) 6. Voice or data terminal pins
3. MDF pins (3-pair modularity) 7. Adjunct power

4. Input to information outlet (4-pair
modularity)

Figure 1-25. 3-pair and 4-pair modularity
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Adjunct power connections

Figure 1-26 shows typical connection locations for adjunct power.
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Figure notes
1. Typical display telephone 9. 100P6A patch cord or jumpers
2. Individual power supply (such as 10. System side of MDF

1151A, not used if item 14 is used)
. 400B2 adapter

11. 25-pair cable to digital line circuit pack

12. Equipment room
. Information outlet (modular jack)

. 4-pair D-Inside Wire (DIW) cable

13. Satellite location

14. Bulk power supply (such as 1145B).
. Satellite site or adapter location Install at satellite location or equipment

. 25-pair D-Inside Wire (DIW) cable room (not both).
. Station side of MDF

0o N O U b~ W

Figure 1-26. Example adjunct power connections
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Local and phantom power

The Attendant Console’s (AC) maximum distance from the system is limited.
See Table 1-8.

Table 1-8. Attendant Console cabling distances

Enhanced Attendant 24 AWG Wire (0.26 mm2) 26 AWG Wire (0.14 mm2)
Console (302C1) Feet Meters Feet Meters
With Selector Console

Phantom powered 800 244 500 152
Locally powered 5000 1524 3400 1037
Without Selector Console

Phantom powered 1400 427 900 274
Locally powered 5000 1524 3400 1037

Auxiliary power

The nonessential functions of an AC and its optional 26A1 or 24A1 selector
console derive power from an auxiliary power source. During short power
outages, provide auxiliary power for an AC through this cable so the console
remains fully operational.

=>» NOTE:
Only 1 console can derive auxiliary power from the system and through the
auxiliary cable located in the trunk/auxiliary field.

A console’s maximum distance from its auxiliary power source is:
= 800 feet (244 m) for a 302A1

350 feet (107 m) for a 301B1 and 302C1

An AC can also derive auxiliary power from:

Individual 1151A or 1151A2 power supply
MSP-1 power supply

258A-type adapters

Bulk power supplies such as the 1145A1
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Install Attendant Console — optional

To install the optional AC:

1. Position the Attendant Console in the desired location and connect the
modular cord to the information outlet.

2. Install labels per the Attendant Console form and Display Module form
assignments.

3. Install a Digital Line circuit (DLC) pack in the assigned carrier slot (if
required).

4. Administer the console forms in DEFINITY Enterprise Communications
Server Release 8.2 Administrator's Guide, 555-233-506.

Hard-wire bridging

A CAUTION:
Bridging or paralleling these endpoints can cause electrical damage to the
consoles or cause the circuit pack to remove power from the consoles.

Analog type hard-wire bridging is not allowed for 4-wire (only) DCP endpoints,
because hard-wire bridging provides no way of combining the digital output of 2
bridged DCP sets. Also, a bridged endpoint causes the added load to degrade
the DCP signal.

Dual wiring of 2-wire and 4-wire endpoints

Do not simultaneously wire a 2-wire and 4-wire endpoint to the same equipment
location in an MDF, even though they connect to different colored wire pairs. The
system uses separate circuit packs to interface 2- and 4-wire endpoints, and
none are capable of interfacing both.

Install 26B1 Selector Console — optional

To install the optional Selector Console:

1. Connect the supplied 3-foot (0.9 m) DBAC cable to the modular jack on
the bottom of the 26B1 Selector Console.

2. Route the cable to the Attendant Console and connect to the DXS/BLF
jack.

3. Attach labels according to the Attendant Console form.

4. Administer the Attendant Console using DEFINITY Enterprise
Communications Server Release 8.2 Administrator's Guide, 555-233-506.
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Connect external alarms and auxiliary
connections

=>» NOTE:

The AUX connector is part of the Processor Interface cable assembly (J1). When the
wiring and administration is complete, give these wiring records to the Customer
System Administrator for troubleshooting purposes.

Alarm input

Alarms can be generated on adjunct equipment, sent to the DEFINITY ONE
system, and recorded and reported as “external alarms.”

A CAUTION:
Pins 26 and 1 on the AUX connector are dedicated to the UPS alarm

input. Using these pins for other alarm inputs will cause the
DEFINITY ONE system to reset.

1. Connect 1 major alarm input wire pair and 1 minor alarm input wire pair to
the auxiliary field from the AUX connector (J1 on Processor Interface

Cable). See Table 1-53 and [Figure 1-54]

Table 1-9. Alarm inputs at AUX connector

Alarm input type Color AUX connector

Minor White-Blue AP2 (Pin 27)
Blue-White Ground (Pin 2)

Major (UPS) White-Orange AP2 (Pin 26)
Orange-White Ground (Pin 1)

Alarm output

The system provides a relay contact closure that can operate a
customer-provided alarm, such as a light or bell. The customer provides the
circuitry and power source. The alarm device must not exceed a rating of more

than 30 VAC RMS or 60 VDC at 0.75 Amps.

The following are procedures to connect alarm output.
1. Connect the external alarm output. See(Table 1-54.

2. Type change system-parameters maintenance and press (ENTER).
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3. Change the “CPE Alarm Activation Level” field to the desired alarm level
and press (ENTER).

Table 1-10. Alarm output at AUX connector

Alarm output type Color ’ AUX connector
EXTALMA Violet-Green (Pin 48)
EXTALMB Green-Violet (Pin 23)

UPS alarm connection

M 1 i
ﬁ*@ BHE
Te : il

cydmone2 LJK 042999

Figure notes
1. Lucent UPS
2. Z3A2 alarm adapter
3. RJ45 (D8W) cable
4. 103A or modular jack

. Pin 1, orange-white
. Cross-connect field

. 25-pair cable

© 00 N O

. Processor interface cable (AUX
connector)

10. DEFINITY ONE

5. Pin 26, white-orange

Figure 1-27. UPS connection to DEFINITY ONE
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Emergency transfer and auxiliary power

=>» NOTE:
Only 1 emergency transfer power panel and 1 auxiliary power connection is
provided per system.

Connect emergency transfer power and auxiliary power as shown in Table 1-11.
Auxiliary power includes power to an Attendant Console or adjunct device.

Table 1-11. Emergency transfer and auxiliary power

Power type Color AUX connector
Emergency Transfer Black-Blue XFER48 (Pin 36)
Blue-Black Ground (Pin 46)
Adjunct -48 VDC Brown-Yellow | ACC48A (Pin 19)
Yellow-Brown | Ground (Pin 44)

Telephone pin designations

Table 1-12 provides pack and pin designations.

Table 1-12. Port circuit pack and telephone pin designations

4-wire;

302C1, 8510T BRI
Pin on 8400-Series, | 2-wire; 302C1, (with adjunct Z3Al & Z3A2
Modular | 603E, 9403, 8400-Series, 603E, speaker Analog Station, | ADU, Data
Plug 9434 9403, 9410, 9434 phone) Modem Module
1 TXT TXT
2 TXR T TXR
3 PXT TXT R PXT
4 T PXR
5 R PXT
6 PXR TXR PXR
7 -48VDC (-48VDC) (-48VDC)
8 GRD GRD GRD
circuit 4-wire digital | 2-wire digital 4-wire BRI Analog line Data Line
pack (8 ports) (16 or 24 ports) Trunk Side (16 or 24 ports)

PX PBX transmit T Tip (A)

TX Terminal transmit R Ring (B)
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Install the BRI terminating resistor

The resistors balance the cable plant between the receiver and the transmitter on
the interface. When using the TN2198 ISDN-BRI 2-Wire U Interface circuit pack,
use an NT1.

A terminating resistor is always required near the terminal when the BRI S-type
interface circuit pack (TN556 BRI 4-Wire S-NT Line circuit pack) is used (see
#B5ESS Switch Integrated Services Digital Network Customer Premises Planning
Guide, 533-700-100).The resistor is built into the NT1 and can be 1 of 3 values,
depending on the configuration and the distance from the NT1 to the ISDN
terminal. The NT1 controls the resistor value; if needed, place a terminating
resistor adapter near the terminal and in the satellite closet or work location.

A CAUTION:

The 440A4 terminating resistor and 110RA1-12 terminating resistor block
are Underwriter Laboratories (UL) listed. Most new installations are the
110RA1-12 terminating resistor block. The following installation instructions
should be observed.

= Never install telephone wiring during a lightning storm.

» Never install telephone jacks in wet locations unless the jack is
specifically designed for wet locations.

» Never touch uninsulated wires or terminals unless the telephone
line has been disconnected at the network interface.

» Use caution when installing or modifying telephone lines.
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Terminating resistor adapter

Figure 1-28 shows an 8-pin 440A4 terminating resistor adapter. The adapter has
an 8-wide plug at 1 end, a short cord, and an 8-wide jack at the opposite end.

® N o U~ W NP
¢
[
© N o U~ W NP

1910013 RPY 012098

Figure notes

1. 8-wide plug 2. 8-wide jack

Figure 1-28. 8-wide terminating resistor adapter (440A4)
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Closet mounted (110RA1-12)

The 110RA1-12 terminating resistor block consists of twelve 2-pair circuits and
provides the 100 Ohm termination used for ISDN-BRI circuits.

Figure 1-29 shows the wiring of the 110RA1-12. Three rows of 110D 4-connector
blocks contain resistors and capacitors. The bottom row is designated as the
input row and the top and middle rows are designated as the output rows. The
circuit assembly is mounted on a standard 110A 100-pair mounting base.

12 3 4 45 46 47 48

©
\'4

o olofof6|— — — — — Djjjo

910014 RPY 012098

Figure notes
1. Circuit 1 5. Input row “C”

2. Circuit 12 6. Only first circuit shown to all 12
circuits (2APR) per block

7. 110D 4-connector block

3. Output row “A”
4. Output row “B”

Figure 1-29. Terminating resistor block (110RA1-12)
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Figure 1-30 shows the wiring connections for the 110RA1-12 terminal block. The
TN556 BRI switch port is terminated to bottom row C.

°
)
¢
) 4

o °

TRTLIRL

N4 °

Figure notes

1. Part of terminating resistor block 7. Basic multi-point option
2. White or purple field 8. 4-pair horizontal cables
3. Part of 4-pair blue field 9. Row “A”
4. From ISDN T-interface circuit 10. Row “B”

(2-pair) 11. Row “C"
5. To ISDN S/T-interface terminals

»

. 2-pair cross-connect

Figure 1-30. Typical installation of terminating resistor block

For point-to-point wiring, the top row connects to the blue station field. The pair
connects from the 110RA1-12 to the standard 4-pair circuit. Pair 1 from the
110RA1-12 connects to Pair 1 of the station field, and Pair 2 connects to Pair 3 of
the station field.

Connect row B (output) to the second terminal common to the multi-point circuit
to accommodate two terminal basic multi-point applications.



DEFINITY ONE™ Communications System Release 2.0 Issue 2
Installation and Upgrades 555-233-109 June 2000
Install and Cable the Cabinet

Install multi-point adapters 1-60

Install multi-point adapters

Use multi-point adapters to provide signal fanout of the T-interface. BR851-B or
the 367A perform fanout at the work station. These adapters support more than 1
ISDN terminal per horizontal 4-pair D-inside wire (DIW). To support multiple
horizontal runs, a MDF with multiple common rows performs fanout in the satellite
closet. The 110RA1-12 provides fanout for two horizontal runs and contains the
100 Ohm terminating resistor. Use this for basic multi-point or point-to-point with
terminating resistor in the closet. Other fanout blocks include the 110AB1-025M
and the 110AB1-050M.

BR851-B adapter (T-adapter)

The BR851-B supports 2 terminals on 1 multi-point BRI at the work station and is
used to fanout transmission and power. See Figure 1-31.

0:987654321

44311322
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44311322

87654321
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Figure notes
1. Wire pairs
2. Pin numbers

3. Modular plug (male)

RTRTRTRT
44311322

87654321

e

4. Female
5. T-Type adapter (BR851-B)

Figure 1-31. Wiring diagram of BR851-B
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367A adapter

The 367A adapter provides fanout for up to 7 terminals. See Figure 1-32.

T (XX XXX/ ‘

87654321 8765432

\ J \
g v

4 © ©

87654321

Figure notes
1. Jack 1 3. Jack 8
2. Jack 2 4. 367A adapter

Figure 1-32. Wiring diagram of 367A adapter
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Basic multi-point installation distances

Figure 1-33 provides cabling information for fanout of ISDN-BRI multi-point
installations. The terminating resistor is located in the satellite closet. All
distances assume 24 AWG (0.26 mmz) D-Inside Wire (DIW).
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Figure notes
1. S-interface source (TN556) 6. System cabinet
2. Terminating resistor 7. Terminating endpoint 1
3. Satellite closet 8. Terminating endpoint 2
4

. Maximum distance from S-interface 9. Work location
source to work location (1600 feet)

10. Maximum distance from information
(488 m) o :
outlet to terminating endpoint (33
5. Maximum distance from satellite feet) (10 m)
closet to work location (250 feet) .
(76 m) 11. Information outlet

Figure 1-33. Basic multi-point with one work location



DEFINITY ONE™ Communications System Release 2.0 Issue 2

Installation and Upgrades 555-233-109 June 2000
Install and Cable the Cabinet
Install off-premises station wiring 1-63

Install off-premises station wiring

The local telephone company provides the cabling for off-premises stations.
These stations can appear on any of the RJ21X network interfaces provided for
the CO trunks.

A CAUTION:
Use only an FCC-approved (or equivalent) analog type telephone (such as
a 2500-type) as an off-premises station. The TN746B and TN2183 Analog
Line circuit packs can be connected to off-premises stations.

1. Install an A25D cable between the RJ21X network interface and a sneak
fuse panel.

2. Atthe MDF, connect jumper wires between 1 row/connecting block in the
green field and up to 3 rows/connecting blocks in the purple field to
concentrate the analog line pairs.

3. Connect an A25D cable between the sneak fuse panel and the terminal
block connector associated with the green row in Step 2.

4. Install a green label on the terminal block to identify the remote location.

5. Administer per DEFINITY Enterprise Communications Server Release 8.2
Administrator’s Guide, 555-233-506.

Install off-premises or out-of-building stations

Out-of-building campus stations are telephones not physically located in the
same building as the equipment room yet located on the same property.

Analog off-premises stations

Figure 1-34|shows the connections for 1 to 8 off-premises analog telephones.
Only analog telephones connected to TN742, TN746B, TN2183, or TN769
Analog Line circuit packs can be installed out-of-building.

The maximum distance from the system cabinet to the out-of-building voice
terminal is 6000 feet (1828.8 meters) using 24 AWG (0.26 mm2) wire.
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Figure notes

1. Locally engineered cables 7. Part of MDF
2. Out-of-building wiring 8. Station side (white field)
3. Multi-pair protector units (primary 9. System side (purple field)

protectors with heat coils or equivalent
with sneak current protection)
11. To analog line circuit pack

4. 356A adapter (TN2183, TN769, TN742, or
5. B25A cable TN7468B)

6. Out-of-building analog telephones

10. Cross-connect jumpers

Figure 1-34. Connections for 1 to 8 out-of-building analog telephones
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Figure 1-35 shows the connections for up to 24 off-premises analog telephones,
with concentrations of analog line pairs used at both buildings to minimize the
off-premises wiring required. At the MDF, jumpers must be connected between 1
row/connecting block in the white field and up to 3 rows/connecting blocks in the
purple field. At the station location, a WP-90929, List 1 Concentrator Cable is
used. There are 8 station appearances on each of the 3 fingers of the
concentrator cable. See Figure 1-35
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Figure notes

1. Locally engineered cables 7. Out-of-building analog telephones

2. Multi-pair protector units (primary 8. Part of MDF
protectors with heat coils or equivalent with 9. Station side (white field)

sneak current protection)
10. System side (purple field)

3. B25A cable
4. Concentrator cable (WP90929 List 1) 11. Cross-connect jumpers

12. To TN2183, TN769, TN742, or
5. 356A adapter TN746B analog line circuit pack
6. Out-of-building wiring

Figure 1-35. Connections to 24 out-of-building telephones
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Circuit protectors

Both building entrances require Carbon block or equivalent protection and sneak
current protection. Provide this protection with a 4-type protector The 4-type
protector is equipped with a heat coil or a 3-type protector plus a separate sneak
current protector.

The 4-type protector is the preferred device. For installations not using primary
protection, always use 4-type protectors. When the 3-type protector is already
installed, a separate sneak current protector is required. The multi-pair protector
units and the off-premises cabling must be locally engineered. Connectorized
multi-pair protector units (female 25-pair connector) are recommended. Table
1-13 shows the recommended protectors.

Table 1-13. Analog line circuit protectors

Primary Sneak current
Primary?! (with heat coil) protectors®
3B1A (carbon) 4B1C (carbon) 220029 Fuse
3B1E-W (wide-gap 4B1E-W (wide-gap gas tube) | SCP-1
gas tube)
3C1S (solid state) 4C1S (solid state)

1. The 3-type protectors should only be used if they are already part of the
existing protection system. A sneak current protector is always required when
a 3-type primary protector is used.

The maximum range of out-of-building analog telephones (500-, 2500-, or
7100-types) connected to an analog line circuit pack should be such that the
maximum loop resistance does not exceed 1300 Ohms.

The following voice terminals cannot be installed in an exposed environment:

» 7300-type voice terminals connected to TN762 Hybrid Line circuit packs

» Multi-button Electronic Telephone (MET) sets connected to TN735 MET
Line circuit packs

» Analog telephones connected to TN746 Analog Line circuit packs

See for circuit protector ordering information (comcodes).
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Digital out-of-building telephones

Use the following equipment to protect digital out-of-building voice terminals and
digital circuit line packs at both building entrances:

» 4C3S-75 Enhanced protector

= [TW Linx Enhanced Protector

These units provide primary and sneak current protection. The 4C3S-75 is
equipped with a heat coil for sneak current protection while the ITW Linx is
equipped with replaceable fuses for sneak current protection.

Use the 4C3S-75 only with Vintage 14 or newer TN754 circuit packs. The
4C3S-75 can be used on all vintages of the TN754B circuit packs. The ITW Linx
may be used on all vintages of the TN754 circuit packs. Table 1-67 lists the
approved protectors.

=>» NOTE:
The TN2181 (2-Wire 16 Port Digital Line circuit pack) may not be approved
for some out-of-building uses. Contact your Lucent Technologies
representative for more information.

Table 1-14. Digital voice circuit protectors

Enhanced primary protector

Circuit pack (with sneak current protection)
TN754B/all vintages 4C3S-75 or ITW Linx
TN2181 4C3S-75 or ITW Linx

TN2224B/all vintages 4C3S-75 or ITW Linx

When possible, all new and reused wiring installations should use blocks that
accept the standard 5-pin plug-in 4C3S-75 protector. However, this may not be
cost-effective in some cases; for these installations, the ITW Linx protector may
be installed. For example, if screw-type carbon block protectors (or other
comparable plug-incompatible types) are in place, it may be too costly to
re-terminate the outside cable on a 5-pin mounting block for only a few
out-of-building terminals.

The ITW Linx Enhanced Protector may be installed in series with existing primary
protection. Note the 4C3S-75 protector cannot be installed in series with other
types of primary protection, but must be installed as the only protection on the
line entering the building. For the 4C3S-75 protector, various 25-, 50-, and
100-pair protector panels are equipped with 110-type connecting blocks and/or
RJ21X connectors. The ITW Linx Enhanced Protector mounts directly on
connecting blocks and requires a separate ground bar.
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The maximum range for out-of-building digital voice terminals is:
» 3400 feet (1036 m) when using 24 AWG (0.26 mmz) wire
» 2200 feet (670 m) when using 26 AWG (0.14 mmz) wire
With the use of a data link protector (an isolating transformer used to remove

phantom power on the system side and re-introduce it on the terminal side), the
range can extend to

» 5000 feet (1524 m) using 24 AWG (0.26 mmz) wire or

= 4000 feet (1219 m) using 26 AWG (0.14 mmz) wire
When using a protector, the voice terminal must be locally powered by an
external power supply or through the AC power cord provided with some of the

7400-type voice terminals. Install the protector on the equipment side of the
protection in both buildings.

See for circuit protector and data link protector comcodes.

Install emergency transfer panel and
associated telephones

=>» NOTE:

Install only 1 emergency transfer power panel per system.

An 808A Emergency Transfer Panel (or equivalent), mounted next to the
trunk/auxiliary field, provides emergency transfer capability. See[Figure 1-69]
Also see[Table 1-55|for the pinout of the AUX (J1) connector. The transfer panel
provides emergency trunk bypass or power-fail transfer for up to 5 incoming CO
trunk loops to 5 selected station sets. The 808A equipment’s Ringer Equivalency
Number (REN) is 1.0 Amp.

Use analog telephones for emergency transfer. The 500 and 2500 type
telephones can also be used as normal extensions. Emergency transfer
capability may be provided on analog CO and Wide Area Telecommunications
Service (WATS) trunks.

At the MDF, the unit is controlled by a connection to a yellow terminal

row/connecting block in the trunk/auxiliary field. The unit is controlled by -48 VDC
from the EM TRANS RELAY PWR terminals.

Install the emergency transfer panel

The following example shows how to install an 808 A Emergency Transfer Panel.

1. Install the transfer panel on any mounting frame in either a vertical or
horizontal position. The housing has ears for screw-mounting and cutouts
for snap-mounting the unit in an 89-type mounting bracket.
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=>» NOTE:

Install the panel so it can be accessed only by authorized personnel.
The location must meet standard environmental considerations such
as temperature and humidity.

2. Verify dial tone is present at each trunk circuit.
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Figure notes
1. 808A emergency transfer panel 3. Trunk identification label
2. Circuit start selection switches 4. 25-pair male connector

Figure 1-36. 808A emergency transfer panel
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3.

Locate the circuit start selection switches (the first 10 two-position
switches on the left side of the 808A. See These switches set
each of the 5 incoming trunk lines to either loop start or ground start. Two
switches are used for each of the 5 circuits; switches 1 and 2 are used for
circuit 1, switches 3 and 4 are used for circuit 2, and so forth. See Table

1-15.

Table 1-15. Trunk/test switches

Switch Circuit

number number

1 1

2 1

3 2

4 2

5 3

6 3

7 4

8 4

9 5

10 5

11 Not Used

12 Test Switch
4. Connect a 25-pair cable between the male RJ21 25-pair connector on the

808A and the yellow field on the MDF. [Table 1-16|shows the pinouts.

Make cross-connections for each emergency trunk/emergency station
pair. See [Figure 1-37|and|Figure 1-38.|

. On the trunk identification label at the bottom of the panel, record the trunk

line, extension, and location for each circuit.

To each voice terminal designated as an emergency terminal, attach a
label identifying it as such. The labels are provided with the unit.

Check the system for normal operation as follows:
a. Place the test switch (switch 12) in NORMAL OPERATION.

b. Ensure the power supply is providing -48 VDC at 80 mA maximum.
The power LED should be ON.

c. Check wiring connections.

d. Verify there is dial tone on all emergency transfer sets.
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Table 1-16. Pin assignments for 25-pair connector on 808A

Pin Color Designation Connector/Description
26 W-BL TTC1 Tip-PBX Trunk Circuit 1

1 BL-W RTC1 Ring-PBX Trunk Circuit 1
27 W-O TTK1 Tip-CO Trunk Circuit 1

2 o-w RTK1 Ring-CO Trunk Circuit 1
28 W-G TLC1 Tip-PBX Line Port 1

3 G-W RLC1 Ring-PBX Line Port 1

29 W-BR TST1 Tip-Emergency Terminal 1
4 BR-W RST1 Ring-Emergency Terminal 1
30 W-S TTC2 Tip-PBX Trunk Circuit 2

5 S-W RTC2 Ring-PBX Trunk Circuit 2
31 R-BL TTK2 Tip-CO Trunk Circuit 2

6 BL-R RTK2 Ring-CO Trunk Circuit 2
32 R-O TLC2 Tip-PBX Line Port 2

7 O-R RLC2 Ring-PBX Line Port 2

33 R-G TST2 Tip-Emergency Terminal 2
8 G-R RST2 Ring-Emergency Terminal 2
34 R-BR TTC3 Tip-PBX Trunk Circuit 3

9 BR-R RTC3 Ring-PBX Trunk Circuit 3
35 R-S TTK3 Tip-CO Trunk Circuit 3

10 S-R RTK3 Ring-CO Line Port 3

36 BK-BL TLC3 Tip-PBX Line Port 3

11 BL-BK RLC3 Ring-PBX Line Port 3

37 BK-O TST3 Tip-Emergency Terminal 3
12 O-BK RST3 Ring-Emergency Terminal 3
38 BK-G TTC4 Tip-PBX Trunk Circuit 4

13 G-BK RTC4 Ring-PBX Trunk Circuit 4
39 BK-BR TTK4 Tip-CO Trunk Circuit 4

14 BR-BK RTK4 Ring-CO Trunk Circuit 4
40 BK-S TLC4 Tip-PBX Line Port 4

15 S-BK RLC4 Ring-PBX Line Port 4

Continued on next page
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Table 1-16. Pin assignments for 25-pair connector on 808A — Continued

Pin Color Designation Connector/Description
41 Y-BL TST4 Tip-Emergency Terminal 4
16 BL-Y RST4 Ring-Emergency Terminal 4
42 Y-O TTC5 Tip-PBX Trunk Circuit 5

17 o-Y RTC5 Ring-PBX Trunk Circuit 5
43 Y-G TTK5 Tip-CO Trunk Circuit 5

18 G-Y RTK5 Ring-CO Trunk Circuit 5

44 Y-BR TLC5 Tip-PBX Line Port 5

19 BR-Y RLC5 Ring-PBX Line Port 5

45 Y-S TST5 Tip-Emergency Terminal 5
20 S-Y RST5 Ring-Emergency Terminal 5
46 V-BL Ccom1 Common 1 Relay Contact
21 BL-V NO1 Normally Open 1 Contact
47 V-0 NC2 Normally Closed 2 Contact
22 o-v NC1 Normally Closed 1 Contact
48 V-G COM2 Common 2 Relay Contact
23 G-V NO2 Normally Open 2 Contact
49 V-BR

24 BR-V

50 V-S GRD Ground From PBX

25 S-V -48PX -48V from Alarm Panel (AUX Cable)

9. Check the system for emergency transfer operation as follows:
a. Place the test switch (switch 12) in the ACTIVATED position.
b. Ensure that the power LED should be OFF.

c. Verify there is CO dial tone for all emergency transfer sets.
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10. Connect the 808A to the MDF with a B25A or A25B cable. Figure 1-37
shows the connections at the trunk/auxiliary field for a telephone used only
for emergency transfer.
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Figure notes
1. To network interface circuitry 4. To power transfer unit
2. To CO trunk circuit pack 5. To control carrier AUX
connector

3. To blue or white station distribution field

Figure 1-37. Connections for telephone used for emergency transfer
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Figure 1-38 shows the connections at the trunk/auxiliary field for a telephone
used for emergency transfer and as a normal extension.
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Figure notes

1. To network interface facility 4. To CO trunk circuit pack
2. To blue or white station field 5. To power transfer unit
3. To analog line circuit pack 6. To control carrier AUX connector

Figure 1-38. Connections for telephone used for emergency transfer and as
normal extension
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Install telephone for power transfer unit

Follow the appropriate procedure for your installation.

Trunk/auxiliary field: telephone used only for emergency transfer

1.

Connect a pair of wires between the -48V and GRD terminals on the yellow
emergency transfer row/connecting block and the EM TRANS RELAY PWR
terminal. See|Figure 1-73.

Connect CO trunk leads from the purple field to the TC terminals on the
yellow emergency transfer row/connecting block for each trunk.

Connect CO trunk leads from the green field to the TK terminals on the
yellow emergency transfer row/connecting block for each trunk.

Connect the ST leads on the yellow emergency transfer row/connecting
block for each emergency transfer telephone to the ST terminal
appearance in the yellow trunk/auxiliary field. The ST terminal leads
should be terminated on the following pairs: 1, 4, 7, 10, 13, 16, 19, or 22
(the first pair of any 3-pair group).

Connect the ST leads from the terminal in Step 4 to the assigned terminal
in the blue or white station distribution field.

Trunk/auxiliary field: telephone used for emergency transfer and as
normal extension

1.

Connect a pair of wires between the -48V and GRD terminals on the yellow
emergency transfer row/connecting block to the EM TRANS RELAY PWR
terminal.

Connect CO trunk leads from the purple field to the TC terminals on the
yellow emergency transfer row/connecting block for each trunk.

Connect CO trunk leads from the green field to the TK terminals on the
yellow emergency transfer row/connecting block for each trunk.

Connect telephone leads from the purple analog line board row/
connecting block to the LC terminals on the yellow emergency transfer
row/connecting block for each telephone.

Connect ST leads on the yellow emergency transfer row/connecting block
for each emergency transfer telephone to the ST terminal appearance in
the purple trunk/auxiliary field.

Connect the ST leads from the terminal in Step 5 to the assigned terminal
in the blue or white station distribution field.

Telephone installation

1.
2.

Connect the telephone to the information outlet.

Install patch cords/jumper wires between the system side and the station
side of the station distribution field on the MDF.
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Connect modem to telephone network

1. Cross-connect the network jack on the modem to the network interface
(via a 103A or modular wall jack). See Table 1-17 for the pinout.

Table 1-17. Pinout of network jack

Pin number | Signal
1 Unused
2 Tip

3 Ring

4 Unused

33.6 Faxmodem

Sportster

0

ARIFAX

Sy

,_l
FRERFIL

O

O 1
SOFF O

modmcabl KLC 110397

Figure notes

1. Pin 1 of network jack 2. Modem

Figure 1-39. Network jack on U.S. robotics modem
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Connect modem

The U.S. Robotics external modem is the recommended external modem for
Release 2.0. A locally obtained, type-approved external modem may be used.
Contact your Lucent Technologies representative for information.

If any other Robotics modem is installed, see the setup instructions provided with
that modem.

External modem option settings

Use Table 1-18 to check or set the 8 option switches on the U.S. Robotics
modem.

Table 1-18. U.S. Robotics model external modem switch settings

Switch | Setting Function

1 OFF (Up) | DTR (Data Terminal Ready) override
2 OFF (Up) | Verbal result codes (text-formatted feedback characters such as
connected or no carrier)
3 ON Enable result codes
(Down)
4 OFF (Up) | Displays keyboard commands (local echo)
5 OFF (Up) | Sets auto answer

OFF (Up) | CD (Carrier Detect) override (modem sends CD signal on
connect, drops CD on disconnect)

7 OFF (Up) | Power-on and ATZ reset software defaults (loads Y or Y1
configuration from NVRAM)

8 ON AT (Attention) command set recognition (enables recognition,
(Down) smart mode)

The modem is pre-configured to operate correctly. See [‘Modem configuration|
land administration”|on page 9-5 for procedures on how to verify that the correct
defaults are set; how to configure the modem, if necessary; and how to test the
modem.
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Set neon voltage to prevent ring ping

=>» NOTE:

If the ringing option is set to 50 Hz, neon voltage is not available. If 25 Hz is selected,
the maximum voltage is 120 volts. See ‘{“Set ringing option”|on page 1-38.

=—>» NOTE:

Set the control to OFF if there are no neon message waiting lamps or if LED message
lamps are used. See Figure 1-40.
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Figure 1-40. Setting the neon voltage

1. Call a telephone with a neon message indicator and leave a message.

2. Check for “ring ping” (single ring pulse) each time the lamp flashes
(approximately every 3 seconds).

3. Adjust the control clockwise in small increments until the ring ping stops.
Ensure that the message lamp still lights when the adjustment is finished.
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1. Enter logoff and press (ENTER) to prevent unauthorized changes to data.

2. Set the left and right doors onto the hinge pins and close the doors. The
doors must be closed to prevent EMI emissions. Tighten the door screws.

3. Set the right cover panel onto the right panel and secure. Do not use

force.

View LEDs to determine power and

fan alarm state

Use the LEDs on the front of each power unit to determine its state.

1. Table 1-19 shows the LED and alarm conditions. Ring voltage and neon
bus output do not activate alarm status.

Table 1-19. LED and Alarm Conditions

Condition LED status | Alarm state Fan alarm

Normal Red off open high
Yellow on

No Input Power Red off closed open
Yellow off

One or More DC Red on closed no state

Outputs Present Yellow off

Fan Alarm Red on closed low

Yellow off
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Connectivity and Access to
DEFINITY ONE

This chapter, exclusive of installation procedures, provides background
information on connectivity and access to aid understanding and implementation
of subsequent chapters. For installation procedures, see[Chapter 3| “System
Initialization”.

Physical connections are as follows:

[“Physical connections’”|on page 2-2

— [“Via a PCMCIA ethernet (NIC) network connection”lon page 2-2

— |“Via local monitor/mouse/keyboard”|on page 2-2

— [“Via RAS (modem) dial up”lon page 2-3

— [“Via customer LAN”|on page 2-11

The access method is determined by the task or access situation:

= [“Access methods”|on page 2-16

— |“Via a Telnet session’ lon page 2-16

— |“Via.a Web browser session”|on page 2-18

— |“Via pcAnywhere”|on page 2-21

= [“System administration/DEFINITY site administration (DSA)”|on page 2-26

= [“DEFINITY ONE Lucent personnel logins”|on page 2-28

This chapter first shows the procedures for physical connection to DEFINITY
ONE. Once you are physically connected to DEFINITY ONE, you must access
the system in one of several ways.
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(See for a tear-out “cheat sheet” detailing physical connection and
access methods, and login information.)

=>» NOTE:
Detailed descriptions of the operation of the Microsoft Windows operating
system and environments are beyond the scope of this document. Please
refer to your Microsoft documentation for details concerning the Windows
95/98 and Windows NT systems.

Physical connections

Via a PCMCIA ethernet (NIC)
network connection

Follow the procedure, [‘Connect the laptop computer to DEFINITY ONE” jon page
C-2, in Appendix C, “Miscellaneous Procedures”. PCMCIA is the preferred
procedure for making the physical connection.

Via local
monitor/mouse/keyboard

Use this method when plugging the monitor into DEFINITY ONE, thus making it
look like a PC. The processor interface cable is on slot 2 of DEFINITY ONE.
Customers have their own monitor/mouse/keyboard setup.

1. Plug the monitor into the processor interface cable on the back of
DEFINITY ONE.

2. Plug the mouse into the processor interface cable on the back of
DEFINITY ONE.

3. Plug the keyboard into the processor interface cable on the back of
DEFINITY ONE.

=>» NOTE:
If these devices are plugged in while the system is running, you must
reboot so that the system will recognize these peripherals. Once
recognized by the system, the devices are hot pluggable.
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Via RAS (modem)
dial up

This connection method enables Lucent services-related personnel, INADS, or
customers to dial in remotely using a modem. On DEFINITY ONE, the Windows
NT Remote Access Service (RAS) is listening for incoming calls from COM1, to
which a modem is connected. Use the standard Windows NT dial up networking
operation to set up this connection from a Services laptop computer as per the
following procedure.

Create a connection icon for DEFINITY ONE

If a connection icon already exists, proceed directly to[*Dial up”]on page 2-5.
Otherwise, follow these steps:

1. Double click “Make New Connection” on the Network
Neighborhood Dialup Server Control Panel.

Make New Connection

Type a name for the computer you are dialing:

IDefinit_l,lEl =]

Select a modem;

fodem of Xircom Ethernet+idodem [CEM 52

LConfigure. ..

< Blach I Heut > I Cancel |

2. Enter the name of the computer you are dialing (be sure to select
the appropriate modem).

3. Click Next.
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4. Enter the area code and phone number of the system you are
calling, then click Next.

Make Hew Connection

Type the phone number for the computer pou want fo call;

Area code: Telephone number;
[0z =] - [EEE1212

Country code;
!Llniteu:l States of Amernica 1] j

< Back I Heut » I Cancel

5. Click Finish. The new icon appears in the Dial-Up Networking
screen.

Make New Connection

You have successfully created a new Dial-Up Metworking
connectioh called:

Click Finizh to zave it in your Dial-Up Mebworking folder.
Double-click it to connect,

To edit thiz connection later, click it, click the File menu
and then click Properties.

< Back I Finizh I Cancel
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Dial up
1. On the laptop computer, double click My Computer.
2. Double click Dial Up Networking.
A similar screen displays:
B2 Dial-Up Networking
J File  Edit “iew Go Fawontes Connections Help ‘.
& = | 2 | %
Hiact Farard Up | Create {irjat | Cut
J Address ;E Dial-Up Metworking
Lucent Bosznia
Fiemo...
drgaurd
1| | i
|8 object(s) v
3. Double click the machine name to which dial up networking has been
administered. For this example, the machine name is “estonia”.
4. To access the Dial-up Networking dialogue box, double click My
Computer on the desktop.
A similar screen displays:
S Wy Computer M=l 3
File Edit ‘“iew Help
IMyEDmputer j El é’él‘lﬁl _| Xl"l Elnn“' &
[=£3% Floppy [4:]
|= Cze [C:]
58] Control Panel
|22 Prirters

28] Dial-Up Metwarking

5. Double click Dial-Up Networking in the My Computer window.
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A similar screen displays.

E& Dial-Up Metworking

File Edit “iew Connections Help

I%} Dial-Up Metworking j Dl@l cll%ll%l il .....X...
o " '_-.r-': '_.-': ._.r:

Eztonia Lucent 800 Lucent local
ACCETE dial in

LucentRemate
Arocess

|6 object(s)

The following steps describe how to make a new connection:

1. To create a new connection, double click Make New Connection in the
Dial-Up Networking window.

2. Double click the new dial-up icon, in this example, Estonia.

The new icon appears in the Dial-Up Networking window below:

B Dial-Up Networking

File Edit “iew Connection: Help

I":i&'j Dial-Up Hetworking j I

| &

$|@l@| «| X
'_.-': :

b ake Mew Bosnia
Connection

Lucent 300 Lucent local
ACCESE dial in

LucentRemate
Arooess

| 1 object(z] zelected
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Physical connections

3. Right-click the new icon to enable the associated properties window.

A similar screen displays:

Eroa ——HE|

General | Server Typesl Scriptingl

B =
e
— Phone nurnber:
GE COnHE; Telephone number;
| I B EEELE
[Caurtincade;
ILIniteu:I States of America [1] j

[T Uze country code and area code

— Connect uzing:

= |Modem of Kircom CrediCard 100+56 7]

Configure. .. |

ak I Cancel |

4. Click the Server Types tab of the associated properties window.

5. Under Allowable network protocol, select TCP/IP.
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6. Click the TCP/IP Settings button.

Eroia R

General = Server Types i Scripting;

Type af Dial-Up Server:

PPP: "Windows indowz MT 3.5, Internet

- Advanced options:
V¥ Log on to nebwark
¥ Enable software compression

[ Require encrypted password

= Allowed network, protocols:
[~ MetBELI
[ IPX/5P Compatible

¥ TCRAP TCEAP Settings...

Issue 2
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A similar screen displays:

TCP/IP Settings HE|

% Server azsigned [P address

" Specify an IP address

| address: | oo oo |

% Server assigned name server addresses

i Specify name zerver addresses . —

Erimmary S | oo oo |

Secandarny ISt | o, o0 o |

Erimnary s S | oo oo |

Secondan SRS | oo oo |

W Use IP header compression

[ Use default gateway on remte netwark

(] I Cancel

7. In the TCP/IP Settings window, select Server assigned IP address.
8. Select Server assighed name server addresses.

9. Select Use IP header compression and ensure that the Use default
gateway on remote network is not checked.

10. Click OK.
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A similar screen displays:
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=¢ Connect To i

Eztania
User namme: ;rasaccess
Pazaword; ;

™| Save pasawond

FPhane number: ;EDE” B

Diialing from: i DR Lab

_:_j Dial Properties. . i

Connect i

Cancel

The user name and password on this screen must be rasaccess with the
appropriate password. Note that the password will be the same for each

DEFINITY system being contacted.
11. Click Connect.

12. A similar screen displays:

Comect G|

Enter a uzer name and paszward with access to the

remaote network, daomairn.

Qsername: hasaccess

Ixxxxxx1

Pazsword:

Domair: I

[ Save pazsword

[_ox ]

Cancel

A network password is not needed unless disks will be mounted, etc.
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13. Leave the domain entry blank and click OK.

=) ®  Statuz Dialing.. Cancel I

The above popup screen indicates that the laptop is trying to dial the
DEFINITY ONE server.

After a connection is established, a similar screen displays:

Connection Established [ 7] |

You are connected to Eztonia.

To digconnect or bo view status information,

double-click the dial-up icon in the statuzs area % ,
of the tazkhbar. ‘ cﬁ 1 245 PM

“'ou can also double-click the connection icon = o
it the Dial-Up Metwarking folder. o bl

[ Do not show this dialog box in the future.

tore Details...

This indicates that the laptop is connected to the DEFINITY ONE LAN. The
dial up connection is established.

Once the dial up connection is established, the caller must use one of 3
access methods. See[‘Access methods” [on page 2-16.

Via customer LAN

Customers may decide to install their LAN, which connects to the ethernet jack of
the processor interface cable. To configure DEFINITY ONE as a node on the
customer’s network, see|‘Administer customer’s LAN interface”|on page 3-7.
This interface must be administered within DEFINITY before the Windows LAN

interface can be used by any DEFINITY application. See|Eigure 2-12.|This form
needs to be administered only once for all uses.
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DEFINITY LAN gateway (DLG)

The Processor Ethernet and proprietary ASAI Adjunct Links must be enabled on
the Customer Options screen before the DLG can be administered. To administer
the DLG function for connection to CentreVu-CT, create an entry on the node
names form within DEFINITY. This defines the CentreVU CT server’s name and

address. See

£ Telnet - albania 9= B3
Connect  Edit Terminal Help
change system-parameters customer-options Page 2 of 7
OPTIONAL FEATURES
Abbreviated Dialing Enhanced List? [l CAS Branch? n
CAS Main? n
Analog Trunk Incoming Call ID? y Change COR by FAC? n
A/D Grp/Sys List Dialing Start at 01?2 y Cug Of Calls Redirected Off-net? n
Answer Supervision by Call Classifier? y DCS (Basic)? y
ARS? y DCS Call Coverage? n
ARS/AAR Partitioning? y DCS with Rerouting? n
ARS/AAR Shortcut Dialing? n DEFINITY Network Admin? n
ASAI Interface? y Digital Loss Plan Modification? n
ASAI Proprietary Adjunct Links? y DS1 MSP? n
Emergency Access to Attendant? y
Async. Transfer Mode (ATM) Trunking? n Extended Cug/Fud Admin? n
ATHMS? y External Device Alarm Admin? y
Attendant Uectoring? n Flexible Billing? n
Audible Message Waiting? y Forced Entry of Account Codes? y
Authorization Codes? y Global Call Classification? y
{NOTE: You must loioFF & loiin to effect the iermission chanies.)
F1=Cancel F2=Nxt Page F3=Submit F4=Help Esc r=Refresh

Figure 2-1. Node names form for CentreVu-CT
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E Telnet - albania [_ =1 X]
Connect Edit Terminal Help

change node-names Page 3 of 6
NODE NAMES

Name IP Address Name IP Address
centrevuserver 135.9 .4 222

F1=Cancel F2:=Nxt Page F3=Submit F4=Help Esc r=Refresh

Figure 2-2. IP Services form for CentreVVu-CT on the Windows LAN

The link must be administered on the IP services form to use the Processor
Ethernet. The service type must be adjlkl and only one link to CentreVu-CT is
permitted. The local node entry of “procr” indicates the use of the Windows LAN
interface. The local port number is set to 5678. The remote port is always zero.
Note that the client link number is handled automatically and is NOT
administered. It is set to one (1) on the client side. Event Minimization is disabled
and cannot be enabled.
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E Telnet - albania S B3
Connect Edit Terminal Help
change ip-services Page 1 of ]

IP SERVICES

Service Local Local Remote Remote
Enabled Type Node Port Node Port
ADJLK1 procr 5678 centrevuserver O

3 33333 -oHMH

F1=Cancel F2:=Nxt Page F3=Submit F4=Help Esc r=Refresh

Figure 2-3. IP Services form for CentreVVu-CT on the Windows LAN

If it is desired to use the C-LAN interface instead, then the IP-services form will
change as illustrated in figure In this example, clan-1 must be
administered on the node names form also.
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E Telnet - albania S B3
Connect Edit Terminal Help
change ip-services Page 1 of ]

IP SERVICES

Service Local Local Remote Remote
Enabled Type Node Port Node Port
ADJLK1 clan-1]] 5678 centrevuserver O

0 33333 3C

F1=Cancel F2:=Nxt Page F3=Submit F4=Help Esc r=Refresh

Figure 2-4. IP Services form for CentreVu-CT on C-LAN
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Access methods

Access DEFINITY ONE through the following methods:

[‘Via a Telnet session”fon page 2-16
[‘Via a Web browser session”Jon page 2-18

= |“Via pcAnywhere”|lon page 2-21

Via a Telnet session

Use this access method to:
» Register DEFINITY ONE with INADS
» Activate license files
» Execute GAS commands from a bash shell
= Access DEFINITY ONE SAT session
» Setup the IP address for DEFINITY ONE using setip command

See Appendix C, [‘Connect to SAT session via Telnet”[for information on

connecting to SAT via Telnet.

=> NOTE:
The IP address differs depending on the type of physical connection
established. See[Chapter H] “Installation Connectivity Quick Reference”.

1. On the laptop, click Start > Run from the Windows task bar. The Run
dialog box displays.

If you are using a PCMCIA direct connection, continue to Step 2.

N 1]

===l Type the name of a program, folder, or document, and
3 “whindows will oper it for pou.

Open:  |telnet 192.11.136 =]

¥ Buriin Separate Memon Space

0k ! Cancel J Browse. .. J

2. Entertel net {DEFINITY ONE | P Address}. Click OK.

A Telnet session opens on your desktop.
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=—>» NOTE:

There are two different scenarios, depending on whether the license file
has already been installed.

a. If no license file is installed, you are prompted for your login and

password. The only valid login is lucent3. Use the appropriate
password and continue to

Telnet - estonia

LConnect  Edit Temminal Help

Login: Tucents
rassword: |

b. If the license file is installed, you will receive a challenge response
instead of a password prompt as shown in the figures below. Use
any valid Lucent login. See|'DEFINITY ONE Lucent personnel|
llogins”]on page 2-28 for a list of valid logins. Continue to[step 3|

o Telnet - estonia

LConnect  Edit Teminal Help

Login: Tucent3

Challenge: 080-5703 Product ID:7000000000
response: B

elnet - estonia

LConnect Edit Teminal Help

Login: Tucent3

Challenge: 080-5703 Product ID:7000000000
Response: 4654439

Enter Command:

[audix | bash | cmd | definity | help | exit]
Lac >l
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3. Enter User Name and Password at the prompts. Once the Lucent Access
Control (LAC) process accepts these inputs, it allows admission into the
system.

4. To continue enter a command.

& Telnet - wing5

Connect  Edit Temminal Help

Login: Tucent3
Challenge: 183-9616
RESpONSE: 2697369
Erter Command:
Laudix | bash | cmd | definity | help | exit]

Lac =

Via a Web browser session

Customers or Lucent personnel use this method of access to DEFINITY ONE
(Windows NT or Windows 95 on their PC) to:

= Administer DEFINITY and AUDIX (WEB access to DSA)
= Backup and restore
= Shut down the system
= Activate and stop pcAnywhere
= Download DSA and Message Manager
The software can be downloaded to the technician’s laptop or a computer on the

customer’s network. The web browser provides a single point from which to start
administration activity.

The web browser interface is available for use once a physical connection is
established.

1. Open your web browser.

If your physical connection is a dial-up or PCMCIA direct connection, complete
step[2]If not, go to step[3]
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2. Verify that you are not using a proxy server:

= Ifusing Netscape, click Edit > Preferences > Advanced >
Proxies and ensure that Direct Connection to the Internet is
checked.

= If using Internet Explorer, click View > Internet Options >
Connection and ensure that Bypass Proxy Server for Local
(Intranet) Addresses is checked.

3. Type http:// <ip address> in the address area of the web browser.The IP
address also can be the name of the machine used. See
“Installation Connectivity Quick Reference”.

The DEFINITY ONE home page displays:

Lucent Technologles 6
Bail Labs Inncwat on. -

DEFINITY ONE™ Comymunications System

The singie solution for
your smali business needs.

Home

Administer
System DerinTy ONE provides you with
a high functionality, cost
effective system enabling you to
meet your current business
challenges head on while
providing the infrastructure to
bridge you to future
opportunities.

User Services

4. Click Administer System.

A similar screen displays:

Uszername and Password Required E3

Enter username for august. dr lucent. com at
august.dr.lucent. com:

Uszer Mame: ||

Pazzward: I

ok I Cancel

5. Type user name and password.
6. Click OK.
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A similar Notice screen displays:

System Administration

o DEFINITY EC2 on Bosnia " The first two links will work only

o Tntuity AUDTE on Bosnia ' you have already matalled
Home = Default AUDEE Settings DEFINITY Site Administration
YL o AUDI Metworlong OfL FOoUr Cotnputer.
Administer .
e System MMaintenance Click on the
System. aBackup & Restore ) Devwnload Saftwars link
User Services o Shutdewn or Bestart Bosma at the 1eft to install

Remote Control - polnywhere DEFINITY Site Administration.
Download o Start Host Service on Bosma
Software o otop Host Service on Bosnia

o start Java Client on your computer

Lucent Technologles 6
BallLabs Innowations

7. Read the screen and click Continue.

Once permissions are granted, the software allows you to navigate
through the system.

A similar screen displays:

System Administration

o DEFINITY EC2 on Bosnia " The first two links will work only

o Tntuity AUDTE on Bosnia ' you have already matalled
Home = Default AUDEE Settings DEFINITY Site Administration
YL o AUDI Metworlong OfL FOoUr Cotnputer.
Administer .
SRR System Maintenance Click on the
System a Backup & Restore. . Devwnload Saftwars link
User Services o Shutdewn or Bestart Bosma at the 1eft to install

Remote Control - polnywhere DEFINITY Site Administration.
Download o Start Host Service on Bosma
Software o Stop Host Zervice on Bosnia

o start Java Client on your computer

Lucent Technologles 6
BallLabs Innowations
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Via pcAnywhere

The following procedures describe how to start pcAnywhere on DEFINITY ONE
and how to start a client session in two ways:

[“Start a pcAnywhere client session from the laptop computer”|

[“Start a pcAnywhere Java client session via the Web browser”|

A CAUTION:
Turn off pcAnywhere when done.

Start the pcAnywhere application on
DEFINITY ONE

The customer or Lucent personnel uses pcAnywhere whenever direct access to
Windows NT desktop on DEFINITY ONE is required for such actions as:

= Setting system clock

= Mapping drives

= Accessing NT operations

= Upgrading software

To access pcAnywhere:

1. Run Netscape or Internet Explorer and verify that the browser is not using
a proxy server:

= Ifusing Netscape, click Edit > Preferences > Advanced >
Proxies and ensure that Direct Connection to the Internet is
selected.

= If using Internet Explorer, click View > Internet Options >
Connection and ensure that Bypass Proxy Server for Local
(Intranet) Addresses is selected.
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2. In the browser window, type:
http://<IP address>
The DEFINITY ONE home page displays.

Lucent Technologles 6
Bail Labs Inncwat on. -

DEFINITY ONE™ Comymunications System

The singie solution for
your smali business needs.

Home

Administer
System DerinTy ONE provides you with
a high functionality, cost
effective system enabling you to
meet your current business
challenges head on while
providing the infrastructure to
bridge you to future
opportunities.

User Services

3. Click Administer System.

A similar screen displays:

Username and Password Required Ed

Enter uzername for august.dr.lucent.com at
august. dr lucent. com:

Uszer Mame: ||

FPaszsword: I

ok I Cancel |

4. Enter user name and password (lucent3)
5. Click OK.

6. On the resulting administration screen, click Start> Host> Service to activate
the pcAnywhere host.

=> NOTE:

This can also be accomplished through the pcAnywhere GAS
command in a bash shell. See[Appendix G]“GAS Commands in the

bash shell”.
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Start a pcAnywhere client session from
the laptop computer

=>» NOTE:
If your laptop computer does not have pcAnywhere, you can use it through
the Java client provided via the web interface. See the next procedure,
[‘Start a pcAnywhere Java client session via the Web browser”|on page
2-24.

1. Click Start > Programs > pcAnywhere.

2. Within pcAnywhere, if you have a client icon for DEFINITY ONE, double
click this icon. Otherwise create one as follows:

a. Onthe pcAnywhere screen, click Remote Control.
b. Click Add Remote Control Item.
c. Give the new remote control item a unique name.

=>» NOTE:

Once this icon is created, it can be used to connect to any
DEFINITY ONE over a generic PCMCIA connection.

d. Click Next.

e. Select tcp/ip as the connection device.

f. In the machine name field, type <IP address>.

g. Click Next.

=>» NOTE:

You may check the Automatically begin remote session
upon wizard completion box if you want to bring up the
session as you exit the wizard.

h. Click Finish.

i. If you did not check the box in step g, double click the newly
created icon.

A connection to DEFINITY will be established.

j- When prompted for a login ID use lucent3.
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k. Leave the domain entry blank.
I. When prompted for a password, enter the appropriate password.

The Windows NT desktop of the DEFINITY ONE system will be
displayed on the laptop.

=>» NOTE:
When using pcAnywhere, the Windows NT desktop overlays the Windows
95 desktop, it is sometimes difficult to know which desktop screen is being
referenced. For example, to access the Start menu of the laptop’s Windows
95 desktop, you may have to scroll the Windows NT desktop up or down
using the scroll bar on the right side of the pcAnywhere screen. You may
want to temporarily reduce the pcAnywhere screen when access to the
Windows 95 desktop is required.

Start a pcAnywhere Java client session via
the Web browser

This procedure allows access to DEFINITY ONE via a java client on a web
browser.

1. Start your web browser.

2. Click Start Java Client on your computer.

=>» NOTE:
pcAnywhere software does not have to be loaded on your PC or
laptop. The web browser needs to be either Netscape Navigator
version 4.1 or later or Internet Explorer version 4.0 or later. The Java
client is known as “pcAnywhere EXPRESS.”

A license agreement appears.

3. Click Yes.

=>» NOTE:
If you click No to this message or any other message, or if you reject
anything at any time, a connection will not be made. If you click
Back on the web browser window, a screen appears on which other
actions (including attempting to reconnect) can be performed.

A warning that the Java applet is requesting additional privileges may
appeatr. It is trying to contact the DEFINITY ONE server. If this happens,
click the Grant button. Also click Remember this decision if you do not
want to see this warning again.

A connect window displays, asking you to choose which system to
connect to. Only one TCP/IP host will be shown: <IP address> (unless you
are connected via the customer’s LAN).
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4. Highlight this and click Connect.

If no hosts are shown, the pcAnywhere server on DEFINITY ONE is
probably not running. If this is the case, ensure that you activated
pcAnywhere properly. If you are sure that it is running, enter <IP address>
in the Host Name: field and click Connect.

A “Connecting to Host” window appears for a while, and is replaced by a
“Security Dialog” window.

5. Type the Login Name and Password. Use lucent3 and its password.

Another “Connecting to Host” window appears for a while and then the
web browser window contains a view of the DEFINITY ONE’s main console
screen.

The screen will probably be larger than the web browser window and so
scroll bars will show and can be used to look at different parts. The Full
Screen icon in the top toolbar can be clicked and the DEFINITY ONE
screen becomes as large as the PC or laptop’s screen and scroll bars are
no longer needed. When this is done, the toolbar is hidden, and the right
arrow button in the upper left corner can be clicked to display the toolbar
again.

A WARNING:
Changing the window size of your web browser window (by
dragging a corner or maximizing) or going to other links with that
window will either disconnect the session or attempt to run a new
session. Use only the controls on the pcAnywhere EXPRESS toolbar
until you are ready to disconnect.

=>» NOTE:
To continue to use the web browser while you are connected through
pcAnywhere EXPRESS, use the web browser’s new window feature.

6. Click the End Session icon to cause a confirmation window to appear.

7. Click “Yes” to disconnect from DEFINITY ONE and allow the web browser
window to be used again.
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System administration/DEFINITY site
administration (DSA)

DSA provides the standard Windows look and feel for performing basic switch
administration. This includes wizards, tabbed windows, menus, and dockable
windows. Customers who use DSA may administer telecommunications
equipment as only a portion of their job responsibilities, and few will be expert
users.

DSA offers customers a graphically-enhanced command line interface (called
the Graphically Enhanced DEFINITY Interface, or GEDI) and a terminal emulation
mode for SAT administration.

Access commands are available in the DEFINITY ONE system from the DSA
application. Once the application is connected to the switch, commands can be
entered on the command line in a similar way to using the SAT screen, or
commands can be selected from the command lists appearing in the left frame

of the screen, as shown in the|screen below.
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L' DEFINITY Site Administration - conl

' DEFINITY Site Administration - con

File Edit View Tools Window Help File Edit Yiew Toolz Window Help
| oEExEE e = e EE R
i x
General @ Wiorkzpace
--{E] Button Labels
T Start GEDI =[] contry test switch
[ [#-{_] Abbreviated Dialing
& Add User -] Call Certer

-] Cowverage
-3 Groups
-3 Metwork
#1- Parameters

#% Change User name

# Remave Llzer

+ Add Bridged Appearance -] Station
. -7 Status
" Browsze Dial B anges El{:] System

----- [#] change cos

=0 L N - [® change dialplan
S Brawze Unused Ports [PV | (7] change feature-access-o
. b - P list autharization-cods
&1 FindUruzed Extenzion | /| I S [#] list car
---- [#] list extension-type
&% PrintButtonLabels |V | . & list lagins
----- [#] et time
Advanced
Add Spztem 1 | | _.,I
¥ Tasks |"B Tree I Y Tasks P8 Tree

Use the key for a list of options.

For help with DSA, click the Help menu. For further information regarding the
operation of the DSA application, see[‘System administration/DEFINITY site|
[administration (DSA)”[on page 2-26
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These are the DEFINITY ONE logins for Lucent personnel. See[‘Enable customer|
logins”]on page 3-5 for further information on logins.

Logins to enter system

Logins to enter DEFINITY

Logins to enter AUDIX

lucentl dinit atsc
lucent2 dinads acraft
lucent3 dcraft acraft

= Each row of logins has the same password. For example, the lucentl,
dinit, and atsc logins all have the same password.

= The lucent logins are used for web browser and pcAnywhere access.

= Alllogins work for Telnet access.

= The d and alogins (columns 2 and 3) are used for DSA access.
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System Initialization

This chapter describes the procedures needed to initialize the DEFINITY ONE
system and is organized as follows:

[“Power up and observe LEDs”|on page 3-2

[“Connect the laptop computer to DEFINITY ONE” jon page 3-2

[“Start a Telnet session”|on page 3-2

[“Verify the software version number”on page 3-2

[“Determine the serial number’|on page 3-3

[“Obtaining a license file” Jon page 3-3

[“Resolve alarms”|on page 3-4

[“Place a test call”’|on page 3-5

[“Enable customer logins”]on page 3-5
[“Administer DEFINITY ONE”|on page 3-6
{— Set the Time/Day on DEFINITY ONE|
{— Check System Status from bash|
{— DEFINITY Commands|
{— Modem Set-up|

[“Set up Call Accounting”lon page 3-11
[“Administer DEFINITY for AUDIX initialization” jon page 3-13

[*“AUDIX administration” |on page 3-22

[“Download Message Manager and DSA”|on page 3-25
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Power up and observe LEDs

See[‘LED boot seguence”[on page E-1.

Connect the laptop computer to
DEFINITY ONE

For this procedure, see[‘Connect the laptop computer to DEFINITY ONE”Jon
page C-2.

Start a Telnet session

See[‘Via a Telnet session”|on page 2-16 for an explanation of how to start a
Telnet session.

Verify the software version number

The following procedure verifies the software version number with the CD-ROM
that shipped with the system.

1. From the bash prompt, type swversion and press (ENTER). This will display
information about the version of software running on the system. The first
line will display a string like:Release=G3V8c.02.0.014.0, which shows the
load number of the software; in this case, load 14.

2. Remove the CD-ROM that shipped with the system in the door of the
cabinet. Verify that the load number stamped on the CD-ROM matches the
load number found in step 1.

3. If the load numbers match, continue to determine the serial number. If the
load numbers do not match, the system software may need to be updated
before proceeding further; see|‘Update software”|on page 5-1. If the
software on the hard drive is newer than the software on the CD-ROM,
then escalate the problem.
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Determine the serial number

1. From the bash prompt, type serialnumber and press (ENTER).
The serial number is read and displayed.

2. Ensure that the serial number matches the label on the front of the circuit
pack. If it does not match, use the serial number you obtained from the
software mechanism — not from the label.

=—>» NOTE:

The serial number obtained in Step 1 is the number embedded in the
firmware and must be used.

Obtaining a license file

The procedure required for the installation technician to obtain a license file
includes tasks performed by both the technician and the DEFINITY Database
Administration (DBA) Group at INADS.

License file installation information is available online. For further information,
contact your Lucent technical services representative.

= For external access: www.lucent-teamworks.com

» For internal access: http://info.dr.lucent.com/~epr/contry

=>» NOTE:

These procedures may not be applicable to international applications. For
assistance, contact your Lucent representative.

1. Connect to the Laptop Computer following the procedure, [‘Connect the
[laptop computer to DEFINITY ONE”[on page C-2.

2. Establish a Telnet session following the procedure['Via a Telnet session”|
on page 2-16.

3. At the LAC prompt, type bash.

4. Call (800) 248-1234 and press the numbers for the INADS administrator
group (6 and then 2).

5. Ask for the license file by supplying the following information:
— Human Resources ID (HRID)
— DOSS order number
— TN795 serial number
— Installation Location (IL) code

— INADS modem telephone number
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The database administrator at INADS assigns a RAS IP address. INADS will
execute the following steps using a set IP command:

» Execute the setip command on DEFINITY ONE by typing setip ras = and
the INADS IP address. See[‘setip command”|on page G-5 and[*Setting]
[the name of the switch”|on page C-15.

» Reboot the system, using the reboot nice command in the bash shell.

6. One the system has rebooted, notify INADS that the system is ready to be
dialed into. The INADS database group will establish connection to the
system and download the license file.

7. Register adjuncts if applicable. Inform INADS if there are any other
products to be registered, such as DEFLAN, CMS, etc., especially if there
are products that should alarm to INADS. Also tell INADS if there are any
external devices to alarm off the switch.

The installconfig command is run by the DEFINITY Database Administration
Group (DBA) The command takes information from the license file for the system
to reboot. After the system starts again, DEFINITY ONE’s user IDs with new
passwords are set that correspond to what was in the install file. The control file
has the serial number of the TN795 circuit pack and is valid only on this circuit
pack. The control file cannot be used to activate software on any other DEFINITY
ONE system. See

The system is ready and all applications on the DEFINITY ONE platform are
automatically started by the Watchdog process.

The DEFINITY ONE Emergency Transfer light goes out.

The installation is complete. Since translations were not removed, they are still
present on the system. A restore is not needed during the normal installation.

Since the system rebooted, the browser and pcAnywhere connections will be
lost.

Resolve alarms

Resolve any alarms using DEFINITY ONE Communications Server
Maintenance, (555-233-111).

Check system status

See|“Lucent access controller bash commands’{on page G-1 for information
about bash commands that are used in installation and administration.

1. Bring up a bash shell.

2. To verify system health, execute d1stat and alarmstat.
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Place a test call

1. From any telephone connected to a digital line circuit pack, call any
nearby telephone connected to an analog line circuit pack.

2. Verify that the dial tone, ringing pattern, and talk path are acceptable.

3. Place a call through the Central Office (outside call) to any nearby
telephone.

4. Verify that the dial tone, ringing pattern, and talk path are acceptable.

Enable customer logins

This section contains information on:

1311

on page 3-5
= [“Enable customer Web logins”|on page 3-6

See [Appendix B]“Set Up and Use of Customer Logins” for information and
procedures on:

» AUDIX logins for customer accounts (vm, sa, browse)
» Customer logins to the web interface

» User level logins within DEFINITY

Table 3-1. DEFINITY customer logins

DEFINITY Default
customer logins Comments password
deftyl This is the customer level “super

user” login within the DEFINITY
application. Its use should be
restricted to the system
administrator. This login can be
used to create additional
DEFINITY logins. See the
DEFINITY command add login.

Enable AUDIX logins

See [Appendix B “Set Up and Use of Customer Logins”. Appendix B also
includes information on the AUDIX logins sa, vm, and browse, and the uses of
each login as well as AUDIX commands accessible to each login.
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Enable customer Web logins

When the system leaves the factory, the only login that has access to the web
interface is the login NTadmin. The customer may wish to create additional
logins; for example, to download the Message manager. See Appendix B,
[“Windows NT logins for the customer”’|on page B-3.

Enable DEFINITY Logins

See['DEFINITY logins for the customer”]on page B-9

Administer DEFINITY ONE

DEFINITY ONE commands

DEFINITY ONE bash commands are useful for administration and installation
tasks. These commands are allowed for the Lucent services login. See[*Lucent]
[access controller bash commands”|on page G-1, and DEFINITY ONE
Communications System Maintenance, (555-233-111) (also on the
documentation CD), for information about these commands.

Set date/time/time zone (Windows NT)

Set the computer and DNS name to 8 characters or less. For example, define.

=—>» NOTE:

pcAnywhere does not have to be used for connection via a monitor and
keyboard. It is used if you are accessing DEFINITY ONE via a PCMCIA
ethernet card, LAN, or RAS connection.

The following procedure describes setting the date and time.

1. Connect to the DEFINITY ONE desktop by following the proc
PCMCIA ethernet (NIC) network connection”|on page 2-2 or|[‘Via local
monitor/mouse/keyboard”|on page 2-2.

2. Click Settings > Control Panel.
The Control Panel screen displays.
3. Click Date/Time.
The Date/Time Properties screen displays.
a. Select the correct day, month, and year.

b. Click Time Zone.
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1. Select the correct time zone.

If you are in an area that does not go on daylight savings
time, uncheck the box before, Automatically adjust clock
for daylight savings change.

Administer customer’s LAN interface

The customer’s LAN connects to the ethernet jack of the processor interface
cable. See|“setip command”|on page G-5 for more information on the setip
command from the command line interface. See Windows Help for the Windows
NT method to change interface parameters.

The customer provides:
» [P address
= Subnet mask
» Default gateway

In the event that a customer needs a new IP address, customers can access the
NT desktop via pcAnywhere.

Change customer options

Refer to DEFINITY Enterprise Communications Server Release 8.2
Administrator's Guide, (555-233-506) to view a sample screen.

The following DEFINITY features are part of the basic software package and do
not require activation. They default to y (yes) on the Optional Features form.

» ARS/AAR Partitioning

» Emergency Access to Attendant

= Service Observing

=>» NOTE:

A lucentl login is required to change customer options. Contact your
regional Customer Software Administrator (CSA) to perform this function.

1. In a SAT session or DSA window, type change system-parameters
customer-options and press (ENTER).

2. Using the customer order, enable the optional features purchased by the
customer (as shown by PEC codes on the customer order).

3. Press when finished to submit the form.
4. Log off and then log back in to set the customer option changes.

5. Type save translations.
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Set country options

Some of the country options must be set on the change system parameters
country options screen, displayed below, to turn off the red alarm LEDs.

1. Enter change system-parameters country options and press ENTER.
2. A similar screen displays:

change euston-paranctars country-options Page 1 of 23
EVETEH PRRAHETERS COUNTRY-OPTIONE
Conpanding Modo: Hu-Law Baao Tonn Gonorater Sot: 1
L50H= PEX-diel Tene? n 4R0Hz Seesndery-dial Tens®

finaleg Rimging Cadance: 1 fok Layer 1 tiper T1 ko 38 sgconds® n
Analag Liny Tranemisaicn: 1

B4/ 8Yxx Display Character Sot: Roman

Houlor Tone AFtor Busy? m Dizconnoct on Mo dnswor by Call Type?
TOME DETECTLION PARAHETERS

Teme Dotockion Modo: &
Interdigit Pauss: short

The default (United States) companding mode is mu-law. If the country uses
A-Law companding, proceed to the next step.

3. Enter A-Law.
4. Click ENTER.
=—>» NOTE:

Other items eventually need to be entered on this screen, but this is all that
is needed to turn the red alarm LEDs off.

The country codes are set as heeded according to the following fields:

1. Digital Loss Plan:
2. Analog Ringing Cadence:

3. Analog Line Transmission:

See|[Table 3-9.

Log into the System
1. Verify that the screen displays: Login:
2. Enter craft.
3. Click ENTER.
4

. Enter crftpw.
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5. Click ENTER.

The password does not display as it is entered. The screen displays the
system software version and the following terminal types: (513, 715,
4410, 4425, VT220):[513].

6. Enter the type of management terminal (such as 715).
7. Click ENTER.
Check System Status
The system status may suggest problem areas. Refer to DEFINITY Enterprise
Communications Server Release 8, Maintenance for R8csi.
To access system status:
1. Enter status system all-cabinets.
2. Click Enter.

3. Verify that the screen displays the service state of i n for all appropriate
areas.

Table 3-2. Country Codes

Country Code Country Code
USA 1 France 12
Australia 2 Germany 13
Japan 3 Czechoslovakia 14
Italy 4 Russia 15
The Netherlands 5 Argentina 16
Singapore 6 Greece 17
Mexico 7 China 18
Belgium 8 Hong Kong 19
Saudi Arabia 9 Thailand 20
United Kingdom 10 Macedonia 21
Spain 11

Set up your system

You are now ready to follow procedures to launch your system including:
= Setting up dial plans, feature access codes (FACs), and extension ranges

= Adding extensions for users
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Setting up special features

Setting up routing

Assigning and changing users

See|‘Configure DSA”|on page 7-7 to set up DSA.

For more information, see:

DEFINITY System’s Little Instruction Book for Basic Administration,
(555-230-727)

DEFINITY System’s Little Instruction Book for Advanced Administration,
(555-233-712)

DEFINITY System’s Little Instruction Book for Basic Diagnostics,
(555-233-713)

DEFINITY Enterprise Communications Server Release 8.2 Administrator’s
Guide, (555-233-506).

The on-line DSA help

Add translations

1. Refer to DEFINITY Enterprise Communications Server Release 8.2

Administrator's Guide, (555-233-506) to add new terminals.

Administer telephone features

1. Administer these features (DEFINITY Translations, AUDIX Mailboxes, etc.)

per customer order via one of two ways:
a. DSA (web)

DSA must be installed on the laptop or remote PC that is connected
to the system

Connect the PCMCIA card with the laptop or through Remote PC
using the web browser (Windows Explorer or Netscape).

b. Lucent Access Control (LAC) [telnet]
(For direct SAT access without going through DSA)

Telnet to DEFINITY ONE through the LAC to receive the SAT screen.
See[‘Start a Telnet session’’Jon page 3-2.
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Set up Call Accounting

Lucent Technologies provides the following call accounting products to help
reduce telephone expenses, optimize resources, assign costs, identify abuse,
and clearly understand telephone expenses and convey that understanding to
others:

» Telecommunications Management System (TMS)
» Call Accounting System NT (CAS-NT)
» Call Accounting System (CAS) for Windows

The following is an example of how to set up one of these products, Call
Accounting System (CAS) for Windows, a comprehensive call accounting
package that runs on a PC as a Windows application. It receives Call Detail
Records (CDRs) from a switch on premises and processes the information into
management reports. DEFINITY ONE creates the CDR file where the CDR
records are written and the file is put into a directory. CAS for Windows is widely
compatible and requires little maintenance, even while collecting data,
generating reports, and managing remote data collection sites.

CAS for Windows needs access to come across the network to access the file
and directory with full read and write permissions. DEFINITY ONE has to share
the CDR directory with full permissions. This procedure will only work if you have
a keyboard and monitor, pcAnywhere, or have already mapped your PC to the
drive on DEFINITY ONE.

=>» NOTE:
Depending on the customer’s specific network, the setting up of CAS for
Windows access will vary. See the system/network administrator to ensure
that proper permissions are set up for the file and directory.

1. Fromthe DEFINITY ONE desktop, right click Start, either locally or through
pcAnywhere.
2. Click Explore.
The Windows Explorer screen displays.
3. Click + by the D drive.
The D drive folders display.
4. Click + by Lucent Data.
The Lucent Data folders display.
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5. Click Cdr.

10.

11.

12.
13.

14.

15.
16.

17.

18.
19.

If cdr has been enabled in the switch, you see two files, cdr.out and cas.in.

The CAS for Windows (CDR Collection device) obtains the CDR records
from cas.in and then removes that file. The current CDR records are
placed in cdr.out. When this file reaches a certain size, the cdr.out file is
renamed cas.in. CAS for Windows obtains those CDR records from cas.in
as more current records are placed in cdr.out.

In order for CAS for Windows to remove cas.in, the CDR folder must be
shared with permissions granted to the user login under which CAS for
Windows is running.

Right click cdr.

Click Properties.

Click Sharing.

The CDR Properties screen displays.
Click Shared As.

Click Permissions.

The Access Through Shared Permissions screen displays and
highlights Everyone / Full Control.

Click OK.

The Properties screen displays.

Click Security.

Click Permissions.

The Directory Permissions screen displays.

Click Add.

The Add Users and Groups screen and the groups display.
Click Show Users.

Highlight the login under which CAS for Windows will be running. (See the
LAN administrator if you do not know the user.)

Click Add.

The Add Names box displays the user.
Click Full Control under Type of Access.
Click OK.

The Directory Permissions screen displays.
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20. Click OK.

21.

The CDR Properties screen displays.
Click OK.

The hand on cdr indicating sharing displays.

Administer DEFINITY for AUDIX
initialization

Check the Dial Plan

The dial plan tells the system how to interpret dialed digits and how many digits
to expect for certain calls. For example, if a 9 is dialed to access an outside line,
the dial plan tells the system to find an external trunk for a dialed string beginning

with 9.

To check the dial plan:

1.

3.

At the SAT or DSA window, enter disp dial.

The Dial Plan Record form displays, which should have the correct local
node number and extension length.

display dialplan

DIAL PLAN RECORD
Local Node Number: 13
ETA Node Number:
Uniform Dialing Plan: 4-digit ETA Routing Pattern:
UDP Extension Search Order: local-extensions-first
FIRST DIGIT TABLE
First Length
Digit -1 - -2 - -3 - - 5 6
1:
2: extension
3:
4:
5:
6:
T: dac
8:
9: dac
0:
*: fac fac
#: fac fac

Command: I

Make note of the local node number (first digit) and the extension length.
The number of digits or the local node number can only be changed
through the web interface.

Press [Cancel].

Check Hunt Groups

1.

At the SAT or DSA window, type list hunt group.
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The Hunt Groups form displays.

list hunt-group group

HUNT GROUPS

Grp Grp
No. Name/ Grp ACD/ Que No. Cou Notif/ Dom Message
Ext Type MEAS Vec MCH Siz Mem Path Ctg Adj Ctrl Center
1 monroe voice hunt
2000 ucd-mia n/- n none 8 8 n A
2 paradox veice hunt
2600 ucd-mia n/- n none 8 8 n n
3  rockuille uoice hunt
2650 ucd-mia n/- n  none 6 8 n h

Command successfully completed
Command :

2. Note the following information about the AUDIX hunt group:

= Grp No.
= Grp Name
= Ext

3. Press [Cancel].

Check Class of Service

1. Atthe SAT or DSA window, type disp cos.

The Class of Service form displays.

display cos

CLASS OF SERVICE

0 1 2 3 45 6 7 8 910111213 1415
Auto Callback n Yy Yy n ynynynwynwyhnuyn
Call Fwd-All Calls n 'y nyynmnyynmnywynnywy
Data Priuvacy n Yy nonnnwywyywyonmnonmnuyWyyWuy
Priority Calling n Yy n nnonnmnwnuywywywywyuy.py
Console Permissions n n nnhn nNnnNnnNnnNnnNnnNDNDNDNDNDNDN
0ff-hook Alert nnnNnnNnnNnnnnnNnR~NONHORANDNDNMNDNDRN
Client Room nnnNnnNnnNnnnnnNnR~NONHORANDNDNMNDNDRN
Restrict Call Fud-Off Net Yy Yy Y Y Yy yyyyyywywyyH py
Call Forwarding Busy/DA n N h N nNnnNMNDNMNDNMRNDNDNDNDNDN
Personal Station Access (PSA) n n n n n n n n n nn nnanonoan
Extended Forwarding All n N h N nNnnNMNDNMNDNMRNDNDNDNDNDN
Extended Forwarding B/DA n N h N nNnnNMNDNMNDNMRNDNDNDNDNDN
Trk-to-Trk Transfer Querride n n n n n n n h nh h nnnannon
QSIG Call Offer Originations n N h N nNnnNMNDNMNDNMRNDNDNDNDNDN

Command: I

2. Find the COS you plan to use for the AUDIX port stations, it is usually
COS 5.

Ensure that Data Privacy and Restrict Call Fwd-Off Net are set to y.
4. Ensure the other fields are set to n.

Press [Cancel].
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Check Class of Restriction

a M DN

At the SAT or DSA window, type disp cor 1, where 1 is the COR you plan
to use for the AUDIX port stations.

The Class of Restriction form displays.

display cor 1 Page 1 of H
CLASS OF RESTRICTION

COR Number: 1

COR Description: audix
FRL: 7 APLT? y
Can Be Seruice Obserued? n Calling Party Restriction: none
Can Be R Seruice Observer? n Called Party Restriction: none
Time of Day Chart: 1 Forced Entry of Account Codes?

n

ni

n

>

Priority Queuing? Direct Agent Calling?
Restriction Ouerride: Facility Access Trunk Test?
Restricted Call List? Can Change Couerage?

5333

Access to MCT?
Category For MFC ANI:
Send ANI for MFE? n
MF ANI Prefix: Automatic Charge Display?
Hear System Music on Hold? y PASTE (Display PBX Data on Phone)?
Can Be Picked Up By Directed Call Pickup?
Can Use Directed Call Pickup?

Gruui Controlled Restriction: inactive

Ensure that the COR has an FRL of 7 to allow for Outcalling and Fax Print.

Fully Restricted Seruice?

—~Nc
S

=3 333

Ensure that Calling Party Restriction is set to none.
Ensure that Time of Day Chart is setto 1.

Press [Next Page].

Page 2 of the Class of Restriction form displays.
Press [Next Page].

Page 3 of the Class of Restrictions form displays.

display cor 1 Page 3 of 4
CLASS OF RESTRICTION

CALLING PERMISSION (Enter "y~ to grant permission to call specified COR)

0? y 129 y 24?7 y 367 y 487 y 60? y T2? y 84?7 y
1?7y 13?7 y 25? y 37?7 y 497 y 61? y 73? y 857 y
2? y 149 y 267 y 387 y 507 y 62? y TH? y 867 y
3Py 152 y 27?7 y 39?7 y 51? y 63? y 75?7y 877 y
4?7 y 167 y 287 y 40?7 y 527 y 64?7 y 767 y 887 y
57 y 17?2 y 297 y H?y 53? y 65? y TT? y 897 y
6? y 18?7 y 30? y 42? y 54?7 y 66?7 y 78?7 y 90?7 y
TPy 197 y 31?7 y 43? y 557 y 67T? y 79?7 y 91? y
8?7 y 207 y 32? y 447 y 567 y 68?7 y 80?7 y 92? y
9? y 21?7 y 33?7y 457 y 57? y 69?7 y 81?7 y 93? y
107 y 22?7 y 34? y 46? y 587 y 70? y 827 y 94? y
11?2y 23? y 35? y 47? y 59?7 y T1?y 83? y 95? y

—
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7. Ensure that all fields are set to y so there are no restrictions.

=>» NOTE:

Pay attention to toll fraud issues.

8. Press [Cancel].

Change the Dial Plan

To change the dial plan, enter disp dial at the SAT or DSA Window.
1. Enter change dialplan.

2. Press Return.

The Dial Plan Record screen displays:

display dialplan

DIAL PLAN RECORD

Local Node Number: 13
ETA Node Number:
Uniform Dialing Plan: 4-digit ETA Routing Pattern:
UDP Extension Search Order: local-extensions-first
FIRST DIGIT TABLE
First Length
Digit - 1 - -2 - -3 - -4 - -5- -6 -

extension

dac

fac fac
fac fac

Command: I

3. Click the field in the row 7, column 3.

K OWLDNOU EWN =
a
o
o

This field defines system function when users dial any number from 700 to 799
4. Enter dac in the selected field.

5. Press Enter to save your changes.
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Add extension ranges

New extension can be added as your needs grow. Each new extension must
belong to a range that is defined in the dial plan.

To add a set of extension stat, for example, start with 3 and are 4 digits, such as
3000-3999:

1. Enter change dialplan and press Return

The dial plan record screen appears:

display dialplan

DIAL PLAN RECORD
Local Node Number: 13
ETA Node Number:
Uniform Dialing Plan: 4-digit ETA Routing Pattern:
UDP Extension Search Order: local-extensions-first
FIRST DIGIT TABLE
First Length
Digit - 1 - -2 - -3 - -4 - -5- -6 -
1:
2: extension
3:
4:
5:
6:
T: dac
8:
9: dac
0:
%*; fac fac
#: fac fac

2. Click row 3 in the column 4.
3. Enter extension in the selected field.

4. Press ENTER to save your changes.

Add stations

Stations are added by entering a change machine command with the starting
and ending numbers. For example, 0000--9999 starting and ending range for a
4-digit extension length.

This procedure sets up stations for AUDIX ports.

1. Atthe SAT or DSA window, enter add sta <number>, where number is the
station you want to use for the first AUDIX port.
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N o g &

10.

The Station form displays.

change station 2001 Page 1 of 3
STATION

Extension: 2001 Lock Messages? n BCC: ©
Type: 2500 Security Code: TN: 1
Port: B1A1201 Coverage Path 1: COR: 1
Name: monroe up#i Couerage Path 2: C0S: 5

Hunt-to Station: Tests? n

STATION OPTIONS

0ff Premise Station? n Message Waiting Indicator:

—

Type 2500 in the Type field.
Type 01A1201 in the Port field.
=> NOTE:

This is a virtual port used to communicate between DEFINITY and
AUDIX.

Type a name in the Name field.
Enter the correct COR and COS.
Ensure that Tests? is set to n.
Press [Next Page].

Page 2 of the Station form displays.

change station 2001 Page 2 of 3
STATION
FEATURE OPTIONS
LWC Reception: audix

LWC Activation? n Coverage Msg Retrieval? n
CDR Privacy? n Auto Answer: nonel

Redirect Notification? n Data Restriction? n

Per Button Ring Control? n Call Waiting Indication? n

Bridged Call Alerting? n Att. Call Waiting Indication? n

Switchhook Flash? y Distinctive Audible Alert? n

Ignore Rotary Digits? n Adjunct Superuision? y
H.3208 Conuersion? n

Per Station CPN - Send Calling Number? _

Audible Message Waiting? n

Ensure that LWC Reception is set to audix.

Ensure that all other fields, except for Switchhook Flash and Adjunct
Supervision, are set to n.

Press [Next Page].
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Page 3 of the Station form displays.

change station 2001
STATION
SITE DATA

Room:

Jack:

Cable:
Floor:
Building:

ABBREVIATED DIALING

Listi: List2:

HOT LINE DESTINATION

Line Appearance: call-appr

Cor
S

D

Page

Headset? n
Speaker?
Mounting:
d Length:
et Color:

List3:

Abbreviated Dialing List Number (From aboue 1, 2 or 3): _
ial Code:

‘ ‘(D\D_D\
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3 of 3

—

11. Ensure that Line Appearance is set to call-appr.
12. Press (F3 [Enter].
13. Type duplicate station <number>, where number is the station you set
up for the first AUDIX port.
14. The Duplicate Station form displays.
duplicate station 2001 Page 1 of 4
STATION
Security
Ext Port Natie Code Root Jack Cable
2002
15. Add the 7 remaining stations.

This allows you to add all the stations at the same time on the same form.
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Make a Hunt Group

1. Atthe SAT or DSA window, type add hunt next.
The Hunt Group form displays.

add hunt-group next Page 1 of 10
HUNT GROUP
Group Number: 4 ACD? n
Group Name: AUDIX Queue? y
Group Extension: 29008 Uector? n
Group Type: ucd-mia Couerage Path:
TN: 1 Night Seruice Destination:
COR: 1 MM Early Answer? n

Security Code:
ISDN Caller Display:

Calls Warning Threshold:

Queue Length: 8
Time Warning Threshold: :

N

Note the Group Number.

w

. Type a name in the Group Name field.

E

Type the Group Extension, that is the Extension from the Hunt Groups
form.

Ensure that Group Type is set to ucd-mia.
Ensure that Queue is y and Queue Length is 8.
Press [Next Page].

The Hunt Group form displays.

add hunt-group next Page 2 of 10
HUNT GROUP

Message Center: audix

Calling Party Number to INTUITY AUDIX? n
LWC Reception: none

First Announcement Extension: Delay (sec): __

—

9. Ensure that Message Center is set to audix.

10. Press (TAB).
The Calling Party Number to INTUITY AUDIX field appears.

11. Ensure that this field is set to n.
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12. Ensure that LWC Reception is set to none.
13. Press [Next Page].

You receive page 3 of the Hunt Group form.

add hunt-group next Page 3 of 108
HUNT GROUP
Group Number: 4 Group Extension: 2900 Group Type: ucd-mig
Member Range Allowed: 1 - 200 Administered Members (min/max): 8 /@
Total Administered Members: B
GROUP MEMBER ASSIGNMENTS
Ext Name Ext Name
1: 2001 14:
2: 2002 15:
3: 2003 16:
4: 20084 17:
5: 2005 18:
6: 2006 19:
7: 2087 20:
8: 2008 21:
9: 22:
10: 23:
11: 24:
12: 25:
13: 26:
At End of Member List

14. Type the extensions of the 8 stations you entered before.

15. Press [Enter].

Change Coverage Path

1. Atthe SAT or DSA window, type add cov pa 1.

You receive the Coverage Path form.

add couerage path 2 Page 1 of 1
COVERAGE PATH

Coverage Path Number: 2
Hunt after Couerage? n

Next Path Number: Linkage
COUERAGE CRITERIA
Station/Group Status Inside Call Outside Call
Active? n n
Busy? y y
Don't Answer? y y Number of Rings: 3
ALl? n n
DND/SRC/Goto Couver? y y

COUERAGE POINTS
Terminate to Couerage Pts. with Bridged Appearances? n

Pointl: hi Point2: Point3:

Point4: Point5: Point6:

2. Ensure that Number of Rings is set to 3.

3. Ensure that Pointl is set to the AUDIX hunt group that you previously set
up.
4. Press F3 [Enter].
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Add test phones

1. Atthe SAT or DSA window, type add sta next.

add station next Page 1 of 4
STATION
Extension: 2009 Lock Messages? n BCC: ©
Type: 6408D+ Security Code: TN: 1
Port: Coverage Path 1: 2 COR: 1
Name: test station 1 Couverage Path 2: _ Ccos: 1

Hunt-to Station:

STATION OPTIONS

Data Module? n Personalized Ringing Pattern: 1
Speakerphone: 2-way Message Lamp Ext: 2009
Display Language: english Mute Button Enabled? y

—

2. Type the type of phone you are using in the Type field.

3. Type the port in the Port field.

4. In the Coverage Path 1 field, type the number of the coverage path you
just created or changed.

o

Fill in any other appropriate fields.

AUDIX administration

This section provides information about AUDIX commands and administering
AUDIX initialization. For additional information about AUDIX administration, refer
to the AUDIX Administration PDF files on the Documentation CD and DEFINITY
ONE Communications System AUDIX Command Line Administration Quick
Reference (555-233-737).
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AUDIX commands

Commands available to change system settings and subscriber information in
the AUDIX application are executable from the AUDIX command prompt. Users
access the AUDIX command prompt from the DSA or Telnet interface. To view a
list of commands, click Fé [Choices], from the command prompt. The following
AUDIX screen displays:

Active Alarms: none

enter new administrative records
audit to validate system data
change to modify existing administrative records

copy to copy announcements and fragments

display to display administrative records and maintenance logs
exit to exit from AUDIX administration and maintenance

get to request remote updates

help to display available types of help

list to produce reports

logoff to log off the system

print to send the command output to the attached printer
remoue to remoue administratiuve records

reset to restart or shutdown the Messaging Core

test to test alarm origination or outcall

toggle to toggle the function key settings

trace to turn on amis trace

enter command: I

Adding an AUDIX subscriber

After completing the machine level translations, subscribers must be added to
the DEFINITY ONE system. The following forms detail the addition of AUDIX
subscribers. Enable the AUDIX forms via DSA or Telnet.

1. Start at the AUDIX command prompt screen.

2. Enter the command Add Subscriber and the extension number that the
new subscriber will use.

3. Enter the data for the subscriber on page 1 of the Add Subscriber Form as

detailed in[Table 3-24.
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Add Subscriber Form, page 1

nonr oe Active Al arms: WA LCogins: 1
add subscri ber 2600 Page 1 of 2
SUBSCRI BER
Nanme: Jones, John Locked? n
Ext ensi on: 2600 Passwor d:
COS: class01 M scel | aneous 1:
Swi t ch Number : M scel | aneous 2:
Community I D M scel | aneous 3:
Secondary Ext: M scel | aneous 4:
Account Code: Covering Extension:

Broadcast Mai | box?

Emai | Address:

Press [ENTER] to execute or press [CANCEL] to abort
enter command: add subscri ber 2600

Table 3-3. Field definitions for Add Subscriber screen, page 1

Field Valid input Description

Name Subscribers Name This is the name of the subscriber. In the
example above: Jones, John

Extension | Extension humber This is the extension number assigned on
DEFINITY for the subscriber

Password | Can be alpha or numeric | Subscribers password. Input a temporary
password and instruct the new subscriber to
change their password when they log in to AUDIX

COs class00 to class11 Class of service; contains features that a AUDIX
subscriber could be enabled to use. Setup the
Class of Service on the system before adding
subscribers.

4. Press (3 [Enter] to save the information.

When adding subscribers to AUDIX, the preferred method is to first set up a
Class of Service (COS) for a group of AUDIX subscribers. Using this method the
data is filled in for you on page 2 of the Add Subscriber form. The following is an
example of page 2 of the Add Subscriber form.
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Add Subscriber Form, page 2

nonr oe Active Al arns: WA Cogins: I
add subscri ber 2600 Page 2 of 2
SUBSCRI BER CLASS OF SERVI CE PARAMETERS
Addr essing Format: extension Logi n Announcenent Set: System
System Mul tilingual is OFF Call Answer Primary Annc. Set: System
Cal | Answer Language Choice? n Call Answer Secondary Annc. Set: System
PERM SSI ONS
Type: call-answer Announcenent Control ? n Qutcal ling? n
Priority Messages? y Broadcast: none | MAPI Access? y
| MAPI Message Transfer? y Fax Creation? y Trusted Server Access? y
| NCOM NG MAI LBOX Oder: fifo Cat egory Order: nuo
Retention Tines (days), New. 10 ad: 10 Unopened: 10
QUTGO NG MAI LBOX Oder: fifo Cat egory Order: unfda
Retention Tines(days), File Cab: 10 Del i ver ed/ Nondel i verabl e: 10

Voi ce Mail Message (seconds), Maxinmum Length: 1200 M ni mum Needed: 32
Call Answer Message (seconds), Maxi mum Length: 1200 M ni num Needed: 8
End of Message Warning Tine (seconds):
Maxi mum Mai |l ing Lists: 25 Total Entries in all Lists: 250
Mai | box Size (seconds), Maxi mum 1200 M ni mum Guarantee: 0
Press [ENTER] to execute or press [CANCEL] to abort
enter command: add subscri ber 2600

Download Message Manager and DSA

Install Message Manager

See[Chapter 8,]“Message Manager Installation” for instructions on installing
Message Manager.

Download DSA

=>» NOTE:
The IP address will be different depending on the type of physical
connection established.

1. Enable your browser (Start > Programs > Netscape or Internet
Explorer).

2. Type http:// <IP address> in the address area of the web browser.
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The home page displays:

Lucent Technologles 6
Bail Labs Inncwat on. -

DEFINITY ONE™ Comymunications System

The singie solution for
your smali business needs.

Home

Administer

DerinTy ONE provides you with
a fully featured, cost effective
systemn enabling you to meet
your current business
challenges head on while
providing the infrastructure to
bridge you to future
opportunities.

3. Click Administer System.
A similar screen displays:

Username and Pazsword Required E3

Enter uzermame for august. dr. lucent. com at
auguzt. dr.lucent. com:

Uzer Mame: ||

Paszword: I

Ok I Cancel I

4. Type the user name and password.

=—>» NOTE:

The Lucent Services representative uses the logins lucent1,
lucent2, or lucent3 and the NT password from the LAC

Issue 2
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password/ASG challenge. The customer uses an appropriate

password to log in, such as NTadmin.
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The following screen displays:

Home

Administer
System

User Services

Download
Software

NOTICE:

By uze of this system, you accept the terms and condittons of the lcense
agreements for all third party software mcluded with this product. Fadure to
comply with these agreements could result in legal action by the third party

vendor(s).

Thiz product 15 designed for the use of authonized Lucent Technologies products
only. Tze of this system for any other third party applications 12 strictly probibited
annd will result in the nullification of Lucent Technologies warranty and post
warranty obligations.

Thiz system is restricted to authorized users for legitimate business purposes.

Tnauthorized access 15 a criminal wiolation of the law. Copyright (o) 1992 -
Lucent Technologies UTnpublished & Mot for Publication

[T Don't show this message again

Continue |

Lucent Technologles @
BallLabs Innowations -

y

i Sl

5. After reading the screen, click Continue.

The following screen displays:

Home

Administer

User Services

Download
Software

System Administration

o DEFINITY EC2 on Bosnia " The first two links will work only
o Tntuity AUDTE on Bosnia ' you have already matalled

o Default AUDTE Settings DEFINITY Site Adminisiration

o AUDI Metworlong OfL FOoUr Cotnputer.

System Maintenance Click on the

a Backup & Restore . Devwnload Saftwars link

a Shutdown or Restart Bosnia at the 1eft to install

Remote Control - polnywhere DEFINITY Site Administration.

o Start Host Service on Bosma
o otop Host Service on Bosnia
o start Java Client on your computer

Lucent Technologles @
BallLabs Innowations -

6. Click Download Software.
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The Software Download screen displays:

Software Download
o DEA (DEFINITY Site & dministration)

Download D34 to your computer to remotely administer Definity ECS and
Home Intuity Audix.

{158 meg, updated: Aug rd, 1008)
Administer » Message Manager
System Deownload Message Manager Software to your computer to access your

Intuity Audix messages.
User Services
Download
Software

o @
7. Click DSA.

The Save As dialog box displays.
8. Choose a destination, such as the desktop.

The Locations Saved To screen displays. When DSA, is saved, it reverts to
the Software Download screen.

9. Double click on the application name in the directory where you saved it.

The Unpacking DEFINITY Site Administration screen and a Welcome
screen display.

10. Click Next.
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11. The DEFINITY Site Administration screen, including an Installing screen
and related information, displays:

nstalling DEFINITY Site Administration

Welcome to the DEFINITY Site Adrinistiation (DSA)
instalation progrem. This program wil nstal DSA on

= your conputer.
that
before continuing. To do 5o,

indaw by clicking = | inthe upper right

imize this window by clicking the DEFINITY Site
Adniristiaion Setup buiton on the: Task B

potion of it Ul in ¢
will be prosecuted to the m:

Hest> Cancel

Press Next.
12. Click Finish when the “please wait” message disappears.

A README file displays that contains useful information about DSA. DSA
is installed on your PC and a DSA icon appears under Start > Programs
> DEFINITY Site Administration.
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Start a DSA session

DSA can be started as a normal application from Windows at the start button. To
start a DSA session:

1. Enable your browser (Start > Programs > Netscape or Internet
Explorer).

2. Type http:// <IP address> in the address area of the web browser.
The DEFINITY ONE home page displays:

Lucent Technologles 6
Bail Labs Inncwat on. -

DEFINITY ONE™ Comymunications System

The singie solution for
your smali business needs.

Home

Administer
System DerinTy ONE provides you with
a fully featured, cost effective
systemn enabling you to meet
your current business
challenges head on while
providing the infrastructure to
bridge you to future

User Services

opportunities.
3. Click Administer System.
A similar screen displays:

Enter uzermame for august. dr. lucent. com at
auguzt. dr.lucent. com:

Uzer Mame: ||

Paszword: I

Ok I Cancel I

4. Type your user name and password.

=>» NOTE:
The Lucent Services representative uses the logins lucent1,
lucent2, or lucent3 and the NT password from the LAC
password/ASG challenge. The customer uses an appropriate
password to log in, such as NTadmin.
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5. The following screen displays:

Home

Administer
System

User Services

Download
Software

NOTICE:

By uze of this system, you accept the terms and condittons of the lcense
agreements for all third party software mcluded with this product. Fadure to
comply with these agreements could result in legal action by the third party

vendor(s).

Thiz product 15 designed for the use of authonized Lucent Technologies products
only. Tze of this system for any other third party applications 12 strictly probibited
annd will result in the nullification of Lucent Technologies warranty and post
warranty obligations.

Thiz system is restricted to authorized users for legitimate business purposes.

Tnauthorized access 15 a criminal wiolation of the law. Copyright (o) 1992 -
Lucent Technologies UTnpublished & Mot for Publication

[T Don't show this message again

Continue |

Lucent Technologles @
BallLabs Innowations -

y

i Sl

6. After reading the screen, click Continue.

The following screen displays:

Home

Administer

User Services

Download
Software

System Administration

o DEFINITY EC2 on Bosnia " The first two links will work only
o Intuity AUDIX on Bosnia if you have already installed

o Default AUDTE Settings DEFINITY Site Adminisiration

o AUDI Metworlong OfL FOoUr Cotnputer.

System Maintenance Click on the

a Backup & Restore . Devwnload Saftwars link

o Shutdewn or Restart Bosnia at the left to install

Remote Control - polnywhere DEFINITY Site Administration.

o Start Host Service on Bosma
o otop Host Service on Bosnia
o start Java Client on your computer

Lucent Technologles @
BallLabs Innowations -
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7. Click DEFINITY ECS or INTUITY AUDIX on <machine name> in the right
pane.

This will launch DSA.

8. Set up daily automatic backups of AUDIX. Backups can be to the LAN,

PCMCIA card, or preferably, to a directory on your server. See
[and restore main menu”|on page C-23.

Scheduling backups

See[‘Adding a new scheduled backup (multiple backup schedules)’|on page
C-27.
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AUDIX Digital Networking

This chapter provides information to administer digital networking after the initial
system administration is complete. For further information, see INTUITY AUDIX
Administration.

This chapter is organized as follows:

“Initial administration tasks” on page 4-1

[“Viewing the Feature Options window” [on page 4-3

[“Changing the number of administered remote users”|on page 4-5

[“Administering networking channels’ lon page 4-6

[“Changing local machine information”|on page 4-7

[‘Adding a remote machine”|on page 4-12

[“Performing a full remote update”|on page 4-21

[“Resetting automatic deletion of nonadministered remote users”|on page
4-21

[“Viewing remote extensions’|on page 4-22

Initial administration tasks

To perform initial administration, complete the tasks shown in sequential order in
Table 4-1]Confirm that each of the tasks are performed, as some may have been
completed by the technician at installation.

The design center provides information for completing digital networking
administration. Ensure that you have design center specifications for TCP/IP,
network channels, the local machine, and all remote machines.
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Table 4-1. Initial administration tasks

Task

Description

Screens, windows, or
commands

Complete Windows NT and
switch administration (normally
done by the technician at the
time of installation).

Define the machine name,
TCP/IP address, and the switch
to work with AUDIX digital
networking.

Windows NT Settings
screens and Switch screens

View digital networking settings.

See|"Viewing the Featurel
on page 4-3.

Verify that the purchased digital
networking options are correctly
displayed.

List Configuration Window

Verify or change the number of
administered remote users
(normally done by the
technician at the time of
installation). See["Changing the]
[number of administered remote]

users” on page 4-5.

Define the number of
administered remote users to be
equal to or greater than the
number of all mailboxes on all
remote systems.

System Parameters Limits
Screen

Administer network channels
(normally done by the
technician at the time of

installation). SeeI“AdministerinQ]
[networking channels”| on page

4-6.

Enable the channels to create a
communication link between the
ACCX card and the switch or the
LAN card and the LAN.

Networking Channel
Administration Window

Change the local machine.

“Changing local machine]
information"|on page 4-7.

Define local machine
information for digital
networking.

Machine Profile Screen;
Local Machine Administration
Window

Add a remote machine or
change a remote machine
(normally done by the
technician at the time of
installation). See[*Adding a|
|remote machine":on page 4-12.

On the local machine, define
information about each remote
machine, including the machine
name, password, connection
type, and dial string.

Digital Network Machine
Administration Window;
Machine Profile Screen

Administer the AUDIX system
on the remote machines.

On each remote machine,
define information about the
local machine.

Remote Machine Profile
Screen of the remote
machine

Perform a full remote update.

See|"Performing a full remote|
on page 4-21.

Manually run a remote update
for each remote machine to
bring the network up to date
immediately.

get remote update
command

Continued on next page
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Task

Description

Screens, windows, or
commands

Set automatic deletion of
nonadministered remote users.

See|“Resetting automatic|

deletion of nonadministered
|remote users”jon page 4-21.

Sets the system to delete
nonadministered remote users
automatically.

System Parameters Features
Screen

View remote extensions. See

[“Viewing remote extensions’|on
page 4-22.

Check that remote users were
added to the local database.

List Remote Extensions
Screen

Record remote machine names.

Record the names of remote
systems so that local users hear
voiced confirmations when
addressing messages to users
on those remote systems.

Use the telephone to perform
this task.

Viewing the Feature Options window

View the Feature Options window to see the purchased options for digital
networking. This window is display only, and can be changed only by certified
Lucent Technologies personnel.

To display the Feature Options window:

1. Start at the]JAUDIX Command Prompt screen.
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denuer Active Alarms: A Logins: 3

|enter command:

Screen 4-1. AUDIX command prompt screen

2. Atthe enter command: prompt, enter list configuration

The List Configuration Screen displays:

hessuille Active Alarms: M Logins: 1
list configuration
LIST CONFIGURATION
Configuration Option Value

Audix Application ON
ocs ON
Fax ON
High speed digital ports N/A
Low speed digital ports N/A
Max Number of IMAPI Sessions 6
Multilingual ON
SCSI Disk Mirroring N/A
TCPIP digital ports 1
Text-to-Speech Sessions 2
Trusted Seruers 6
hours_of_speech 30
uvoice_ports 8

Press [NextPagel, [PreuPage] or [Cancel]
enter command: list configuration

Screen 4-2. List Configuration Screen

3. Contact your Lucent Technologies representative if you need more than
the enabled number of ports or if you want to add TCP/IP networking.
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Changing the number of administered
remote users

The number of administered remote users must be equal to or greater than the
number of mailboxes on all remote systems networked with this local system.

To change the number of administered remote users:

1. Start at the[AUDIX command prompt screen.|

2. Enter change system-parameters limits at the ent er conmand prompt.

The System-Parameters Limits Screen displays:

Active Alarms: MmwA Logins: 3

change system-parameters limits
SYSTEM-PARAMETERS LIMITS

MESSAGE LIMITS
Message Lengths, Maximum (seconds): 1208 Minimum (tenths of seconds): 1

Messages, Total In All Mailboxes: 50000 Awaiting Delivery: 5000
ADMINISTRATION LIMITS

Subscribers, Local: 15000 Administered Remote: 1000
Lists, Total Entries: 2000068 Lists/Subscriber: 180  Recipients/List: 258

|enter command: change system-parameters limits

Screen 4-3. System-Parameters Limits screen

3. Enter the number of remote users in the Admi ni st ered Renpt e: field.
4. Press F3[Enter] to save the information in the system database.

The cursor returns to the command line, and the system displays the
following message:

Conmand Successful | y Conpl et ed.

5. Enter exit or another administrative command at the ent er conmand:
prompt.
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Enable the network channels so the local AUDIX system can exchange voice

messages over the digital network. Enabling the channels creates a

communication link between the ACCX card and the switch or between the LAN
card and the LAN and/or the wide area network (WAN).

To enable the network channels:

1. Start at the DEFINITY ONE main page from Internet Explorer or Netscape,
and select Administer System > AUDIX Networking > Administrative

Menu > Network Channel Administration.

The system displays the Network Channel Administration Window.

l Network Channel Administration
Channel Type Channel Status Channel Configuration
© Enahle
1 TCP/P DISABLE @ Dicahle
& Enahle
2 TCP/P ENABLE £ Dicahle
Help | Save | | | Cancell | | |

Screen 4-4. Network Channel Administration Window

2. Click Enable for each channel in the Channel Configuration column.

3. Click Save.

The system takes a few seconds to change the hardware configuration.
The system displays a confirmation message when the process finishes.
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Changing local machine information

You can change local machine information on the Machine Profile Screen for the
Local Machine and on the Local Machine Administration window.

=> NOTE:
If you change the local machine profile, contact all remote network
administrators and inform them of the changes.

Changing the local machine profile

1. Start at the|[AUDIX command prompt screen.|

2. Enter change machine at the ent er conmand: prompt.

The system displays the Machine Profile Screen for the Local Machine,

Page 1.
Active Alarms: MmwA Logins: 2
change machine Page 1 of 2
MACHINE PROFILE
Machine Name: drmidi@ Type: local Location: local
Uoiced Name? n Extension Length: 5
Uoice ID: O Default Community: 1
ADDRESS RANGES
Prefix Start Ext. End Ext. Warnings
36000 37999

DLW ~NOWUNFEFWwN —

enter command: change machine

Screen 4-5. Local Machine Profile Screen, Page 1

3. Complete the fields on this screen using the information from the table
below.

=> NOTE:
The Machi ne Name, Type, Locati on, Ext ensi on Lengt h, and
Voi ce | Dfields are display only and cannot be changed except via
the web page.
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Table 4-2. Field definitions; local machine profile screen, page 1

Field Valid input Procedure/Description

Machine Name Display only Displays the Machine Name for the local
machine. This value comes from the network
settings in Windows NT.

Machine Type Display only Displays | ocal .

Location Display only Displays | ocal .

Voiced Name? y =yes The Voice Name field contains an n until you

n =no record a name for the machine. This field

automatically changes to y when you record a
name for the machine.

Extension Length

an integer, 3 through
10

Enter the length of extensions on the local
system. The value you enter must match the
extension length in your dial plan.

Voice ID

Display only

Displays a system-assigned identifier that you
must use to identify the machine if you decide to
record machine names.

Default Community

an integer, 1 through
15

If you have administered your system to use
community sending restrictions, enter the default
community number for your user population.

Prefix

0 to 21 alphanumeric
characters

Prefixes can be used on the local machine, but
they limit the functionality and are not
recommended. For a detailed discussion of the
use and implications of prefixes, see the AUDIX
Fax Administration documentation.

Continued on next page
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Table 4-2. Field definitions; local machine profile screen, page 1 — Continued

Field Valid input Procedure/Description
Start Ext. a 3-digit to 10-digit Enter the starting extensions for the ranges of
string telephone numbers used on the local system.

(Designate a block of switch extensions that can
be used at the local system when assigning
users.)

For example, if your system uses extensions
between 2000 and 3000, enter 2000 in the
Start Ext. field.

Up to 10 different ranges can be specified to
pinpoint the exact set of extension blocks used
by the local system. The length of the start and
end extension must agree withthe Ext ensi on
Lengt h field. For a 5-digit extension, the
default is 00000 to 99999.

End Ext. a 3-digit to 10-digit Enter the ending extensions for the ranges of
string telephone numbers used on the local system.

For example, if your system uses extensions
between 2000 and 3000, enter 3000 in the End
Ext . field.

Warnings Display only This field displays a warning when a duplication
or overlap of an extension range for another
machine is being assigned.

4. When you have finished entering information on this screen, press F7
[NextPage].
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The system displays Machine Profile Screen for the Local Machine, Page 2.

Active Alarms: MmwA Logins: 2
change machine Page 2 of 2
MACHINE PROFILE
Allow Automatic Full Updates? y
Updates: In? y Out? y

Network Turnaround? y

enter command: change machine

Screen 4-6. Local Machine Profile Screen, Page 2

5. Complete the fields on this screen using the information provided in the
following table.

Table 4-3. Field definitions; local machine profile screen, page 2

Field Valid input  Description
Allow Automatic  y =yes If y, the local AUDIX system automatically requests full
Full Updates n =no updates from remote systems.
If n, the local AUDIX system does not automatically
request full updates from remote systems.
Updates: y =yes If y, this local AUDIX system will accept updated user
In? n =no database information from any remote machine (the

Updat es | n field must also be settoy on the remote
Machine Profile screen setup on the local AUDIX
system for each remote machine).

If n, the local AUDIX system will not accept updates
from any remote machine regardless of the entry on
the remote Machine Profile screen. Set this field to y
only after testing the network end-to-end during initial
administration.

Continued on next page
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Table 4-3. Field definitions; local machine profile screen, page 2 — Continued

Field

Valid input

Description

Updates:
Out?

y =Yyes
n =no

If you enter y, updates to user database information
for local users are sent to a remote machine (the
Updat es Qut field must also be set to y on the
remote Machine Profile screen set up on the local
AUDIX system for each remote machine).

If you enter n, updates will not be sent to any remote
machine regardless of the entry for this field on the
remote Machine Profile screen. Set this field to yes
only after testing the network end-to-end during initial
administration.

Network
Turnaround

y =yes
n =no

To disable this feature system-wide, enter n on the
local Machine Profile screen.

To enable the feature, enter y on the local Machine
Profile screen and on the appropriate remote Machine
Profile screens on this local system.

If enabled, a network connection that originated from
this local AUDIX system is allowed to turn around after
the local AUDIX system has sent all of its network data
to any remote machine. The remote machine may then
return update information, voice mail, and status on
the same connection.

6. When you finish updating the local machine information, press F3 [Enter] tO

save the information in the system database.

The cursor returns to the command line, and the system displays the

following message:

Conmand Successful | y Conpl et ed.

7. Enter exit or another administrative command at the ent er conmand:

prompt.

Completing the Local Machine Administration
window

1. Start at the DEFINITY ONE home page from the web browser and select
Administer System > AUDIX Networking > Administrative Menu >

Local Machine Administration
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The Local Machine Administration Window displays:

' Local Machine Administration
Local Machine Name drryon BERIIECT TCRAR
Type
IP
Address 135.9.181.44

|Password ||denver1

Help | Change Cancel

Screen 4-7. Local Machine Administration

2. Change the password if necessary.

You cannot change the value in any fields except the Passwor d field. To
change other values, see[‘Changing the local machine profile”’|on page
4-7.

3. Click Save.

The system updates the information and displays a confirmation
message.

Adding a remote machine

If you want users on the local machine to be able to exchange messages with
AUDIX users on another machine, you must provide information to the local
machine about the remote machine.

=>» NOTE:
The AUDIX system accepts only one local machine. Do not attempt
to add a second local machine. Use the instructions in this section
only to add remote machines.

Completing the Digital Network Machine
Administration window (via Web browser)

To enter information for connecting to the remote machine:

1. Start at the DEFINITY ONE home page and select Administer System >
AUDIX Networking > Administrative Menu > Remote Machine
Administration > Digital Machine Administration

2. On the Digital Machine Administration screen, click Add New Machine.
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The system displays the Digital Machine Administration window.

Digital Machine Administration

Machine | Connection

Name tvpe TCPIP

| IP Address | | |

Message Transmission Schedule (hh:mm, 00:00 - 23:59)

1.8tart| [ End[ [ Interval [
2. Start| [ End[ [ Interval [
3.start| | [ End[ [ Interval [
Send .
Multimedia | [ves ~] M.I?Ch;"e [INTUITY 4.0 or Later =]
Messages ? yP
| Password | f |

Help | Add | Change | Deletel Cancel | Rename | |

Screen 4-8. Digital Machine Administration window

3. Complete the fields in this window using the information provided in
[a-1]

Table 4-4. Field definitions; Digital Network Machine Administration

Field Valid input Procedure/Description
Machine 1to 10 Enter the unique name of the remote machine.
Name alphanumeric . .
i Each remote machine must have a unique name, not
characters; see .
S only from other remote machines, but from all
guidelines at . ) . .
right machines on the network, including fax call delivery
machines and the local AUDIX.
TCP/IP Numericaddress The IP address of the remote machine.
Address string in the
format

nnn.nnn.nnn.nnn

Continued on next page
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Table 4-4. Field definitions; Digital Network Machine Administration — Continued

Field Valid input Procedure/Description

Message 24-hour clock Start Ti me — Enter the starting time for a message
Trans- timeinthe format transmission period to the remote system, such as
mission hh:mm 00:01 for 1 minute after midnight.

Schedule

End Ti me — Enter the ending time for a message
transmission period to the remote system, such as
23:59 for 1 minute before midnight.

I nt er val — Enter the interval at which the local
AUDIX system will call this remote system, such as
00:05 for every 5 minutes. The AUDIX system checks
the queue at this interval and calls the remote system
if something is in the queue for this remote system.

Stagger start times and intervals for each remote
system so the local AUDIX system is not trying to call
all remote systems at the same time.

Password 5-digitto 10-digit  Enter the password exactly as it is administered on the

alphanumeric remote system.

characters
Send yes Select yes if the remote machine will accept
Multimedia no multimedia messages (such as fax and text
Messages? messages).

Select no if the remote machine will not accept
multimedia messages.

Continued on next page
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Table 4-4. Field definitions; Digital Network Machine Administration — Continued

Field Valid input Procedure/Description
Machine See description Enter the machine type.
Type at right

To see a list of valid machine types, click the
dropdown arrow and select the appropriate machine
type from the available types.

4. When you finish entering information for a remote machine, click Save.
The system adds the information and displays a confirmation message.

5. Add another remote machine if needed.

Completing the Machine Profile screen for the
remote machine (via AUDIX)

Use the Machine Profile screen to enter networking information required for each
remote machine, such as address ranges and remote update information.

To enter networking information on the Machine Profile screen:

=—>» NOTE:

The Digital Network Machine Administration window must be completed for a remote
machine before completing the Machine Profile screen for that machine.
1. Start at the AUDIX command prompt screen.

2. Enter change machine remote_machine_name at the ent er conmand:
prompt.

The system displays the Machine Profile screen for a remote machine,
page 1.
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Active Alarms: MmwA Logins: 2

change machine drbigl0

MACHINE PROFILE

Machine Name: drbigl® Type: VEX Location: remote-digital
Voiced Name? n Extension Length: 5
Uoice ID: 1 Default Community: 1
ADDRESS RANGES
Prefix Start Ext. End Ext. Warnings
53000 56999

DWW ~NOOU EZWwWhN —

|enter command: change machine drbigl0

Screen 4-9. Remote machine profile screen, page 1

=> NOTE:
If you do not know the names of the remote machines, enter list
machines at the ent er conmand: prompt. The system displays a
list of all machines administered on the system.

3. Complete the fields in this window using the information provided in Table
4-5.

=> NOTE:

The Machi ne Name, Type, Locat i on, and Voi ce | Dfields are
display only and cannot be changed.

Table 4-5. Field definitions; remote machine profile screen, page 1

Field Valid input Description

Machine Name Display only Displays the machine name for this remote
machine entered on the Digital Network Machine
Administration window.

Type Display only Displays the machine type for this remote
machine entered on the Digital Network Machine
Administration window.

Location Display only Displays the location r enot e-di gi t al .

Continued on next page
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Table 4-5. Field definitions; remote machine profile screen, page 1 — Continued

Field Valid input Description
Voiced Name? y =vyes The Voice Name field contains an n until you
n =no record a name for the machine. This field

automatically changes to y when you record a
name for the machine.

Extension Aninteger from  Enter the length of extensions on the local system.

Length 3to 10 The value you enter must match the extension
length in your dial plan.

Voice ID Display only Displays a system-assigned identifier that you
must use to identify the machine if you decide to
record machine names.

Default An integer from  If you have administered your system to use

Community 1to 15 community sending restrictions, enter the default
community number for your user population.

Prefix Oto21 Enter the prefix digits. A user enters the prefix

alphanumeric before the remote user’s extension when
characters addressing voice messages. To simplify this task,

use a short, descriptive prefix. The total length of
the prefix plus the extension must not exceed 25
characters. The system uses the prefix only to
identify users. It is not used for dialing out, so it
does not need to match an area code or office
code. The following are examples of possible
prefixes:

No prefix — The prefix is required only when one
or more of the remote users share the same
extension numbers as the local users (the
extension ranges of the two systems overlap). If
there are no overlapping extension numbers, a
prefix is not needed.

Public network access code — When addressing
a message to a remote user, the local user enters
the remote user's number as if placing a call to
that user.

Location code — This method simplifies
addressing messages by requiring only an
alphanumeric code in front of the extension
number. Location codes are shorter and often
easier to remember.

Continued on next page
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Table 4-5. Field definitions; remote machine profile screen, page 1 — Continued

Field Valid input Description

Start Ext. A 3-digit Enter the starting extensions for the ranges of
to10-digit string  telephone numbers used on the local system.
(Designate a block of switch extensions that can
be used at the local system when assigning
users.)

For example, if your system uses extensions
between 2000 and 3000, enter 2000 in the St ar t
Ext . field.

Up to 10 different ranges can be specified to
pinpoint the exact set of extension blocks used by
the local system. The length of the start and end
extension must agree with the Ext ensi on

Lengt h field. For a 5-digit extension, the default
is 00000 to 99999.

End Ext. A 3-digit Enter the ending extensions for the ranges of
to10-digit string  telephone numbers used on the local system.

For example, if your system uses extensions
between 2000 and 3000, enter 3000 in the End
Ext . field.

Warnings Display only This field displays a warning when a duplication
or overlap of an extension range for another
machine is being assigned.

4. Press F7 [NextPage].

The system displays the Machine Profile screen for a remote machine,
page 2.
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Alarms:

MmwA Logins: 2

Updates:

MACHINE PROFILE

Send to Non-Administered Recipients? y

In? y

Network Turnaround? y

Out? y
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5. Complete the fields in this window using the information provided in

[a-6]
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Table 4-6. Field definitions; remote machine profile screen, page 2

Field Valid Input Description

Send to Non- y=yes Enter y if the system will attempt to deliver
Administered n =no messages to hon-administered remote recipients.
Recipients?

Enter n if messages cannot be sent to
nonadministered recipients.

Updates: y=yes Enter y if the local system will accept updated

In? n =no database information from the remote system (the
Updat es Qut field must also be set toy on the
local Machine Profile screen).

Set to y only after testing the network end-to-end
during initial administration.

Updates: y=yes Enter y if the local system will send updated

Out? n =no database information to the remote system (the
Updat es | n field must also be set to y on the
local Machine Profile screen).

Set to y only after testing the network end-to-end
during initial administration.

Network y=yes If you are conducting an acceptance test, enter n.

Turnaround n="no After the acceptance tests, enter y if a network

connection that originated from this remote
system is allowed to turn around after the remote
system has sent all of its network data to the local
system.

The local system may then return update
information, voice mail, and status on the same
connection. This feature reduces toll charges and
increases the efficiency of the system in networks
with more than 10 machines.

The Networ k Turnaround field must be set to
y on the local Machine Profile screen for this
feature to work between the local system and the
remote system.

6. Press F3[Enter] to save the information.

The cursor returns to the command line, and the system displays the
following message:

Conmand Successful |y Conpl et ed.
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7. Press F3[Cancel] to return to the command line.

8.

Enter exit or another administrative command at the ent er conmand:
prompt.

Performing a full remote update

If you have the system set to perform automatic daily updates, you only need to
perform the full remote update to update the system after making changes to
remote machine connections or to verify changes of data you just entered.

To update the remote user information immediately:

1.
2.

Start at the]AUDIX command prompt screen.|

Enter get remote update machine_name at the ent er comrand:
prompt, where machine_name is the name of the remote machine.

The system displays the Remote Update Request confirmation screen.
Press F3 [Enter] to continue.

The cursor returns to the command line, and the system displays the
following message:

Conmand Successful | y Conpl et ed.

Enter exit or another administrative command at the ent er comrand:
prompt.

Resetting automatic deletion of
nonadministered remote users

To conserve server space by automatically deleting nonadministered remote

users:
1.
2.

Start at the|AUDIX command prompt screen.|

Enter change system-parameters features at the ent er commrand:
prompt.

The system displays the System-Parameters Features, page 1 screen.

Press F7 [NextPage] three times to display the System-Parameters Features,
Page 4 screen.

Inthe Days without Activity: field, type the number of days. Type
0 if you do not want to automatically delete nonadministered remote
subscribers.

Inthe Even 1f on a Mailing List? field, type n to retain information
for nonadministered remote subscribers that are on a subscriber’s mailing
list.
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6. Press F3 [Enter] to save the changes.

The cursor returns to the command line, and the system displays the
following message:

Conmand Successful |y Conpl et ed.

7. Enter exit or another administrative command at the ent er command:
prompt.

Viewing remote extensions

To verify that the local machine database updated the remote subscriber
information, view the remote extensions:

1. Start at the]AUDIX command prompt screen.|

2. Enter list remote-extensions machine_name at the ent er command:
prompt, where the machine_name is the local machine of the remote
subscribers.

The system displays the List Remote Extensions screen.
3. Press F7 [NextPage] to display additional pages of the list.
4. Press F1 [Cancel] to return the cursor to the command line.

5. Enter exit or another administrative command at the ent er command:
prompt.
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Upgrade and Repair Procedures

This chapter provides the procedures to upgrade and repair the DEFINITY ONE
system.

This chapter is organized as follows:

“Update software” on page 5-1

« |‘Replace the TN795 circuit pack’|on page 5-4

« [‘Replace the hard disk”|on page 5-4
« |‘Replace the PCMCIA flash disk (hot pluggable)”|on page 5-6

[“Access Diskeeper software to defragment the disk” jon page 5-6

Update software

This procedure upgrades the system from Release 1.0 to Release 2.0. Lucent
applications cannot be running during an upgrade.

Install license file

License file installation information is available online. For further information,
contact your Lucent technical services representative.

= For external access: www.lucent-teamworks.com

= Forinternal access: http://info.dr.lucent.com/~epr/contry
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Prepare for the update

1. Prepare laptop for update (share laptop CD drive or map to laptop). See
[“Map DEFINITY ONE to the laptop computer's CD-ROM drive”|on page
C-13.

2. Connect the laptop computer using the procedure [‘Connect the laptop|
[computer to DEFINITY ONE”|on page C-2.

3. Back up all translations by following the appropriate backup procedure.
See[‘Perform immediate backup”lon page C-23.

4. Start a pcAnywhere session using|“Via pcAnywhere”|on page 2-21 and
Access the DEFINITY ONE.

The DEFINITY ONE desktop displays.

5. Click Start>Run>bash to enable a console bash shell on the DEFINITY
ONE.

6. In the console bash, enter shutdown all to stop all running system
applications.

=>» NOTE:
During the shutdown process, open a second console bash and, if
desired, use the d1stat command to check the status of the shut
down.

=>» NOTE:
Install a new license file if the processor board has been changed or
the software is upgraded to a new release. Use the procedure
[‘Obtaining a license file”|on page 3-3. Do not reboot until the
installconfig procedure is complete. This procedure is not yet valid
for international applications. For assistance, contact your Lucent
representative.
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Run the update

Update system
1. Insert the customer’'s CD into the laptop CDROM drive.

2. Map the CD-ROM from the laptop to DEFINITY ONE using the procedure
[“Map DEFINITY ONE to the laptop computer's CD-ROM drive”’lon page
C-13 in Appendix C, “Miscellaneous Procedures”.

3. Click on the shared drive.

4. Locate the setup.exe file. Double click setup.exe. The Install Wizard loads
automatically.

5. Select the options, as indicated. (The install process takes approximately
20-30 minutes).

6. When the installation completes, click Finish. The system automatically
reboots.

7. Restore the translations.
8. Reboot the system.

9. Open a console bash and enter d1stat. When DEFINITY is up, check for
dial tone.

Upgrade pcAnywhere
=>» NOTE:

This section provides information to upgrade pcAnywhere from
Version 8 to Version 9.

1. Share laptop CD drive or map to laptop. See|‘Map DEFINITY ONE to the|
laptop computer's CD-ROM drive” Jon page C-13.

2. Connect the laptop computer using the procedure [Connect the laptop|
[computer to DEFINITY ONE”]on page C-2.

3. Telnet to the LAC using|“Via a Telnet session”|on page 2-16 and open a
bash shell.

4. Atthe prompt, enter pcAnywhere -remove f:, where f is the drive letter
that refers to the CD-ROM. Wait for system reboot. This can take up to 10
minutes, not including reboot.

5. Telnet to the LAC using|“Via a Telnet session”|on page 2-16 and open a
bash shell.

6. Atthe prompt, enter pcAnywhere -install. Wait for the system to reboot.
This can take up to 10 minutes, not including reboot.

7. Telnet to the LAC using[“Via a Telnet session”|on page 2-16 and open a
bash shell.

8. Atthe prompt, enter pcAnywhere -admin. When the bash prompt returns,
the pcAnywhere update is complete.
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Replace the TN795 circuit pack

=> NOTE:
When the TN795 circuit pack is changed out, for repair or upgrade, a new
license file must be obtained and the installconfig process must be used.
DEFINITY and INTuITY AUDIX will not start if the license file does not match
the new TN795 serial number.

Shut down the system.

Remove the TN795 circuit pack.

Remove the hard disk from the failed TN795 circuit pack.

Insert the hard disk onto the new TN795 circuit pack.

AN S

Boot the system.

Follow the procedures to install a new license file, including running the setip
command. See["“Obtaining a license file”|on page 3-3 for more details.

=>» NOTE:
The system will boot but DEFINITY ONE applications will not run because
the serial number on the disk does not match the serial number on the
board. Because the hard disk is reused, the system has the old password
file that was on the system before the board failed. To log in you must obtain
the appropriate password from the TSO.

Replace the hard disk

To replace the hard disk perform the following procedures:

Remove the old disk

1. Shut down the system.
2. Remove the TN795 circuit pack.
3. Remove the failed hard disk from the TN795 circuit pack.

Add the new hard disk

1. Insert the new hard disk onto the board, ensuring it is the appropriate hard
disk for the given circuit pack and software release.

2. The disk comes pre-loaded with all the necessary DEFINITY ONE
software; however, the DEFINITY ONE applications will not run until you
install the new license file. See|[‘Obtaining a license file”’|on page 3-3.
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Verify the software on the new hard disk

1. Once the system reboots, connect the services laptop computer to
DEFINITY ONE per|[‘Connect the laptop computer to DEFINITY ONE”]on

page C-2.

2. Telnet to the LAC as per[‘Via a Telnet session” Jon page 2-16 and Access
to DEFINITY ONE.

3. Log in and run a bash session.

The browser prompts for a login and password. Because the new hard
disk does not have a password file, the system reverts to the factory
default login of lucent3.

4. Execute swversion and verify the software on the hard drive matches that
on the customer’s CD. If it does not, see [‘Update software” jon page 5-1.

5. Enter fwversion. Record the current boot code release number. Compare
the boot code number with the number on the Software Release letter. It
may be necessary to download new boot code.

Restore customer’s data

1. Enable a browser on the laptop and load the DEFINITY ONE Home Page.
For information on how to start a web browser, see|“Via a Web browser|
[session”]on page 2-18.

2. Navigate the browser to the backup and restore screens.

The browser prompts for a login and password. Because the new hard
disk does not have a password file, the system reverts to the factory
default login of lucent3.

3. Follow the steps for restoring the customer’s data. The customer may have
backed up to their local network or the PCMCIA flash disk.

If the customer backed up to the PCMCIA flash disk, then whatever was
backed up last will be restored. If the registry was backed up, the restore
will update LAN information allowing DEFINITY ONE to be seen from the
customer’s network.

If the customer backed up to the local network or failed to back up the
registry, run setip with the cust option to re-establish DEFINITY ONE on the
customer’s network.

4. After restoring, follow the procedures to install a new license file, including
running the setip command. See['Obtaining a license file”|on page 3-3.

After installing the license file, the system restarts and all applications
load. The logins and passwords have been updated by the installconfig
command.
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5. Note that the NT logins of vm, sa, browse, and NTadmin are reset to their
factory defaults. Tell the customer to reset these passwords and to reinstall
other NT accounts they may have created.

=> NOTE:

The DEFINITY-specific customer logins should work as they were
restored with the previous restore.

6. If necessary, upgrade the software on the disk by foIIowing
software”Jon page 5-1. Always upgrade the software before installing the
new license file.

=>» NOTE:

It is not necessary to install a license file between loads in the same
release, such as Release 2.0 to Release 2.0.

Replace the PCMCIA flash disk
(hot pluggable)

This procedure describes replacement of the PCMCIA flash disk.
1. Verify that disk is not in use (check LED on front panel).
2. Unplug old disk and insert new disk.

3. Run translation backup to verify health.

Access Diskeeper software to
defragment the disk

=>» NOTE:

Do not defragment during scheduled DEFINITY maintenance. Open a SAT
session and enter change system-parameters maintenance and press
ENTER. Note the scheduled maintenance times.

Diskeeper software automatically defragments the disk. The C drive is
defragmented once every Sunday at 3:00 a.m., and the D drive once every day
between 2:00 a.m. and 4:00 a.m. These times may change.

Set up a schedule for manually defragmenting the disk. A help file is accessible
through the control GUI.
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Change the default times on Diskeeper

1.

N o g s~ N

From the DEFINITY ONE desktop, click Start > Programs > Executive
Software > Diskeeper.

The Diskeeper Menu displays.

Select Set It and Forget It.

Select Partition Scheduler.

Select Set It and Forget It - Partition Scheduling window appears.

Set new times for automatic defragging. This changes the default times.
Click Start.

Click Close.
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Hardware Additions

This chapter provides the tasks required to install equipment associated with
upgrading an existing DEFINITY ONE system.

For more information about installing adjuncts and peripheral devices, see
DEFINITY Enterprise Communications Server Release 8.2 Installation for
Adjuncts and Peripherals, (555-233-116).

This chapter is organized as follows:

= [“Add circuit packs”]on page 6-2
« [‘Add CO, FX, WATS, and PCOL"|on page 6-2
= [“Add DID trunks”|on page 6-3

= [“Add tie trunks”|on page 6-4
= [‘Add DS1 tie and OPS”|on page 6-6

= [“‘Add speech synthesis”|on page 6-6

= [‘Add Code Calling access’|on page 6-6

« [“Add pooled modem”|on page 6-7

= [“Multiple integrated recorded announcements’|on page 6-9
« [“‘Add ISDN-PRI"]Jon page 6-10
« [‘Add IP trunk”]on page 6-13

= [‘Add DOLAN and C-LAN functionality’|on page 6-21
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Add circuit packs

When installing additional features or equipment, it may be necessary to install
additional circuit packs. For a list of allowable circuit packs, see[‘Allowable and

[non-allowable circuit packs”|on page 1-24. This is a general procedure to use

when adding features or equipment that require adding circuit packs.

1. Log onto the system and answer y to the Suppress Alarm Origination
question during login.

Install the circuit pack in the carrier.
Type change circuit-pack.

Verify the circuit pack appears in the listing.

a M DN

If the circuit pack code does not appear, type the code manually in the
proper slot.

6. Type test board long command to test the board.
7. Log off the system after the addition (and any required administration) is
complete.

For information about administering circuit packs and other equipment, see the
DEFINITY Enterprise Communications Server Release 8.2 Administrator’s Guide,
(555-233-506).

Add CO, FX, WATS, and PCOL

Requirements

Each Central Office (CO), Foreign Exchange (FX), Personal Central Office Line
(PCOL), or Wide Area Telecommunications Service (WATS) trunk connects to 1
port of either an 8-port TN747B or to 1 of several CO trunk circuit packs.



DEFINITY ONE™ Communications System Release 2.0 Issue 2

Installation and Upgrades 555-233-109 June 2000
Hardware Additions

Add DID trunks 6-3
Installation

1. Determine the port assignment of the trunk from Trunk Group form.

EXAMPLE: | Port Number 3 A 07 01
Cabinet Carrier Slot | Circuit
(Port Network) (or Compact
Modular
Cabinet)

2. Install a TN747B or a CO Trunk circuit pack in the assigned carrier slot (if
an additional circuit pack is required).

3. Administer the forms listed under CO, FX, WATS, or PCOL Trunk Group in
DEFINITY Enterprise Communications Server Release 8.2 Administrator’s
Guide, (555-233-506).

Add DID trunks

Requirements

Each Direct Inward Dial (DID) trunk connects to 1 port DID Trunk circuit pack or
to 1 port of an assortment of DID trunk circuit packs.

Installation

1. Determine the port assignment of the trunk from Trunk Group form.

EXAMPLE: | Port Number 1 A 07 01

Cabinet Carrier Slot | Circuit

(Port Network) (or Compact
Modular
Cabinet)

2. Install a DID Trunk circuit pack in assigned carrier slot (if an additional
circuit pack is required).

3. Administer forms listed under “DID Trunk Group” in DEFINITY Enterprise
Communications Server Release 8.2 Administrator's Guide,
(555-233-506).
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Each tie trunk connects to 1 port of a 4-port tie trunk circuit pack or to an
assortment of international tie trunk circuit packs.

Installation

1. Determine the port assignment of the trunk from Trunk Group form.

EXAMPLE: | Port Number 3 A 02 01
Cabinet Carrier Slot | Circuit
(Port Network) (or Compact
Modular
Cabinet)

2. Install tie trunk or an international tie trunk circuit pack in assigned carrier
slot (if an additional circuit pack is required).

3. For customer-owned (not leased) tie-trunk facilities (such as campus
environments), tie trunk circuit packs provide signaling capabilities
beyond those specified by the industry-wide E&M standard. Use [Figure]

and Table 6-1|to choose the preferred signaling format, set switches
on the circuit pack, and administer the port.

4. Administer forms listed under “Tie Trunk Group” in the DEFINITY

Enterprise Communications Server Release 8.2 Administrator's Guide,

(555-233-506).
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Figure 6-1. Tie Trunk circuit packs (component side)
Table 6-1. Tie trunk option-switch settings and administration
E&M/SMPLX Prot/Unprot | Administered
Installation situation Preferred signaling format switch switch port
Circumstance | To System Far-End
Collocated DEFINITY E&M Type 1 | E&M Type 1 | E&M Unprotected | Type 1
Compatible Standard Compatible
Inter-Building DEFINITY Protected Protected E&M Protected Type 1
Type 1 Type 1
Compatible Standard Compatible
Plus
Protection
Unit
Collocated Net Integrated | E&M Type 1 | Any PBX E&M Unprotected | Type 1
Standard
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Add DS1 tie and OPS

Service interruption

Because the addition of DS1 tie-trunk service may require a service interruption,
notify the customer when the addition will occur.

Add speech synthesis

The TN725B Speech Synthesizer circuit pack is required when Voice Message
Retrieval, Automatic Wakeup, or Do Not Disturb features are activated. The
TN725B circuit pack does not require administration.

1. Determine the port assignment of the Speech Synthesizer circuit pack
being added.

2. Install the TN725B Speech Synthesizer circuit pack in the designated
carrier slot.

Add Code Calling access

The tones for the Code Calling feature are generated by the TN2182/B
Tone-Clock circuit pack in the port networks.

1. Install a TN763B/C/D Auxiliary Trunk circuit pack or a TN457 Speech
Synthesizer circuit pack and connect for Loudspeaker Paging. The Code
Calling Access feature shares the same ports as Loudspeaker Paging. An
Auxiliary Trunk circuit pack provides 4 ports for Loudspeaker Paging and
Code Calling Access.

2. Administer the form listed under “Code Calling Access” in DEFINITY
Enterprise Communications Server Release 8.2 Administrator's Guide,
(555-233-506).
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Add pooled modem

Modem pooling supports two types of conversion resources: “integrated” and
“combined.”

The integrated type requires a TN758 pooled modem circuit pack for each two
conversion resources provided.

The combined type requires a port on a digital Line circuit pack and a port on
either an 8-port or 16-port analog line circuit pack for each conversion resource
provided.

1.

4.

Determine the port assignment of the circuit packs to be added (if
required).

Install the appropriate circuit packs in assigned carrier slot (if required).
For Paradyne 3800-Series modems:
a. Type AT&F&D2&S4\D3S2=128x7V2S7=60S85=1 and press Enter.
b. Type ATY0S10=100S78=2MOEO\N1&W and press Enter.

For other types of modems, see the vendor’s documentation.

Settings for modem connected to data module

e e N s < =
o oM W N P O

© © N o gk w DR

Type add data-module next and press Enter.

Type pdm in the Type field.

Type x in the Por t field.

Type dte in the Connect ed t o field and press Enter.
Type add station next and press Enter.

Type 2500 in the Type field.

Type x in the Por t field.

Type n in the Test s field and press Enter.

Type add modem-pool next and press Enter.

Type combined in the G- oup Type field.

. Type5inthe Hol d Ti me (m n) field.

. Type two-way in the Di r ect i on field.

. Type 9600 in the Speed field.

. Type Full in the Dupl ex field.

. Type async in the Synchr oni zat i on field.

. Type the port pair assignments in the Anal og and Di gi t al fields and

Press Enter.
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1. Type add station next and press Enter.
2. Type 2500 in the Type field.

3. Type the port assignment in the Por t field and press Enter.

Table 6-2. 7400A options — attention control modems

Set option display Option Setting
Set 300 Speed? 300 Note 1
Set 1200 Speed? 1200 Note 1
Set 2400 Speed? 2400 Note 1
Set 4800 Speed? 4800 Note 1
Set 9600 Speed? 9600 Note 1
Set 19200 Speed? 19200 Note 1
Set AT Control? AT ON
Set Cl Lead? Cl Note 2
Set CI2 Lead? CI2 Note 2
Set CH Lead CH Note 2
Set CH2 Lead? CH2 Note 2
Set LL Lead? LL Note 2
Set REMOTE Loop? REMLOOP Grant
Set RL Lead? RL Note 2
Set SIGLS Disc? SIGLS DISC | ON
Set TM Lead? ™ Note 2

=> NOTE:

1. Set speed to match remote modem. At least one speed must be

set ON.

=> NOTE:

2. Set to match remote modem.
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Multiple integrated recorded
announcements

There are 2 methods of providing integrated announcements on DEFINITY ONE.
Both methods for announcements can be used in the same system. The methods
are:

= TN750C Announcement Circuit Pack

TN750C announcement circuit pack

The TN750C circuit pack contains on-board flash memory that provides internal
backup of announcements. Thus, the TN750C circuit pack does not require the

save and restore processes. Announcements cannot be backed up and restored
to an external device with a DEFINITY ONE system.

The TN750C circuit pack can replace a TN750 or TN750B. The difference in
operation is that the TN750C automatically restores and reports the availability of
announcements from its internal flash memory in 5 minutes, rather than the 40
minutes for the TN750 or TN750B.

If a circuit pack already has announcements in its flash memory, the yellow LED
flashes as the announcements copy to the voice RAM.

Add TN750C circuit packs
Follow this procedure to add the circuit packs:
1. Insert the TN750C into a vacant slot in a carrier.

2. Administer new announcements to that TN750C slot by executing the
change announcements <location> command.

3. Record the announcements, as described in DEFINITY Enterprise
Communications Server Release 8.2 Administrator's Guide,
(555-233-506).

4. Wait until the announcements copy from voice RAM to the on-board flash
memory (the yellow LED on the TN750C starts and then stops flashing).
This takes about 10 minutes.
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Move a single announcement to another
announcement circuit pack

Follow this procedure to move a single announcement to another announcement
circuit pack.

1. Enter the change announcements command to change the circuit pack
locations of a particular announcement. (You may also change the
compression rate at this time.)

2. Re-record the announcement, as described in DEFINITY Enterprise
Communications Server Release 8.2 Administrator's Guide,
(555-233-506).

Add ISDN-PRI

T1 (North American Standard)

This procedure describes adding a T1 line.

1. Use a TN767F or TN767E (or later version) circuit pack to set up an ISDN
PRI trunk. Ensure that the dip switch on the board is set for 24 channels. If
you are using Facility Associated Signaling (FAS), 23 channels are
available to be used as trunk group members. Channel 24 must be used
to create a signaling group for the trunk groups. If you are using Non
Facility Associated Signaling (NFAS), it is possible, in some instances, to
use all 24 channels for trunk group members.

2. To create a PRI trunk:
a. Enter ADD DS1 (board location) at the SAT terminal session.
b. Enter the required information on the DS1 form.

c. Create a signaling group using the ADD SIG NEXT command. If
you are using FAS signaling, use the 24th channel on your DS1
board as the D-channel for your signaling group. If you are using
NFAS signaling, enter N in the associated signaling field. List the
trunk board location in the Trunk Board field.

d. Create a trunk group by using the ADD TRUNK NEXT command:

1. Complete the required information on the Trunk Group Form
pages.

2. Enter the port locations of the trunk members on the Trunk
Group Member page.

3. Enter the correct signaling group number.
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E1 (International Standard)

1. Use a TN464F circuit pack. Ensure the dip switch on the board is set for
30 channels (E-1). If you are using Facility Associated Signaling (FAS), 29
channels are available to be used as trunk group members. Channel 16
must be used to create a signaling group for the trunk groups. If you are
using Non Facility Associated Signaling (NFAS), it is possible to use all 30
channels for trunk group members in some instances.

2. To create a trunk group, do the following:

a. Determine the slot assignment of the circuit packs to be added.
Install the DS1 interface circuit pack in the assigned carrier slot.
Enter ADD DS1 (board location) at the SAT terminal session.

Enter the required information on the DS1 form.

® 2 o o

Create a signaling group using the ADD SIG NEXT command. If
you are using FAS signaling, use the 16th channel on your DS1
board as the D-channel for your signaling group. If you are using
NFAS signaling, enter N in the associated signaling field. List the
trunk board location in the Trunk Board field.

f. Create a trunk group by using the ADD TRUNK NEXT command:

1. Complete the required information on the Trunk Group Form
pages.

2. Enter the port locations of the trunk members on the Trunk
Group Member page.

3. Enter the correct signaling group number.

Add circuit packs

1. Determine the slot assignment of the circuit packs to be added.

2. Install the DS1 Interface circuit pack in the assigned carrier slot.

Install cables

Install cables from the cabinet to the MDF as required.

Enter added translations

1. Administer the forms listed under “Integrated Services Digital Network —
Primary Rate Interface” in DEFINITY Enterprise Communications Server
Release 8.2 Administrator's Guide, (555-233-506).
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Resolve alarms

1. Examine the alarm log. Resolve any alarms that may exist using DEFINITY
ONE Communications System Release 2.0 Maintenance, (555-233-111).

Save translations

1. Enter save translation and press Enter. This instructs the system to take all
translation information in memory and write it to the translation cards.

2. Update backup cards, if necessary.
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Add IP trunk

The DEFINITY IP Trunk lets you integrate LAN applications into the DEFINITY
communications network. It is implemented using the TN802B MAPD, which is a
Windows NT server residing on a circuit pack inside DEFINITY ONE. Installing
the DEFINITY IP Trunk involves the following steps:

1. Prepare for installation

2. |Check your shipment
3. |Connect the modem (optional)
4. [Connect the IP trunk server to your local area network|

Prepare for installation

Make ready the following before your shipment arrives.

Three adjoining, unoccupied slots in the DEFINITY ONE.

The IP-trunk circuit pack occupies only one slot, but needs the two slots to
its left for clearance.

A 10/100 BaseT Ethernet connection into your local area network

A valid, unused IP address on your network that can be assigned to the IP
Trunk server

A technician’s laptop computer

A mouse, keyboard, and VGA monitor with Windows NT loaded for use
during the installation of the server

An analog telephone line reserved for the IP-trunk diagnostic modem

A valid international telephone number reserved for the IP-trunk diagnostic
modem

Symantec pcAnywhere software

This third-party application lets Lucent support personnel control the
MAPD processor remotely, via the modem, during maintenance and
troubleshooting.

AC power outlets for the modem and monitor
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Check your shipment

When your DEFINITY IP Trunk order arrives, check the contents.

1. Before opening the shipping carton, inspect it for damage. If the box is
damaged, do not open it. Inform the shipping company, and ask for
instructions on filing a claim.

. If the box is undamaged, check the contents against the packing slip.

Check the condition of each component, and note any damage or missing
contents on the packing slip. The carton should contain the following for
each IP Trunk ordered: See Table 6-3.

TN802B MAPD circuit pack
US Robotics Sportster external modem

The modem permits Lucent support personnel to remotely maintain
and troubleshoot your system.

TN802B external cable assembly

The TN802B external cable assembly is a bundle of cables with an
amphenol connector at the end of the bundle and various PC-type
connectors (VGA, USB, mouse, keyboard, Ethernet, modem, and
COM2) at the ends of the individual cables. See It
should be labeled at the point where the bundle enters the
amphenol connector.

Table 6-3. Required hardware

Comcode/Code

quantity Description

108525528 TN799B C-LAN circuit pack.

1 One TN799B supports more than one TN802B

J58890MA-1 L30
more

TN802B IP Interface Assembly

601939804 1 or
more

H600-512, G1 external cable assembly

1 259A connector

1 CATS or better cable

407633999 U.S. Robotics Sportster external modem, Model USR 33.6 EXT (U.S.

1 customers only). Non-U.S. customers must provide a modem comparable
to this model.

601087091 20-ft BD-25 serial cable from modem to TN802B external cable assembly

1

(U.S. customers only). Non U.S. customers must provide a serial cable.
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chdfocto AWF 122398

Figure Notes

1. To P1 on cabinet backplane 5. To mouse

2. To VGA monitor 6. To Ethernet

3. To USB (not used) 7. To modem (optional)
4. To keyboard 8. To COM2 (not used)

Figure 6-2. TNB802B external cable assembly

Install the TN802B MAPD

The TN802B circuit pack is hot-swappable, so it is not necessary to power down
the carrier.

1. Ensure there is room to install the TN802B circuit pack. To accommodate
the width of the circuit pack, you must have at least 3 adjacent free slots.
(If you put the TN802B circuit pack in slot 7, you must have 2 adjacent
slots.)

2. Insert the TN802B circuit pack in the most right slot (the one reserved for
IP trunking).

3. Connect the P1 amphenol connector on the TN802B external cable
connector to the leftmost backplane connector looking from the rear (of
the 3 slots required for the TN802B).
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Connect the modem (optional)

The modem lets Lucent technicians remotely service and troubleshoot your
system.

1. Connect the RS232 port of the modem to the MODEM cable of the
TN802B external cable assembly.

2. Connect an analog phone line to the most left analog-line port on the
modem.

3. Ensure that the modem’s DIP switches are set as indicated in
Figure 6-3.

4. Plug the modem into an AC power outlet.

L ©

A [

modfrobo KLC 121198

Figure Notes
1. Connect analog line here. 3. Connect MODEM connector here.

2. DIP switch 5 must be up.

Figure 6-3. External modem connections

Connect the IP trunk server to your
local area network

Connect the ethernet cable

1. Connect the network cable to the ethernet connector on the TN802B
external cable assembly.
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Connect a monitor

You need a VGA monitor to log onto the Windows NT Server and to configure the
network software.

1. Attach a VGA monitor to the VGA cable of the TN802B external cable
assembly.

2. Attach the keyboard to the KEYBOARD cable of the TN802B external
cable assembly.

3. Attach the mouse to the MOUSE cable of the TN802B external cable
assembly.

4. Plug the monitor into an AC power receptacle, and turn it on.

Log onto the IP trunk server

Log onto the IP trunk server as follows.
1. Press the CTRL, ALT, and DELETE keys simultaneously.
2. Type administrator in the User Nane field.
3. Leave the Passwor d field blank, and click OK.
4.

After logging on the first time, change the administrator password and, if
desired, the user name, to ensure security. See your Windows NT Server
documentation for details.

Assign a server name and domain name

Windows NT Server identifies servers using a server name plus a domain name
that locate the named server in a particular part of the network. The TN802B is
shipped with a generic server name and a generic domain name. You should
assign replacement names that are meaningful within your network.

1. Click My Computer from the Windows NT desktop.

Click Control Panel in the My Computer window.

Click Network in the Control Panel window.

Click Identification, then Change.

Type the new name in the Conput er Nane box.

Type the name you chose for the IP-trunk domain in the Domain box.
Click OK > OK.

Click Close.

© © N o g~ DN

When prompted, choose one of the following options:
» If you have not administered IP addresses, click No.

» If you have administered IP addresses, restart Windows NT so that
the new names take effect.
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Check network services

When the server restarts, ensure that the required network services have started
correctly.

1. Click My Computer from the Windows NT desktop.
Click Control Panel in the My Computer window.
Click Network in the Control Panel window.

Click Services in the Network window.

SRR S

Ensure that the following services are listed:
« Computer Browser
» Microsoft Internet Information Server 2.0 needed
» NetBIOS Interface
» RPC Configuration
« Server
» Workstation

6. Click Protocols, and examine the Network Protocols. TCP/IP should be
the only protocol listed.

7. Click OK.

Assign an IP address

Click My Computer from the Windows NT desktop.
Click Control Panel in the My Computer window.
Click Network in the Control Panel window.

Click Protocols in the Network window.

Click TCP/IP Protocol from the list.

R e o

Click Properties in the Network window.
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Microsoft TCP/IP Properties EHE
IPAddress |DNS | WINS Address | Pouting|
An IP address can be automatically assigned to this netwark card by a
DHCPF server. Ifyour network does not hawe a DHCF server. ask your
network administratar for an address, and then type itinthe space
el
1] Intel 82 ed 10/100 Ethernet PCl Adapter
" DOhbtain an IP address from a DHCF server
% Specify an IP address
IP Address: [ o 0. 0.0 %
Subnethask: [ 255 255 . 255 . O
Default Gatewey: | o, o. 0.0
Advanced... |
OFK. I Cancel | Al |
7. Click Specify an IP address.
8. Type a valid IP address for the IP Trunk server in the | P Addr ess: field.
9. Type the appropriate subnet mask in the Subnet Mask: field.

10. If you use gateways, type the IP address of the default gateway for the IP
Trunk server in the Def aul t Gat eway: field.

11. Click OK.

12. If Windows NT responds with the “At | east one of the adapter
cards has an enpty primary WNS address. Do you want to
cont i nue?” message, click Yes.

13. Click Bindings to make the changes.

NetBIOS Interface, Server, and Workstation should now be enabled. If any
are disabled (marked a red circle with a line through it), review the
network-configuration steps above for omissions or errors.

14. Click Close.

15. Restart your computer.
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Test the connection to the LAN

To test IP connections ping the IP trunk server and ping a known computer
connected to your network.

1. In the Windows task bar, click Start > Programs > Command Prompt.

2. Atthe command prompt, type ping nnn.nnn.nnn.nnn (where
nnn.nnn.nnn.nnn is the IP address of the IP trunk server).

» If everything is configured correctly, the system replies with the
following:

Reply from nnn.nnn.nnn.nnn: bytes=32 time<##ms TTL=###

« If no reply, verify the IP-address information and check the
connectivity including the cabling.

3. At the command prompt, type ping nnn.nnn.nnn.nnn (where
nnn.nnn.nnn.nnn refers to the IP address of another computer on the
network).

» If there is connectivity, the system replies with the following:
Reply from nnn.nnn.nnn.nnn: bytes=32 time<##ms TTL=###

« If no reply, verify the IP-address information and check the
connectivity including the cabling. Consult your IP-network
administrator.

4. Type exit and press Enter.

Test the modem
1. Check for dial tone.

Set up network-trust relationships

After all DEFINITY IP Trunk servers are in their own domain, establish trust
relationships between domains to allow for remote administration. To establish
trust relationships, see your Windows NT Server 4.0 documentation.

Administer the IP trunk

The TN802 circuit pack is now installed in the DEFINITY carrier and connected to
the IP network. You can now use the Configuration Manager software
(pre-installed on the TN802 hard disk) and DEFINITY ECS switch administration
software to prepare the IP Trunk for use. See the DEFINITY ECS Release 8.2
Administrator's Guide, (555-233-506) for more information.
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Add DOLAN and C-LAN functionality

DEFINITY ONE Release 2.0 uses DEFINITY Release 8.2, which allows the use of
IP Softphones. In addition, co-resident C-LAN functionality can be optionally
purchased. The DEFINITY ONE Windows NT LAN interface may be used in place
of the C-LAN circuit pack for those cases where DSO capability through the
C-LAN is not required. DCS using DSO will still be supported via a separate
C-LAN. The Windows NT LAN interface (co-resident C-LAN) will also be used to
connect CMS, BCMS, and Centre Vu CT. See the DEFINITY ONE Release 2.0
Overview, (555-233-001).

DEFINITY IP Solutions software

The DEFINITY IP Solutions software operates both as an IP gateway and
gatekeeper. As a gateway it converts voice traffic to data transmission over IP
networks. As a gatekeeper, it provides IP endpoints with secure access to the
DEFINITY system. This connection lets users take advantage of all applications
residing on the system, including voice mail, computer-telephone integration, call
center, wireless, and call control features, such as conferencing, call forward,
transfer, hold, speed-dial, and multiple-line appearances.

The software supports Distributed Communications System DCS and
Q-Signaling (QSIG) protocols over IP networks to operations across multiple
sites. The DEFINITY IP Solutions Software can be managed through the server’s
existing system administration tools, and can take advantage of the DEFINITY
system’s call routing and cost accounting, self diagnostics, security toll fraud
protection, and remote access applications. It enables IP telephones to
communicate with analog, digital, and ISDN phones on the DEFINITY network,
and supports the H.323 protocols and standard application programming
interfaces, including TAPI, TSAPI and JTAPI.

DEFINITY ONE Release 2.0 adds optional enhancements that are well suited to
small call centers. Several new co-resident applications free up slots in the
cabinet, including C-LAN functionality, Announcement functionality (now part of
Release 2.0) and DEFINITY LAN Gateway. In most cases, with these applications
co-resident, separate C-LAN and announcement boards are not required and
MAP-D is not required for DEFINITY LAN Gateway. Also BCMS Vu and CentreVu
CT reside on a separate server, which is LAN connected and enables DEFINITY
ONE to interface with these applications.



DEFINITY ONE™ Communications System Release 2.0 Issue 2
Installation and Upgrades 555-233-109 June 2000

Hardware Additions
Add DOLAN and C-LAN functionality 6-22



DEFINITY ONE™ Communications System Release 2.0 Issue 2
Installation and Upgrades 555-233-109 June 2000

DEFINITY Site Administration (DSA)
7-1

DEFINITY Site Administration
(DSA)

This chapter provides information about DSA, the system management tool
integrated into the platform. See|‘Download Message Manager and DSA”|on

page 3-25.

This chapter is organized as follows:

= [“Interactions with switches and voicemail systems”|on page 7-2
= [“What DSA does”|on page 7-3

= [“Components of DSA’|on page 7-4

= [‘How DSA works”|on page 7-6
« [‘DSA help”]on page 7-7

= [“Configure DSA”[on page 7-7

— [*“Adding DEFINITY ONE Switch Administration Item”|on page 7-8

— [“Adding DEFINITY ONE Voice Mail Administration item”|on page
7-16

As previously stated, DEFINITY ONE applications are pre-loaded on the
hardware platform. The actual set up of customer translations are administered
through a common system management tool, DSA, which is integrated into the
platform.

DSA is an all-purpose telecommunications management tool aimed at small- to
mid-sized companies, such as small businesses, motels, and branch offices of
large companies.
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Interactions with switches and
voicemail systems

DSA is a Windows 95/98 and NT application that is not client-server based. It
communicates directly with switches and AUDIX systems as follows:

» Through a direct hardware connection within a DEFINITY ONE computer

= OveraLAN

» With a modem or data module
DEFINITY ONE, as shipped, allows installation personnel to connect to switches
and voicemail systems through the direct hardware connection in the DEFINITY
ONE computer. To optimize the efficiency of DEFINITY ONE and DSA, and
because administrators may not want to work directly on the DEFINITY ONE

computer, install DSA software on a separate computer and connect to the
switch in any of the other three ways listed above.

If installation personnel choose to install DSA on a separate computer, that
computer must fulfill the following requirements:
Windows 95/98 configuration:

= Processor: 486/Pentium

« RAM: 16MB/32 MB

» Available Disk Space: 100 MB minimum

« CD-ROM

» Printer port: Standard PC printer port or LAN connection

» Available Serial Ports: One free serial port or LAN connection is required
for a connection to the switch

= TCP/IP LAN: Optional, depending on configuration

» Display: SVGA with minimum screen resolution of 800 x 600

Windows NT configuration:
= Processor: Pentium
« RAM: 64 MB
» Available Disk Space: 100 MB minimum
« CD-ROM
» Printer port: Standard PC printer port or LAN connection

= Available Serial Ports: A modem connection or a LAN connection is
required for a connection to the switch
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= TCP/IP LAN: Optional, depending on configuration

» Display: SVGA with minimum screen resolution of 800 x 600

What DSA does

DSA performs most types of switch administration activities (except for the
“monitor” commands). Switch administration activities include:

» Adding phones to the system, including identifying which extensions or
ports are available

» Scheduling activities to run at a later date and time
» Scheduling activities to run repeatedly

» Assigning telephone feature buttons

» Creating or modifying coverage paths

» Adding or modifying hunt groups

» Administering pickup groups

» Administering bridged appearances

» Resolving and monitoring alarms

» Changing a user’s personal information, such as the name, set type,
location, etc.

= Moving or removing agents or stations

» Determining how well/whether a station is operating

» Testing stations or trunks

» Setting up vectors

» Performing AUDIX administration activities, including setting up a
voicemail account for a new phone

Setting up a voicemail account is part of the DSA User Administration wizard. For
all other AUDIX tasks, administrators must use DSA’s terminal emulation feature
to open an AUDIX terminal emulation window.

Besides switch administration functions, DSA has its own administration
activities. These activities help set up DSA to communicate with switches and
AUDIXes, organize telecommunications data, and specify DSA will work. These
DSA administration activities include:

» Setting up direct, modem/data module, and LAN connections between
DSA and switches or AUDIX systems

» Entering DSA-specific data, such as time-out intervals, number of times to
retry tasks, and other system options
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= Using the history, schedule, and connection viewers to track the status of
administration tasks

=« Organizing systems and task shortcuts in the browser tree

Components of DSA

DSA provides a central window that allows access to switches and AUDIX
systems. The pictures below show the main DSA screen.
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Figure 7-1. DSA window with tasks pane and status viewer or history pane
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Figure 7-2. DSA window with tree pane and status viewer or schedule pane

As a default setting, the left-pane shows the task wizards that DSA offers for
performing frequent tasks. Users can use task wizards to create common tasks
and schedule those tasks to run on the system and/or save the tasks to the DSA
browser tree. Users can create the following tasks with the task pane:

= Start GED — Any administration activity that can be accomplished with
the Graphically Enhanced DEFINITY interface (GEDI), and includes
almost all DEFINITY ONE administration

= User Administration — Adding phones, removing phones, and changing a
phone user's name in DEFINITY ONE and AUDIX

= Find and Replace — Changing, finding, or removing something across an
entire switch

= Import Data —- Copy and paste data from a spreadsheet to a grid in DSA
= Export Data — Save switch data to an external file

= Use Template — Add obijects, such as a phone, to a switch, using an
existing template

= Create New Template — Create a template to use when adding objects to
the switch
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Add Bridged Appearance — Create a bridged call appearance on a
phone

Generate Call Accounting — Select call accounting data and save it as an
external file

Browse Dial Ranges — View the dialing ranges specified by a switch’s dial
plan

Find Unused Extension — Search a switch for the next available extension
after a specified extension

Browse Unused Ports — View a list of unused ports on a switch.
Browse Stations — View a selected or complete list of stations on a switch

Monitor Trunks — Tell DSA to periodically check for out-of-service trunks
and notify the user

Start Emulation — Access a switch or AUDIX via terminal emulation
Add Switch — Set up a connection from DSA to a DEFINITY switch

Add Voice Mail System — Set up a connection from DSA to an AUDIX
system

Print Button Labels

Clicking the Tree tab on the left-pane displays the DSA browser tree. This tree is
a Windows Explorer-like view of all of the switches and AUDIX systems
connected to DSA, the tasks a user has created, and the button label templates.
Users can:

Expand nodes in the tree
Move items

Cut, copy, or delete items
Add or paste items to the tree
Rename items

Change an item’s properties

Connect to a switch

How DSA works

In DSA, any switch or AUDIX administration activity is called a task. When using
DSA to perform a switch or AUDIX administration task, enter the task into DSA
and then tell DSA when to run the task. For example, to add a phone to the
system for a new employee, create a task in DSA that adds the phone (and,
optionally, the associated voicemail account), and then tell DSA to add the new
phone immediately or at a later time.
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When the task runs, DSA connects to the appropriate switch or AUDIX, runs the
task, and displays feedback about the task in the schedule tab. Depending on
the instructions from the user, DSA will either disconnect from the switch or make
the connection idle when it is finished running the task.

DSA help

DSA provides the following information to help administrators:

» Guided tour — The guided tour orients users to the DSA interface,
explains what the different areas of the DSA screens are for, and orients
users to what DSA is and how to get started. Users can launch the Guided
Tour by choosing Guided Tour from the Help menu.

» Online Help with Demonstrations — The online help system tells how to
administer DSA, how to perform basic switch administration and
troubleshooting, and how to connect to an AUDIX. Many topics include a
Show Me button. When a user clicks Show Me, a short animated
demonstration of the task plays. To open the help system, choose
Contents from the Help menu.

= Show Me demonstrations — Users can launch a list of Show Me
demonstrations by choosing Show Me from the Help menu.

» Connection support — Clicking Help on a connection error message will
launch a series of troubleshooting screens to walk users through solving
common connection problems.

Configure DSA

When DSA is initially installed on a client machine, it needs to be configured to
communicate with both the switch application (DEFINITY) as well as the voice
mail applications (AUDIX) on the DEFINITY ONE platform.

When it runs initially, after downloading, DSA asks if it should create a new entry
for the Switch. To create a new entry for the switch, do the following:

1. Answer yes to creating a new switch.

2. Complete the Switch Properties information and apply it.

3. Answer yes to the request for creating a new entry for a voice mail
application.

4. Complete the Voice Mail System Properties information and apply it.
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Both Switch access and voice mail access are now configured through DSA to
DEFINITY ONE.

=>» NOTE:

To create a new entry for a different system, perform the following
procedure.

Adding DEFINITY ONE Switch
Administration Item

1. Click file > new > Switch. A screen similar to the one below displays.

Switch Properties

[ Login manually to system

Lagin name; |

% Password: I
Pazsward [again): I

" Access Securly Gateway [A55)

Secret ke I

~ Connections

Type | Dial/Hozt | Port | Device

Add.. | F‘ropgrties...l Hemmue |

0k I Cancel | Help |

2. Enter a name in the System name field. As a technician configuring DSA
on your laptop, use a generic name, as you will be able to use this
connection item for all DEFINITY ONE machines connected over the
PCMCIA physical connection.
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3. Enter a login name and Password.

For Lucent Personnel enter one of the dxxxx logins (dinit, dinads, dcraft)
depending on the level of access desired along with the appropriate
password. The password will be unique for each DEFINITY ONE system.

For non-Lucent personnel, enter your valid DEFINITY login with its
appropriate password. See|‘Enable customer logins”|on page 3-5.

Log in to DEFINITY with ASG enabled
If the system is ASG-enabled:

1. Clickthel ogi n manual ly to systemcheck box. An emulator screen
displays, prompting for login.

Log in as dxxxx. You will be issued a challenge; respond correctly.
Manual Login ;
Enker your login and pazsword or challenge responze at the prompts. When pou have

entered the login and passward [or rezponze). press "Continue'’.

MOTE: Press "Continue'" at the "'Temminal Type'' prompt.
If you have already selected a terminal type, press "Cancel” and try again.

Login: dcraft
Challenge: 764-28585 Product ID:7000000000

Fesponse: |

Cantinue [F7] i Cancel Help
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If you respond successfully, you will start to see data scroll by. The system will
ask for terminal type; do NOT enter a terminal type. Simply click on the Continue
button at the bottom of the screen as in the screen below.

Manual Login x|

Enter pour login ahd pazswaord or challenge response at the prompts. When pou have
entered the login and pazzword [or rezponze], presz "Continue'’.

MOTE: Press "Continue' at the "'Terminal Type'" prompt.
If you have already zelected a terminal tppe, press "Cancel' and try again.

Login: deoraft

Challenge: 764-2885 Product ID:7000000000
Fesponse: 0941427

c[l:24r[1;1H[0J

Login:

Pazzword:

Systen: GictsVo Software Version: G3W7c.0l.0.439.0[E
Terminal Type (513, 715, 4410, 4425, VIZ220, NTT, SUNT): [513]

Continue [F7) i Cancel Help
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Once you have populated the fields on the Switch Properties page, the
screen should look similar to the one below.

Switch Properties

= System

g’:a | Systemame: |DEFINITY ONE - Swich

[™ Login manually to system

Login name: Idinads

{+" Passwird: I,mm—
Password (again) I‘-‘-“‘-‘“‘

" Agcess Secunty Gateway [ASG]

Secret key: I

i~ Connection

Type | Dial/Host | Port | Device

Add... | Propgrties...l Hemoye |

0K | Cancel | Help |
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2. Click on the Add button at the bottom of the screen.This is used to add a
physical connection mechanism from the client machine to the DEFINITY
ONE. Clicking on the Add button will pop up a screen similar to the one
below.

Connection Properties

General | Advanced |

~Details

=

Metwark connectior

Host: I

Bart: I

E/:? ' Direct serial port connection

Fort: fCam "l

¥ ' Modem or data module connection

Device: I :J

Pat fcomi =

Phone Mumber: I

Edipao| [Edtoe|

Ok I Cancel | Apply | Help |

=> NOTE:
Regardless of the physical connection used, that is, local
monitor/keyboard/mouse, PCMCIA, RAS modem or customer LAN, THE
CONNECTION TYPE IS ALWAYS A LAN CONNECTION.

=—>» NOTE:

By default the Modem or data module connection radio button is
highlighted. Be sure to click on the LAN connection radio button.

3. Host: For the host address, enter the IP address that is commensurate
with the physical connection mechanism used to connect to the DEFINITY
ONE. See|“Installation Connectivity Quick Reference”|on page H-1.

4. Port: For the port number, ALWAYS use port 23.
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5. Click on the Apply followed by OK. This dismisses the Connection

Properties page and put you back at the Switch Properties page, similar to
the one below.

Switch Properties

~ System
System name: iDEFINITY OME - Switch
= Login
I Login manually to system
Login name: Idinads
+ Password; I’““"“‘“
Pazsword [again]: I ”””””””
" Apcess Security Gateway (455)
Secret kew ;
r— Connections
Tupe | Dial/Host | Part | Device |
W Network 19211136 23
Eroperties.., | Hemowe |
0K | Cancel | Help |

=>» NOTE:

For a Switch (DEFINITY) connection, add two identical connection entries
by repeating steps andThis allows you to use the wizards.
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After having created the second LAN connection item, your Switch
Properties screen should look similar to the one below.

Switch Properties

— System

{gr | Systemname:  [DEFINITY DNE - Suitch

™ Login manually to system

Login name: Idinads

% Password:

Ixxxxxxx

Pazzword [again):

ixxxxxxx

 Access Secuity Gateway [A55]

Secret ke I
— Connections
Type | Dial/Host | Fort | Device
W Metwork 19211136 23
T Metwork 19211136 23
F'ru:upgrties...l Femove I
Ok, | Caricel | Help |

6. Click on the OK button to complete the addition of the Switch item.
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By clicking on the Tree tab on the DSA window, you can see the newly
added DEFINITY ONE Switch Administration item. The screen will look
similar to the one below.

2 DEFINITY Site Administration
File Edit iew Took ‘window Help

| 5E=lax] (4|2 @] Joernmy one -swich ]
sl |

lﬁ workspace

#1-[2) DEFINITY OME - Switch

¥ Tasks U Tree I

x| Severity I Date/Time I Syztem I Description
A B info 09/01/1999 2.02:21...  estonia change system-parameters cdr E
ﬂ Info 0340141993 2.02:07...  estonia change system-parameters cdr _'
o Info 09/0141999 201:52...  estonia change system-parameters cdr
it 09/01/1999 201:%7...  estoria chsys cdr 3
4 | ]
[ ] [ BI History A Schedule #, Connection Status i
M

Ready
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Adding DEFINITY ONE Voice Mail
Administration item

For a new Voice Mail Administration item, click on file > new > Voice Mail
System. A screen similar to the one below will appear.

Yoice Mail Spstem Properties
r S}'Stclll
[
2 System name: !
,
i Logh 1

[™ Login manually to spstem

Login name: I

¥ Password: I
Pazzword [again]: I

' Acoess Secuity Gateway [A56G)

Secret key: ;

- Connection

Type | Dial/Host | Port | Device

Add.. | Propgrties...l Hemove |

0F | Cancel | Help |

1. Enter a name in the System name field. For technicians that are
configuring DSA on their laptops, use a generic name, as you will be able
to use this connection item for all DEFINITY ONE machines connected
over the PCMCIA physical connection.

2. Enter a login name and Password.

For Lucent Personnel enter one of the axxxx logins (atsc or acraft)
depending on the level of access desired along with the appropriate
password.

For non-Lucent personnel enter one of the valid AUDIX Customer logins
(sa, vm, or browse) along with the appropriate password.
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Log in to AUDIX with ASG enabled

If the system is ASG-enabled, then you must click the | ogi n manual ly to
syst emcheck box. When you try to initiate a connection, an emulator screen will
pop up, prompting for login.

Log in as axxxx. You will be issued a challenge to which you must respond
correctly.

The system will ask for terminal type; do NOT enter a terminal type. Simply click
on the Continue button at the bottom of the screen.

M anual Login i

Enter vour login and pazsword or challenge responze at the prompts. %hen you have
entered the login and password [or responge]. press 'Continue".

MOTE: Press "Continue" at the "'Terminal Type'' prompt.
If you have already selected & terminal twpe, press "Cancel'’ and by again.

Login: acraft
Challenge: &654-1610 Product ID:7000000000
Fesponse: 4651915

TUnknown Terminal Type 'cygwin'
TERM=[at38e]?

Continue [F7) i Cancel Help
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Once you have populated the fields on the Voice Mail System Properties
page, the screen should look similar to the one below.

Yoice Mail Spztem Properties
~Syatem
f : iDEFINITY OME - Audix
L Shstemn name:
ﬁ__.
— Login

™ Login manuslly o system

Login narme: |acrafl

' Pasaword: Im—
Password (again; |1—

" Access Security Gateway [A55)

Secret key: I

— Conrections

Tupe I Ciial/Host I Part I Device I

Add... | F'mpglties...l Eemoye |

Ok I Cancel | Help |
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3. Click on the Add button at the bottom of the screen. This is used to add a
physical connection mechanism from the client machine to the DEFINITY
ONE. Clicking on the Add button will pop up a screen similar to the one

below.
Connection Properties
Genaral |Advanced|
— Details
@) .
Eort: I
" Direct zerial port connection
Part: JEon =
¥ " Modem or data module connection
Device: i :J
Fart cam [7]
Phone Mumber: !
Edipers. | | EdtDeviess. |
QK. I Cancel | Apply | Help |
=>» NOTE:

Regardless of the physical connection used, that is, Local
monitor/keyboard/mouse, PCMCIA, RAS modem or customer LAN, THE
CONNECTION TYPE IS ALWAYS A NETWORK CONNECTION.

=>» NOTE:

By default the Modem or data module connection radio button is
highlighted; be sure to click on the LAN connection radio button.

4. Host: For the host address, enter the IP address that is commensurate
with the physical connection mechanism used to connect to the DEFINITY
ONE. See[Chapter H,]“Installation Connectivity Quick Reference”.

5. Port: For the port number, ALWAYS use port 23.
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6. Click on Apply followed by OK, this will dismiss the Connection Properties

page and put you back at the Voice Mail Properties page, similar to the
one below.

Voice Mail System Properties

— Spstem

g@ | Systemnamer|DEFINTY ONE - Auds

~ Login

[ Login manually to spstem

Login hame: |acraft

5 Password: I—
Password (again): IW—

" Access Security Gateway [85G]

Secret keyw I

- Connection:

Type | Dial/Host | Port | [ievice
T Metwork 19211136 23

Flopertics.., | Hemawe |

Ok | Cancel | Help |

7. Click on the OK button to complete the addition of the Voice Mail System
Administration item.



DEFINITY ONE™ Communications System Release 2.0 Issue 2

Installation and Upgrades 555-233-109 June 2000
DEFINITY Site Administration (DSA)
Configure DSA 7-21

By clicking on the Tree tab on the DSA window you can see the newly
added DEFINITY ONE Switch Administration item. The screen will look
similar to the one below.

&' DEFINITY Site Administration

Eile Edt View Took Window ﬂelp

= Bl e @I%] )] [oerNTY ONE -Swich =]

“‘.‘f( Tasks i Tres I

x| Severiy | D ate/Time | Syztem | Deseription
o ﬂ Infa 03/01/41993 202:21...  estonia change system-parameters cdr
ﬂ Infa 03/01/41993 20207...  estonia change system-parameters cdr
ﬂ Infa 03/01/41993 201:52...  estonia change system-parameters cdr
ﬂ Infa 03/01/41993 201:37...  estonia chsps cdr
«| | |
Ml 4| blbll\ HishnryA Schedule )\ Connecion Statuz [
Ready MUK A

Starting a Switch Administration session

To launch a GEDI session:
1. Click on the tree tab of the DSA window

2. Right click on the newly created Switch Item (DEFINITY ONE Switch in our
example)

3. Click on General
4. Click on Start GEDI

While the connection is being established, a screen similar to the one
below will be displayed.

Connecting

Setting up connection, pleaze wait....
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Once the connection has completed, a screen similar to the one below displays.

& DEFINITY Site Administration - [DEFINITY ONE - Switch GEDI]

@ File Edit Wiew Toolz ‘“Window Help _iﬁ'i_X__j

2] [2|&] @] [oermTy onE -Swich =] |
=l i _:j send[rtn]i help [F5) Ecancel[esc]i ehter

@ Workspace

--{E] Button Labels
DEFINITY OME - Audix
DEFINITY OME - Switch

This system is restricted to authorized users
for legitimate business purposes. Unauthorized
access is a criminal violation of the law.

Copyright (c) 1992 - Lucent Technologies
Unpublished & Mot for Publication
All Rights Reserved

- « | :IJ
“ Tasks 18 Tree i

Ready — [T 1,

To launch an emulation session:
1. Click on the Tree tab of the DSA window
2. Right click on the newly created Switch Item (DEFINITY ONE “- Switch”.
3. Click on Advanced
4. Click on either 4410 Emulation or 513 Emulation

While the connection is being established, a screen similar to the one
below will be displayed.

Connecting

Sething up connechon, pleaze wait. . Cancel
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Once the connection has completed, a screen similar to the one below
displays.

Q‘ DEFINITY Site Administration - [DEFINITY OME - Switch Emulation]

I Fie Edit View Tools Window Help =18 x|

i‘@ B> (5|8 @) [oEANTY ONE - Swich 7]
| x| cancel i i i i help i i i

@ wiorkspace
~{E] Button Labels

DEFIMITY OME - Audix
DEFIMITY OME - Switch

This system is restricted to authorized users
for legitimate business purposes. Unauthorized
access is a criminal violation of the law.

Copyright {c) 1992 - Lucent Technologies
Unpublished & Hot for Publication
All Rights Reserved

Y% Tasks U8 Tree i

FReady

Starting a Voice Mail Administration session
1. Click on the Tree tab of the DSA window

2. Right click on the newly created Voice Mail System Item (DEFINITY ONE
AUDIX in our example)

3. Click on either 4410 Emulation or 513 Emulation
While the connection is being established, a screen similar to the one
below displays.

Connecting

—

Setting up conhection, pleaze wait...
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When the connection completes, a screen similar to the one below
displays.

Q‘ DEFIMITY Site Administration - [DEFIMITY ONE - Audix Emulation]

- [ |
&2|x| ; =] ; [DEFINITY ONE - Swich =] |
=] cancel refresh

=]

|2 Workspace i Alarms: none
Button Labels
DEFINITY OME - Audiz
DEFINITY OME - Switch

clearfld help choices restpage | prevpage

enter

enter command:

¥ Tasks P8 Tree ; 7 5

Ready
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Message Manager Installation

This chapter provides the tasks required to install Message Manager:

= ‘“Introduction” on page 8-1

= |‘Pre-Installation considerations”|on page 8-2

= |“Installation to a client PC”|on page 8-8

Introduction

The Lucent Technologies INTUITY Message Manager is a tool for handling
multimedia messages with use of a personal computer (PC).

Message Manager visually accesses the AUDIX messaging system through a
local area network (LAN) connection. When connected to a LAN, the AUDIX
system is referred to as the "AUDIX server".

The following describes the process for installing client copies of Message
Manager on individual AUDIX users’ PCs.

Standard features

This Windows-based application provides the following features:

« Visual display of the AUDIX mailbox capable of playing voice messages,
viewing faxes and text messages, and launching or exporting file
attachments, through a simple graphic interface

» A Personal Address Book on the PC, independent of the AUDIX server

» Personal folders for sorting and storing messages on the PC, independent
of the AUDIX server
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» Soundcard support for playing and recording messages and greetings on
the PC, depending on availability of sound card, speakers, and
microphone.

» Remote, off-site access to messages through a high-speed modem and
TCP/IP (PPP) access to a LAN, depending on hardware availability

» The ability to receive, create, and send text messages and attached files

» Fax messaging, including receiving, forwarding, deleting, printing, or
creating fax messages, depending on the release and configuration of the
AUDIX server.

= Related Documentation

The following information is available:

» The Message Manager section of the AUDIX electronic documentation
describes preparation of the AUDIX system for Message Manager.

» The Guide Builder program creates a customized quick reference user
guide that describes the features and use of AUDIX and Message
Manager.

» The custom.txt file appears when Message Manager users select About
Your System from the Help menu. As the system administrator, you can
revise the custom.txt file to include information useful to your subscribers.
See[‘Updating your site-specific information”|on page 8-17.

Pre-Installation considerations

This section describes installation requirements and options for setting up and
running Message Manager 4.5.

PC requirements

Minimum hardware and software required:
= A compatible operating system:
— Windows NT Version 3.51, with Service Pack 5
— Windows NT Version 4.0
— Windows 95

= A minimum 486, 66 MHz PC with 16 Mbytes of RAM and 19 Mbytes of
available hard disk storage (assuming a Personal Address Book with 400
entries). Exception:

— The tutorial requires an additional 10 Mbytes of disk storage.

— The operating system may require additional RAM for improved
performance (for example, 32 Mbytes of RAM for Windows NT).
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VGA or higher monitor (color recommended)
LAN interface card

Windows Sockets (WINSOCK.DLL) access to TCP/IP (either through a
NetWare Loadable Module or TCP/IP protocol stack)

Mouse supported by Microsoft Windows (recommended)

Microsoft Windows-compatible sound card with speakers and a
microphone (for remote access)

Speakerphone, telephone headset, or a Microsoft Windows-compatible
sound card with speakers, microphone, or a computer headset for
hands-free operation (optional)

Installation requirements

Ensure the PC and LAN will support Message Manager before installing. Perform
the following:

On the PC, log into the network and enable Microsoft Windows

Obtain a server name or TCP/IP address of a workstation in your network
from the LAN administrator and run the ping program from a DOS prompt
in Windows ("ping" the address or name). A ping from the DOS shell
without Windows running is not a valid test. For assistance ask your LAN
administrator how to access or use this utility.

If the ping fails or the system hangs, install Message Manager and on the
Help icon in the program group. For additional options, search for
"General Troubleshooting.”

The executable Message Manager software and a copy of the software
CD must be in different directories if a shared copy of Message Manager
is installed for users to run on the LAN and the Message Manager
software is copied to the LAN for easy distribution.

Administrative privileges or login as Administrator are required to install
the fax package on Windows NT.
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Operating system considerations

The Message Manager Setup program automatically tailors Message Manager to
work with the operating system installed on a PC. Operating system
considerations are:

» Message Manager Release 4.5 runs as a 32-bit application on Windows
95 and Windows NT (NT version 3.51 requires Service Pack 5).

» Message Manager Release 4.5 cannot run on Windows 3.1, 3.11, or NT
3.51 without Service Pack 5. Obtain Message Manager Release 4.3. to run
Message Manager on a 6-bit system.

» Reinstall Message Manager when changing operating systems. Message
Manager must be installed separately for each operating system if the PC
runs multiple operating systems (such as Windows NT and Windows 95).

Select installation type

Several methods of installation and operation are available for Message
Manager. On completion of the install process, select the following type of
installation (Refer to[Table 8-1 for advantages/disadvantages):

» Single User Install. Install a copy of Message Manager on each user’'s PC
using either of the following distribution methods:

— Share or copy the CD included in the installation package.

— Download compressed Message Manager files from the DEFINITY
Office browser interface or the intranet.

» Copy from LAN Server. Install a copy of Message Manager by accessing
the software through a LAN file server. This allows administrators easy
distribution of Message Manager through a LAN rather than sharing the
CD or downloading compressed files. See|"Installing Message Manager|
[from a LAN server”lon page 8-14.

» Run from LAN Server. All users on a LAN server share a single copy of
Message Manager. The Message Manager software that is only on the
LAN file server, can easily be updated by the LAN administrator. See
[“Installing and accessing a shared copy of Message Manager”|on page
8-10.

» Automated Installation. Start an automatic installation to load on users’
computers with an entire set of application software, including Message

Manager, as defined by the company. This allows administrators to easil
distribute a uniform set of user software to all computers. See

[automated installation process”|on page 8-15.
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Table 8-1.

Advantages and disadvantages of installation and operation choices

Install method

Advantages

Disadvantages

Single user install
from a CD

Fast load for users with slow
LAN connection (remote
access)

Administrator cannot
password-protect the CD

Requires CD distribution at
each update

Single user install
via browser
download

Users can install the
software

Stand alone executable that
requires only temporary
LAN access during install

Increases network traffic
during installation

LAN distribution

Fast load for users with LAN
connection

Secure — directory can be
password-protected

No CD to manage

Easily updated if software
changes

Requires disk space on
LAN server

Increases network traffic
during installation

Shared copy on
LAN

Saves disk space on user’s
computers

Secure — software can be
password-protected

No diskettes to manage

Easily updated if software
changes

Requires disk space on
LAN server

Can greatly increase
network traffic

May have much slower
execution speed,
depending on LAN
performance

Automated
installation

Simplest install for users
Administrator resources
required only initially

Fast load for users with slow
LAN connection (remote
access)

System administrator must
custom-build, load, and
distribute installation media

Requires software media
distribution at each update
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Upgrade considerations

If upgrading from an earlier release of Message Manager to Release 4.5, either
replace the existing version of Message Manager or keep two versions of
Message Manager installed on the same PC.

Before installation

Make a backup copy of the following directories and contents:
»  Workbench (Workbnch)
» Personal Folders (default names are PF1, PF2, PF3, PF4, and PF5)
» Address Book (PBOOK.MDB)

During installation
Complete the following:

» Close all Windows programs, including the current version of Message
Manager

» To save a copy of the current Message Manager software, select a new
directory name and program group when installing Release 4.5

» Installing Message Manager "basic" software removes the fax print drivers
from the computer. In addition, there can be two releases of Message
Manager installed, but only one set of fax print drivers.

» Install (or reinstall) the fax software that corresponds with the Message
Manager release for faxing after installing the basic software,.

After installation
Take note of the following:

» Message Manager Release 4.5, opening the first time, prompts the option
of converting the existing workbench and personal folders to the new
release.

— If converted, the messages are longer accessible by earlier
releases of Message Manager.

— If personal folders are not converted, new personal folders must be
set up in Release 4.5 under the main screen File menu. To later
convert a personal folder, select the folder as a Release 4.5
personal folders.
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» Release 4.5 uses the Address Book, Personal Folders, and Workbench
files located in the directory established with the previous version of
Message Manager. To protect files from deletion, use File Manager or
Explorer to copy the following directories and files to the Release 4.5
directory:

— PF1, PF2, PF3, PF4, and PF5 (and contents). Select Set Personal
Folder Properties from the File menu to set each new file location.

— Workbench (and its contents). Select the Workbench Directory from
the File menu to set the new file location.

— PBOOK.MDB. Open the Personal Address Book, select Open from
the File menu, go to the new location, and select PBOOK.MDB.

» The installation process provides several shortcut icons in the Message
Manager Windows program group and Start menu. The following icons
are valid for Message Manager Release 4.5:

— Fax Cover Page Wizard
— Help - US English

— Message Manager

— Personal Address Book

— ReadMe

Uninstalling Message Manager

Previous versions of Message Manager remain on the system until replaced or
removed. The method used to uninstall Message Manager varies with the
Message Manager release:

» Toremove Message Manager Release 4.3 or earlier, overwrite the files by
loading Message Manager 4.5 into the same directory, or delete the
Message Manager directory and files. See|‘Upgrade considerations” jon

page 8-6.

» Toremove Message Manager Release 4.5 or later, run unwise.exe from
the Message Manager directory.
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Installation to a client PC

Select the following during installation:
» Installation type to perform

» Parts of the application to install (basic and/or fax packages). For
Windows NT, log in as Administrator to install the fax package.

= To run Message Manager from the PCs or share a copy from the LAN. See
[‘Select installation type”lon page 8-4.

» Optional back up of files (upgrades and reinstalls)

Single user installation process

The default method of installation, described in Table 8.2, is from a CD or intranet
site to a single PC. Subsequent sections describe additional install and operation
methods (install from a LAN, run shared copy from a LAN, and automated install).

1. Perform one of the following installation options:
— Obtain the Installation CD.

— Download the Message Manager software file to a temporary
directory from the DEFINITY Office browser page or an intranet site
designated by the system administrator. Select File Explorer and
double click to decompress the file.

— Navigate to a LAN directory designated by the system
administrator.

2. Run setup.exe.

3. Complete the steps listed in[Table 8-2[to install Message Manager
Release 4.5.
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Table 8-2. Single user install screens
Screen name Notes
Welcome
License File
Tell Me Abouit... The Message Manager CD includes the following tools:

» Install description
= User Overview/Tutorial

=« Documentation

Select Installation Type

The following installation choices are described in

|insta||ation ter”|on page 8-4:

» Single User Install (Continue with the instructions in this
table)

= Shared Installation (Go to|‘Installing and accessing a

shared copy of Message Manager”|on page 8-10)
= Copy for LAN Installation (Go to|"Installing Message|

Manager from a LAN server’jon page 8-14)

» Automated Installation is available, although it is not a
selection on the Installation Type screen. (Go to
automated installation process’”|on page 8-15)

Important! message

Close open software applications. For Windows NT, you must
have administrative privileges or be logged in as Administrator
to successfully install the fax package.

Select Destination
Directory

To load the program in a directory other than the default, select
the directory of choice. If creating a new directory, type the
directory path in the Select Destination Directory dialog box.

Backup Replaced Files

Save Backup files in the Backup directory. Personal Folders,
Workbench, and Address Book files are not automatically

backed up; see|[‘Upgrade considerations”|on page 8-6.

Select Components

Select Message Manager and FAX for a complete installation.
Select fax to add it to a previous installation.

Enter FAX Information

If FAX is selected on the Select Components screen, enter the
Server ID and Extension. The information determines which
AUDIX mailbox opens when the user creates a fax. Select
Options/Preferences in Message Manager to add or update
later.

Continued on next page



DEFINITY ONE™ Communications System Release 2.0 Issue 2

Installation and Upgrades 555-233-109 June 2000
Message Manager Installation
Installation to a client PC 8-10

Table 8-2. Single user install screens — Continued

Screen name Notes

Ready to Install, Select Next on the Ready to Install screen. The Status light and

Installation Status a list of installed files appear.

Indicator

hints.txt The hints.txt screen contains a description of each program
group icon.

Installation Complete, The Message Manager is active following restart of the
computer.

Restart dialog box

4. Restart Windows to complete the installation process.

Installing and accessing a shared copy of
Message Manager

To install a shared copy the system administrator installs a single, shared
executable copy of the software on a LAN server, customizes certain files, and
installs (or notifies users to install) Message Manager on users’ PCs. When
Message Manager is installed on the PCs, a minimal set of files load, including
msg_mgr.ini, Personal Folders, and the Message Manager print driver (if fax
package installed).

The application loads from the server to the client computer's RAM when user
double s the Message Manager icon. Message Manager can run throughout the
day without affecting other users.

1. Run setup.exe.

2. Complete the steps in|Table 8-3|to install Message Manager Release 4.5
on the LAN server.
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Table 8-3. Shared installation Setup.exe screens

Screen name Notes

Welcome

License File

Tell Me About... The Message Manager CD includes the following

tools:
» Install description
= User Overview/Tutorial

= Documentation

Select Installation Type

Select Shared Installation. Installation options are
described in|‘Select installation type”|on page 8-4.

Important! message

Close open software applications. For Windows NT,
administrative privileges or login as Administrator
are required to install the fax package.

Select Destination
Directory

Designate or create the directory on the LAN server
to contain the Message Manager software. To load
the program in a directory other than default,
browse to the directory of choice. To create a new
directory, type the directory path in the Select
Destination Directory dialog box.

Backup Replaced
Files

Save Backup files in the Backup directory. Personal
Folders, Workbench, and Address Book files are

not automatically backed up; see[‘Upgrade]

[considerations”|on page 8-6.

Select Components

For a complete installation, select Message
Manager and FAX. Select FAX to add fax to a
previous installation.

Enter FAX Information

For shared Installations leave these fields blank.
The information determines which AUDIX mailbox
opens when the user creates a fax. Select
Options/Preferences in Message Manager to add or
update later.

Continued on next page
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Table 8-3. Shared installation Setup.exe screens — Continued

Screen name

Notes

Ready to Install,

Installation Status light

Select Next on the Ready to Install screen. The
Status light and a listing of the installed files appear.

hints.txt

The hints.txt screen contains a description of each
program group icon.

Installation Complete,

Restart dialog box

The Message Manager is active following restart of
the computer.

3. Customize either of the following text files to user needs:

= custom.txt — This is the file that Message Manager users see when
About Your System... is selected from the Message Manager Help

menu. See|“Updating vour site-specific information” jon page 8-17.

= hints.txt — This file contains a description of each program group

icon.

4. Install (or instruct users to install) the necessary user files and print driver
to each individual PC by from the LAN to the shared directory (created
during the LAN server install above) and run the SH_Setup.exe program.
The following table includes a description of the SH_Setup.exe install

process.

Table 8-4. Shared installation Sh_Setup.exe screens

Screen name

Notes

Welcome

License File

Important! message

Close open software applications. For Windows NT,
administrative privileges or login as Administrator
are required to install the fax package.

Select Destination
Directory

Load only a minimal set of files of the client PC. To
load the program in a directory other than default,
browse to the directory of choice. To create a new
directory, type the directory path in the Select
Destination Directory dialog box.

Continued on next page
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Screen name

Notes

Backup Replaced
Files,

Select Backup
Directory

Back up replaced system files in the default
directory or directory of choice. To create a new
directory, type the path in the Select Destination
Directory Dialogue Box. Personal Folders,
Workbench, and Address Book files are not
automatically backed up; see["Upgrade]

|considerations’|on page 8-6.

Select Components

Select Message Manager and FAX for a complete
installation. To add fax to a previous installation,
select FAX.

Enter FAX Information

If FAX is selected on the Select Components
screen, enter the Server ID and Extension. This
determines which AUDIX mailbox opens when the
user creates a fax. Select Options/Preferences in
Message Manager to add or update later.

Ready to Install,

Installation Status
Indicator

Select Next on the Ready to Install screen,. The
Status light and list of installed files appears.

hints.txt

The hints.txt screen describes each program group
icon.

5. Restart Windows to complete the installation process.
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The system administrator copies and decompresses the software from the CD to
a LAN server. Specific files are customized and Message Manager Release 4.5 is

installed (or users are notified to install) to individual PCs.

1. Run setup.exe.

2. Complete the steps Table 8-5 to copy and decompress the installation

files.

Table 8-5. LAN installation screens

Screen name Notes

Welcome

License File

Tell Me Abouit... The Message Manager CD includes the following

information tools:
» Install description
= User Overview/Tutorial

= Documentation

Select Installation Type

Select Copy for LAN Installation. Installation
choices are described in[‘Select installation type”|

on page 8-4.

Select Destination
Directory

Select or type the directory path in the Select
Destination Directory dialog box.

Ready to Install,

Installation Status
Indicator

Select Next on the Ready to Install screen. The
Status light displays and a list of installed files
appears.

hints.txt

The hints.txt screen describes each program group
icon.

3. Customize any of the following text files to meet user needs:

» custom.txt — This file appears when users select About Your
System... from the Message Manager Help menu. See

lyour site-specific information”|on page 8-17.

» docs.txt — This file, viewable during the install process, describes
the electronic user documents.

» hints.txt — This file contains a description of each program group

icon.
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» install.txt — This file, viewable during the install process, describes
the install choices.

» readme.txt — This file contains late-breaking information about
Message Manager Release 4.5. It is viewable at the end of the
Single User Install process.

» tutorial.txt — This file, viewable during the install process,
describes the computer-based overview tutorial.

4. Install (or instruct users to install) the application to each PC from the LAN
to the shared directory. Perform the[“Single user installation process”|on

page 8-8.

Using the automated installation process

The system administrator updates the silent.txt (template) file and installs the
software from the LAN to users’ computers.

1. Copy the silent.txt text from the Message Manager Release 4.5 CD to the
PC. The file contains the following text:

rem This is the Prototype Silent Install Settings File

rem This file is used to create a Silent Installation of
rem Message Manager version 4.5

rem To use this settings file, invoke the installation

rem as follows:

rem

rem <path>\Setup.EXE /M=<path2>\Silent. TXT

rem

rem Where <path> is the location of the Setup.EXE installation
rem executable

rem and <path2> is the location of the Silent.TXT file being
rem used

rem Following are the Variables and values required for
rem installation. Spelling and Capitalization are
rem CRITICAL!

rem Following line is required - do not change
SILENT=1

rem Following line is required - do not change
INSTALLTYPE=A

rem Following line is required - do not change
LANGUAGES=A
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rem Following is for "What to Install”

rem

rem use A for Basic, B for FAX, AB for both
COMPONENTS=AB

rem Following is used only for FAX install

rem

rem Provide the values for the FAX Server and Extension
rem Spelling is critical

rem

rem if left blank, install will use the previous values

rem from the msg_magr.INI file (if present)

FAXSERVER=

FAXEXTENSION=

rem Following is for Installation Location

rem

rem Directory location for Installation

rem

rem Example - MAINDIR=C:\MSG_MGR

rem Example - MAINDIR=C:\Program Files\Lucent\Message Manager
MAINDIR=C:\Program Files\Lucent\Message Manager

rem Following is for Backup of replaced files during

rem installation

rem

rem Use A for True, B for False

DOBACKUP=A

rem Following is for backup directory

rem If backup is not selected, file name is not used
BACKUP=C:\Program Files\Lucent\Message Manager\backup

rem Following is the Name of the Program Manager Group
rem for Message Manager installation.

rem Spelling is critical

GROUP=Message Manager

rem Following is the re-boot flag

rem Windows must be re-booted before using Message Manager
rem Setting this flag will cause the install to query the

rem user about the reboot

rem Clearing this flag will not reboot, and will not ask

rem the user

rem Use S for System Reboot (recommended), W for Windows
rem reboot, and nothing for no reboot.

RESTART=S

rem End of silent install parameters
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2. Customize silent.txt to specify the following:
» COMPONENTS
» FAXSERVER
= FAXEXTENSION
= MAINDIR
« DOBACKUP

3. Follow the instructions in silent.txt to enable the automatic installation
process.

Updating your site-specific information

Message Manager Release 4 and later allows users or administrators to update a
custom file with site-specific information such as the AUDIX server ID, prefixes,
text-addressing format, feature-access codes, and help numbers. Users select
About Your System in the customs file from the Help menu on the Message
Manager main screen.
To update the default custom file or supply a quick-reference file:

1. Access the Message Manager Release 4.5 directory.

2. Locate the default custom.txt file template provided with Message
Manager. To update this file:

» Open the custom.txt file using any ASCII text editor.

» Follow the instructions in the template and save the file.
3. Toinstall a custom file of a different type (such as doc or hip):

» Move or rename the default custom.txt file template.

» Put custom file in the same directory as the executable Message
Manager msg_mgr.exe file. Name the file “custom”.

» If you use a file type other than txt, there must be a computer
application associated with that extension, or the custom file will not
run.
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Updating the custom file varies according to the installation setup:

Users sharing a copy of Message Manager on a LAN server access the
same custom file, which is either the default template or the system
administrator’s version. If the administrator later updates the custom file,
users access the new version the next time Message Manager is run.

Users installing a personal copy of Message Manager on a PC from a LAN
server initially obtain the custom file (either the default or the
administrator’s version) from the server. If this file is later updated, users
must manually copy it from the server or reinstall Message Manager.

Users installing a Message Manager CD must update custom files
independently. The administrator may provide a modified custom file for
users to copy to an application directory after installation (distributed on
diskette, as an attached file, or through a LAN server). If so, include
directions for users to rename or remove the old or default custom.txt file.
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Troubleshooting

This chapter provides information specific to troubleshooting installation
problems. Problem types can:

» Be new and never worked through before
» Occur after installation

= Occur after installation has worked

The following sections apply:

= |“Install Wizard error messages” Jon page 9-2

« |‘Platform troubleshooting commands”Jon page 9-5

[“Modem configuration and administration” jon page 9-5
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Install Wizard error messages

Error messages can occur with the DEFINITY ONE Install Wizard. Error
messages and possible explanation/remedies are presented on the next page:

Error message

Possible explanation/remedy

Unable to set the registry
default root to HKEY _
LOCAL_MACHINE

The registry key HKEY_LOCAL_MACHINE is
not accessible from the install wizard.
Ensure that the registry key is accessible.

DEFINITY ONE is still
running. Shut it down and
restart install.

Install wizard cannot execute while
DEFINITY ONE is running. The command,
shutdown all, shuts down the applications
related to DEFINITY ONE. After this

command executes, rerun the install wizard.

Unable to shut the

CornerStone logger down.
Manually shut it down and
restart the install program.

Execute
C:\\LucentSoftware\CornerStone\mtce\bi
n\csShutdownlog.exe. Execute the
command
C:\\LucentSoftware\CornerStone\bin\cslo
g_server.exe -UnregServer. The
CornerStone logger should shut down.
Rerun the install wizard.

Unable to register the
following files xxxx,yyyy,.....

The install program is unable to self register
the files. Register the DLLs manually using
the command regsvr32.

Unable to Reboot
workstation Reboot now

Install wizard tried to reboot the workstation,
but was not successful. Reboot attempted
because some of files were not installed
properly (may be in use). Manually push the
shutdown button on the front of the TN795
and power cycle.

Unable to set xxxx:yyyy from

[ffff]

Install wizard could not read the key yyyy
from section xxxx in the ini file ffff. Check:

» The ini file ffff should be in the same
directory as Setup.exe (install wizard).

= The ini file ffff should have read
permissions.

= The ini file ffff has the section xxxx and a
value for the key yyyy.

Unable to determine screen
resolution

Escalate
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Error message

Possible explanation/remedy

Screen resolution must be at
least 640x480.

Install wizard requires that the screen
resolution be at least 640x480.

Unable to determine the Escalate
operating system
Unable to determine Escalate

operating system version

Operating system must be
Window NT 4.0.

The underlying OS is not Windows NT 4.0.

Must have administrator
privileges to run this program

Installer does not have administrative
privileges.

Unable to get free disk
space on X drive

Escalate

Not enough space on X drive
for new install. Space
required is Y.

Free up space and ensure that there is at
least Y MB space on drive X.

Not enough space on X drive
for an upgrade. Space

Free up space and ensure there is at least Y
MB space on drive X.

required is Y.

Unable to parse path Escalate
Unable to remove last slash Escalate
from path

Unable to get current path Escalate
Unable to create [XXXX] Escalate

Unable to create a target
directory

Ensure that the path is syntactically correct
and you have access rights to the target
drive.

Unable to allocate memory
required to complete the
copy file process

Free memory by terminating as many
running applications as possible.

Not enough disk space on
target drive to copy the files

Free disk space on target drive.

Unable to open the input file

Ensure the source file is a valid file name,

and the source file and target directory exist.

Unable to copy the
requested file

Escalate

Target file is read-only.

Remove read-only attribute from target file
and try again.

A self-registering file did not
register successfully.

Escalate
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Error message Possible explanation/remedy
Unknown error Escalate
Unable to copy file [X] Escalate

Unable to get directory name Escalate

Unable to parse directory Escalate

Unable to create Substring Escalate

section list

Unable to open file X Escalate

Unable to merge [X] into the  Escalate

Registry

Translation ID interval Login INADS. Reset Translation ID. Save
expiration Translation.

The following warnings (insignificant errors) may be generated by the
installconfig wizard. Attempt to manually resolve these. Note them in the log book
and continue. They are:

» Unable to get the AUDIX extension length

= Unable to add DSA shortcut to Start Menu

» Unable to reset AUDIX extension length to xxxx

» Unable to get file size

» Unable to get the product version from the last install

» Unable to create directory
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Platform troubleshooting commands

For a complete list of commands, see[‘Lucent access controller bash|
commands”jon page G-1. Detailed strategic analysis of each command is found
in DEFINITY ONE Communications System Release 2.0 Maintenance
(555-233-111).

Modem configuration and
administration

The following procedures describe how to check settings and test the external
modem:

“Configure modem” on page 9-5

= “Verify INADS modem settings” on page 9-5

« [“Verify external modem option settings”|on page 9-6

[“Configure External Option Modem”|on page 9-6

[“Test the external modem” Jon page 9-8

=>» NOTE:

The modem (U.S. Robotics Model) is preconfigured to work correctly.

Configure modem

Verify INADS modem settings

No external modem installed

If no external modem is connected to INADS (no INADS Alarm Origination),
proceed as follows:

1. Enter display system-parameters maintenance and press (ENTER).

2. Verify that the Alarm Origination Activated to OSS Numbers field is set to n
and press (ENTER).

3. Verify that Cleared Alarm Notification and Restart Notification are set to n.

External modem installed
1. Enter display system-parameters maintenance and press (ENTER).

2. Verify that the Alarm Origination Activated to OSS Numbers field is setto y
and press (ENTER).

3. Verify that the Cleared Alarm Notification and Restart Notification fields are
settoy.
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Verify external modem option settings

1.

10.
11.

12.
13.
14.

=>

Follow the procedure Start a pcAnywhere Client Session from the Laptop
Computer to connect to pcAnywhere.

ClLick Start > Settings > Control Panel.
Double click Modems.

A Modem Properties screen displays that shows the US Robotics 336K
FAX Ext modem.

Click Next.

Another Modem Properties screen displays.

. Verify the modem port is attached to COM1.

Click Next.
Another Modem Properties screen displays.

Right click Properties.

. The Properties screen displays.

Verify speed and speaker volume defaults are set.

Click Connection.

Verify that Data bits is 8, Parity is none, and Stop bits is 1.
Click Advanced.

The Advanced Connection Settings screen displays.

Verify that the defaults are set.
Click OK > Close.
Configure External Option Modem

NOTE:
This procedure is necessary if the factory shipped modem is not used.

Start a pcAnywhere Client Session from the Laptop Computer to connect
to pcAnywhere.
Click Start > Settings > Control Panel.

Double click Modems.
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The Modem Properties screen.

Install New Modem

Wwindows MT will now try to detect your modem.  Before
continuing, you should:

1. If the modem iz attached to your
computer, make sure it is turned on.

2. Quit any programs that may be using the
modern.

Click Mext when you are ready to continue.

[ Don't detect my modem; | will select it from a list]

< Bachk I Mest » I Cancel |

4. Click Don’t detect my modem. | will select it from a list.
5. Click Next.
Install New Modem screen displays
6. Click Add.
Install New Modem screen displays.
7. Select the manufacturer (3COM Corp) and the model (US Robotics 336K
FAX Ext).
8. Click Next.
9. Select the port the modem is attached to (COM1).
10. Click Next.
The Modem Setup screen states that you need to restart the modem
before using it.
11. Click Finish > OK.

Another Install New Modem screen states that the modem is set up
successfully. The Modem Properties screen displays.

Configure the installed modem

1.

Right click Properties.

The Properties screen displays.

. Click OK to accept speed and speaker volume defaults.

3. Click Connection tab.

. Click OK to accept the defaults For Data bits (8), Parity (none), Stop bits

(1), and Call Preference.
Click the Advanced button.

The Advanced Connection Settings screen displays.
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6. Click OK to accept the defaults.
7. Click OK > Close.

The Modem Properties screen displays.
8. Click Close.

The following message displays: “Dial-up Networking requires configuring
because the list of installed modems has changed. Would you like to do
this now?”

9. Click Yes.

10. The Remote Access Setup screen confirms that the modem is
configured.

Test the external modem

1. Atthe SAT session, type change system parameters maintenance, and
Click or Submit.

2. Ensure that the Test Remote Access Port field is set to y.
3. Type test pr-maintenance and Click or Submit.
4. \Verify that test 230 passes.

For more information See DEFINITY Enterprise Communications System
R7 Administration for Network Connectivity (555-233-501.
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Security and Copy Protection

This chapter provides information about software copy protection.

Software copy protection mechanisms

This section provides information about software copy protection methods for the
installation, repair, and upgrade of procedures related to the TSC/COE.

Copying software from one machine to another is more of an issue with DEFINITY
ONE’s Windows NT platform running the three primary applications (DEFINITY,
AUDIX, and DSA) than with a proprietary system.

Security measures add a level of impedance (time, money, expertise, etc.) to the
process to discourage copying without permission. The possibility exists for
someone with physical access to break into a system. There are two types of
software protection in the DEFINITY ONE environment: feature and copy
protection.

Feature protection

Feature protection has specific feature protection capabilities or capacities within
an application. It controls the capabilities provided by the application. For
example, the DEFINITY feature Translation copy protection supports a “customer
options” administration form to tailor operation of DEFINITY to a specific
customer.
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Software copy protection mechanisms

Copy protection

Copy protection prevents software copying. A special mechanism associated
with the DEFINITY ONE license file prevents the software from running on other

systems.
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Cable Pinouts

This appendix provides the following information forTN760D Tie Trunk and
TN464E/F option settings, connector and cable diagrams, and pinout charts.

= |“TN760E tie trunk option settings”|on page A-1

= |“TN464F option settings”|on page A-4

= |“Connector and cable diagrams —pinout charts”|on page A-6

TNT760E tie trunk option settings

The TN760E Tie Trunk circuit pack interfaces between 4 tie trunks and the TDM
bus. Two tip and ring pairs form a 4-wire analog transmission line. An E and M
pair are DC signaling leads used for call setup. The E-lead receives signals from
the tie trunk and the M-lead transmits signals to the tie trunk.

To choose the preferred signaling format|(Table A-1land |Tab|e A-2),|set the
switches on the TN760D and administer the port using [Figure A-1 and [Table A-3]
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Table A-1. Signaling formats for TN760E

Mode Type

E&M Type | Standard (unprotected)

E&M Type | Compatible (unprotected)

Protected | Type | Compatible, Type | Standard

Simplex Type V

E&M Type V

E&M Type V Revised

Table A-2. Signaling type summary
Signaling type Transmit (M-Lead) Receive (E-Lead)
On-Hook Off-Hook | On-Hook Off-Hook
Type | Standard ground battery openllbattery ground
Type | Compatible openllbattery ground ground openllbattery
Type V openllbattery ground open ground
Type V Reversed | ground open ground open

1.

An open circuit is preferred instead of battery voltage.
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Figure A-1.

TN760D tie trunk circuit pack (component side)

Table A-3. TN760E option switch settings and administration

Installation situation Preferred signaling format E&M/SMPLX | Prot/Unprot | Administered
Circumstance | To System Far-end switch switch port
Collocated DEFINITY E&M Type 1l | E&M Type 1 | E&M Unprotected | Type 1
Compatible Standard Compatible
Inter-Building DEFINITY Protected Protected E&M Protected Type 1
Type 1 Type 1
Compatible Standard Compatible
Plus
Protection
Unit
Collocated Net E&M Type 1 | Any PBX E&M Unprotected | Type 1
Integrated
Standard
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TNA464F option settings

The TN464E/F DS1/E1 Interface - T1/E1 circuit pack interfaces between a 24- or
32-channel Central Office/ISDN or tie trunk and the TDM bus.

Set the switches on the circuit pack to select bit rate and impedance match. See
Table A-4 and If the top switch setting is set to 32 Channel, set the
lower switch setting to either 120 Ohm or 75 Ohm.

Table A-4. Option switch settings on TN464F

120 Ohms Twisted pair

75 Ohms Coaxial requiring 888B adapter
32 Channel | 2.048 Mbps
24 Channel | 1.544 Mbps
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Figure Notes

1. TN464F 3. 24/32 Channel Selector
(24CH shown)

4. 75/120 Ohm Selector
(120 Ohm shown)

2. Option Switch

Figure A-2. TNA464E/F option settings
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Connector and cable diagrams —
pinout charts

See Table A-5 for typical lead designations. The circuit packs and auxiliary
equipment are classified as shown in the following tables.

Table A-5. Lead and color designations

Cross-connect Amphenol

pin Color pin Backplane pin
1 W-BL 26 102
2 BL-W 01 002
3 W-O 27 103
4 O-w 02 003
5 W-G 28 104
6 G-w 03 004
7 W-BR 29 105
8 BR-W 04 005
9 W-SL 30 106
10 SL-W 05 006
11 R-BL 31 107
12 BL-R 06 007
13 R-O 32 108
14 O-R 07 008
15 R-G 33 109
16 G-R 08 009
17 R-BR 34 110
18 BR-R 09 010
19 R-SL 35 111
20 SL-R 10 011
21 BK-BL 36 112
22 BL-BK 11 012
23 BK-O 37 113
24 O-BK 12 013

Continued on next page
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Table A-5. Lead and color designations — Continued

Cross-connect Amphenol

pin Color pin Backplane pin
25 BK-G 38 302
26 G-BK 13 202
27 BK-BR 39 303
28 BR-BK 14 203
29 BK-SL 40 304
30 SL-BK 15 204
31 Y-BL 41 305
32 BL-Y 16 205
33 Y-O 42 306
34 O-Y 17 206
35 Y-G 43 307
36 G-Y 18 207
37 Y-BR 44 308
38 BR-Y 19 208
39 Y-SL 45 309
40 SL-Y 20 209
41 V-BL 46 310
42 BL-V 21 210
43 V-O 47 311
44 O-Vv 22 211
45 V-G 48 312
46 G-V 23 212
47 V-BR 49 313
48 BR-V 24 213
49 V-SL 50 300
50 SL-V 25 200

Issue 2
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Processor external cable pinout
Table A-6 shows the pinout for the processor external cable.
Table A-6. Processor external cable pinout
Processor
(PD)
(amphenol AUX Modem
Signal name connector) J1) (P2) Mouse Keyboard USB | VGA Ethernet
ACC48A 12 19
AP1 (alarm in) 2 26
AP2 (alarm in) 27 27
EXTALMA 4 48
EXTALMB 3 23
XFER48 38 36
GROUND 25 1
MOD-CTS 21 5
MOD-DCD 46 8
MOD-DSR 8 6
MOD-DTR 7 20
MOD-GRD 20 1&7
MOD-RTS 34 4
MOD-RXD 33 3
MOD-TXD 45 2
MOUSE-DAT 18 1
MOUSE-GRD 31 3
MOUSE-VCC 6 4
MOUSE-CLK 5 5
KYBD-DAT 30 1
KYBD-GRD 17 3
KYBD-VCC 16 4
KYBD-CLK 29 5
USB-vCC 15 1
USB-DAT- 40 2
USB-DAT+ 42 3
GRD 41 4
VGA-RED 49 1

Continued on next page
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Table A-6. Processor external cable pinout — Continued
Processor
(PD)
(amphenol AUX Modem
Signal name connector) J1) (P2) Mouse Keyboard USB | VGA Ethernet
VGA-GREEN 47 2
VGA-BLUE 23
GRD 10 5
GRD 48 6
GRD 46 7
GRD 24 8
VGA-PWR 35 9
GRD 36 10
VGA-HSYNC 37 13
VGA-VSYNC 11 14
ETH-RD+ 44 3
ETH-RD- 19 6
ETH-TD+ 32 1
ETH-TD- 7 2
RX- 28
TX+ 13
TX- 14
RX+ 39
NC —
NC —
GROUND 50
NC —
— 43
NC —
NC —
NC —
— 1
=>» NOTE:

AUX is a 50-pin receptacle, Modem is a 25-pin D-sub plug, Mouse is a 6-pin miniature
DIN receptacle, Keyboard is a 6-pin miniature DIN receptacle, USB is a type A

receptacle, VGA is a 15-pin D-sub receptacle, and Ethernet is an 8-pin jack.
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Table A-7. Portcircuit pack lead designations
TN742/B
TN747B
TN753 TN760/B TN793
Cross- TN769 TN760C TN763 TN767B TN746/B | TN2793
Connect | TN2147 TN754 | TN760D TN763B TN464E TN2183 TN2224/B
pin TN465 TN726 | TN2209 TN762/B | TN763C | TN735 | TN2207 TN2215 TN2214
1 T T1 T1 T TA c5 T1 T1
2 R.1 R.1 R.1 R.1 R.1 R.1 R.1
3 TXT.1 | T11 TXT.1 sz.1 BT.1 C_ENAB T.2 T.2
4 TXR.1 | R1.1 TXR.1 sz1.1 BR.1 R.2 R.2
5 PXT.1 | E1 PXT.1 s.1 LT.1 C_SYNC* T3 T3
6 PXR.1 | M1 PXR.1 s1.1 LR.1 R.3 R.3
7 T.2 T.2 T.2 T.2 T2 C2D-DATA | T.4 T.4
8 R.2 R.2 R.2 R.2 R.2 RDATA* R.4 R.4
9 TXT.2 | T1.2 TXT.2 sz.2 BT.2 TDATA* T5
10 TXR.2 | R1.2 TXR.2 sz71.2 BR.2 TRSYSNC R.5
11 PXT.2 | E2 PXT.2 S.2 LT.2 GRD T6
12 PXR2 | M2 PXR.2 s1.2 LR.2 SCLK* R.6
13 T3 T3 T3 T3 T3 T7
14 R.3 R.3 R.3 R.3 R.3 R.7
15 TXT.3 | T1.3 TXT.3 sz.3 BT.3 T8
16 TXR.3 | R1.3 TXR.3 s71.3 BR.3 PAHER* R.8
17 PXT.3 | E3 PXT.3 s3 LT3 T5 T.9
18 PXR.3 | M3 PXR.3 S1.3 LR.3 C_48v R.5 R.9
19 T.4 T.4 T4 T.4 T4 T6 T.10
20 R.4 R.4 R.4 R.4 R.4 R.6 R.10
21 TXT4 | T1.4 TXT.4 Sz.4 BT.4 C_P2SCLK | T.7 T.11
22 TXR4 | R1.4 TXR.4 S71.4 BR.4 LI (RX) R.7 R.11
23 PXT4 | E4 PXT.4 S.4 LT.4 LO* (TX) T8 T.12
24 PXR4 | M4 PX4.4 S1.4 LR.4 LBACK1 R.8 R.12
25 T5 T5 T5 T5 T5 GND T.9 T.13
26 R.5 R.5 R.5 R.5 R.5 C_5v R.9 R.13
27 TXT5 | T15 TXT.5 SZ.5 BT.5 T.10 T.14
28 TXR5 | R15 TXR.5 S71.5 BR.5 R.10 R.14
29 PXT.5 | E5 PXT.5 S5 LTS5 T.11 T.15
30 PXR5 | M5 PXR.5 S1.5 LR.5 C_RST R.11 R.15
31 T.6 T6 T6 T.6 T6 T.12 T.16
32 R.6 R.6 R.6 R.6 R.6 R.12 R.16
33 TXT6 | T16 TXT.6 SZ.6 BT.6 RDATA T.17
34 TXR.6 | R1.6 TXR.6 S71.6 BR.6 TDATA R.17
35 PXT.6 | E.6 PXT.6 S6 LT.6 TRSYNC T.18
36 PXR.6 | M.6 PXR.6 S1.6 LR.6 GRD R.18
37 T.7 T.7 T.7 T.7 T7 SCLK T.19
38 R.7 R.7 R.7 R.7 R.7 R.19
39 TXT.7 | T1.7 TXT.7 sz.7 BT.7 T.20

Continued on next page
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Table A-7. Port circuit pack lead designations — Continued
TN742/B
TN747B
TN753 TN760/B TN793
Cross- TN769 TN760C TN763 TN767B TN746/B | TN2793
Connect | TN2147 TN754 | TN760D TN763B TN464E TN2183 | TN2224/B
pin TN465 TN726 | TN2209 | TN762/B | TN763C | TN735 | TN2207 TN2215 | TN2214
40 TXR.7 | RL7 TXR.7 sz1.7 BR.7 R.20
41 PXT.7 | E7 PXT.7 s.7 LT.7 GRD T.13 T.21
42 PXR.7 | M.7 PXR.7 S1.7 LR.7 R.13 R.21
43 T.8 T.8 T.8 T.8 T8 C_PRES* T.14 T.22
44 R.8 R.8 R.8 R.8 R.8 R.14 R.22
45 TXT.8 | T18 TXT.8 sz.8 BT.8 T.15 T.23
46 TXR.8 | R1.8 TXR.8 sz1.8 BR.8 DC2_DATA | R.15 R.23
47 PXT.8 | E8 PXT.8 s.8 LT.8 LI* (RX) T.16 T.24
48 PXR.8 | M.8 PXR.8 S1.8 LR.8 LO (TX) R.16 R.24
49 GRD GRD GRD GRD GRD GRD LBACK2 GRD GRD
50 GRD GRD GRD GRD GRD GRD GRD GRD GRD
* Denotes high side of line.
Table A-8. DS1 interface cable H600-307 (and C6C)
50-Pin 15-Pin
Pin Color Designation | Pin Color Designation
02 W-BL
03 BL-W
47 W-G LI (High) 11 W-G LI (High)
22 G-W LI 03 G-W LI
48 W-BR LO 09 W-BR LO
23 BR-W LO (High) 01 BR-W LO (High)
49 W-SL LOOP2 06 W-SL LOOP2
24 SL-W LOOP1 05 SL-W LOOP1

All other pins are empty.
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Table A-9 shows the pinouts for the TN2185 ISDN-BRI 4-wire S Interface.

Table A-9. TN2185 ISDN-BRI — 4-Wire S interface pinout

Port | Signal | Cross-connect pin | Color | Amphenol pin | Backplane pin
1 TXT.1 |1 W-BL 26 102
TXR.1 | 2 BL-W 01 002
PXT.1 |3 W-O 27 103
PXR.1 | 4 Oo-w 02 003
2 TXT.2 |5 W-G 28 104
TXR.2 | 6 G-W 03 004
PXT.2 |7 W-BR | 29 105
PXR.2 | 8 BR-W | 04 005
3 TXT.3 | 9 W-SL 30 106
TXR.3 | 10 SL-W 05 006
PXT.3 | 11 R-BL 31 107
PXR.3 | 12 BL-R 06 007
4 TXT.4 | 13 R-O 32 108
TXR.4 | 14 O-R 07 008
PXT.4 | 15 R-G 33 109
PXR.4 | 16 G-R 08 009
5 TXT.5 | 17 R-BR 34 110
TXR.5 | 18 BR-R 09 010
PXT.5 | 19 R-SL 35 111
PXR.5 | 20 SL-R 10 011
6 TXT.6 | 21 BK-BL | 36 112
TXR.6 | 22 BL-BK | 11 012
PXT.6 | 23 BK-O 37 113
PXR.6 | 24 0O-BK 12 013
7 TXT.7 | 25 BK-G 38 302
TXR.7 | 26 G-BK 13 202
PXT.7 | 27 BK-BR | 39 303
PXR.7 | 28 BR-BK | 14 203

Continued on next page
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Port | Signal | Cross-connect pin | Color | Amphenol pin | Backplane pin
8 TXT.8 | 29 BK-SL | 40 304

TXR.8 | 30 SL-BK | 15 204

PXT.8 | 31 Y-BL 41 305

PXR.8 | 32 BL-Y 16 205

Table A-10 shows the pinout for the TN793 and TN2793 24-Port Analog Line

circuit pack.

Table A-10. TN793 Analog line circuit pack pinout

Port | Signal Cross-connect pin Color | Amphenol pin | Backplane pin
1 T.1 1 W-BL | 26 102
R.1 2 BL-wW | 01 002
2 T.2 3 W-O 27 103
R.2 4 O-W 02 003
3 T.3 5 W-G 28 104
R.3 6 G-W 03 004
4 T.4 7 W-BR | 29 105
R.4 8 BR-W | 04 005
5 T.5 9 W-SL | 30 106
R.5 10 SL-W | 05 006
6 T.6 11 R-BL 31 107
R.6 12 BL-R 06 007
7 T.7 13 R-O 32 108
R.7 14 O-R 07 008
8 T.8 15 R-G 33 109
R.8 16 G-R 08 009
9 T.9 17 R-BR | 34 110
R.9 18 BR-R | 09 010
10 T.10 19 R-SL 35 111

Continued on next page
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Port | Signal Cross-connect pin Color | Amphenol pin | Backplane pin
R.10 20 SL-R 10 011
11 T.11 21 BK-BL | 36 112
R.11 22 BL-BK | 11 012
12 T.12 23 BK-O | 37 113
R.12 24 O-BK | 12 013
13 T.13 25 BK-G | 38 302
R.13 26 G-BK | 13 202
14 T.14 27 BK-BR | 39 303
R.14 28 BR-BK | 14 203
15 T.15 29 BK-SL | 40 304
R.15 30 SL-BK | 15 204
16 T.16 31 Y-BL 41 305
R.16 32 BL-Y 16 205
17 T.17 33 Y-O 42 306
R.17 34 O-Y 17 206
18 T.18 35 Y-G 43 307
R.18 36 G-Y 18 207
19 T.19 37 Y-BR | 44 308
R.19 38 BR-Y 19 208
20 T.20 39 Y-SL 45 309
R.20 40 SL-Y 20 209
21 T.21 41 V-BL 46 310
R.21 42 BL-V 21 210
22 T.22 43 V-0 47 311
R.22 44 O-v 22 211
23 T.23 45 V-G 48 312
R.23 46 G-V 23 212
24 T.24 47 V-BR | 49 313

Continued on next page
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Port | Signal Cross-connect pin Color | Amphenol pin | Backplane pin
R.24 48 BR-V | 24 213

25 49 V/SL 50 314

50 50 SLIV 25 214
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Set Up and Use of
Customer Logins

This chapter provides information about the setup and use of customer logins:

= “Customer access” on page B-1I|

= [“Windows NT logins for the customer”|on page B-3

= [“NT login types for the customer”lon page B-3

« [‘Enabling Windows NT customer logins’|on page B-7

= [|“DEFINITY logins for the customer”|lon page B-9

= [“nstalling and configuring DSA on a workstation” [on page B-13

. |“Insta||ing DSA”|on page B-13

= |“Configuring DSA”|on page B-13

» [‘Downloading Message Manager” |on page B-13

Customer access

In DEFINITY ONE Release 2.0, the Lucent Access Control (LAC) module allows

access to a “shell” (=bash) using any valid Windows NT login. This enhancement
allows a customer to use a login, such as NTADMIN, to access Windows NT via a
“bash shell”. This feature is not intended to be used by Lucent Services person-
nel who continue to use the Lucent Services logins (lucentl, lucent2, lucent3).

In Release 1.0 the LAC module listened only on TCP port 23. A connection to this
port produced different results depending on the login used. For example, a
services login (lucentl, lucent2, lucent3) resulted in the “lac” prompt to select
DEFINITY, Audix, or a Bash shell. An alias login, such as donut, resulted in a
DEFINITY SAT screen without a LAC prompt. This continues to be supported in
Release 2.0, but is being deprecated in favor of the use of separate telnet ports
for direct access to DEFINITY and AUDIX.
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If the telnet session is established to TCP port 22, and the login has privileges to
access DEFINITY, a connection is made directly to a DEFINITY SAT without a
LAC prompt. If the caller logs off, the telnet session is terminated.

If the telnet session is established to TCP port 24, and the login has privileges to
access AUDIX, a connection is made directly to an AUDIX Forms Controller
administration screen without a LAC prompt. If the caller logs off, the telnet
session is terminated.

The same logins are used with ports 22, and 24, as well as 23. The difference is
that a direct connection is made to the appropriate application without a LAC
prompt or having to use an alias login.

See['System administration/DEFINITY site administration (DSA)”lon page 2-26.
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Windows NT logins for the customer

Several Windows NT login groups and associated logins are pre-installed for
customer use from the factory. See Table B-1.

The login IDs in the last two columns of Table B-1 are for customer use. The
following describes use and administration of these logins.

Table B-1. Windows NT logins

Logins for customer use

Windows NT

login group Default
User name password

Administrators NTadmin NTadminl

Guest - disabled | -- -

lucent -- --

officeadmin

officeuser

Power Users -- --

Users browse
vm
sa

1. To be administered
2. To be administered

A WARNING:
The logins in the Lucent group of Table B-1 are for the exclusive use of
Lucent Technologies Services personnel. These logins are established and
updated automatically by Lucent software. DO NOT ALTER THESE LOGINS
IN ANY MANNER. To do so may render the system unserviceable and may
require a partial or complete reinstallation of the software by Lucent
personnel.

NT login types for the customer

Administrator login
= NTadmin

This is a standard Windows NT administrator account used to administer
network parameters and similar functions.
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AUDIX logins

= browse

This login is used in the Voice Messaging application. See the INTUITY
AUDIX documentation or Table B-2 for a list of commands accessible to
the browse login. This login is disabled from the factory. It must be
enabled and a password chosen before it can be used.

= VM

This login is used in the Voice Messaging application. See the INTUITY
AUDIX documentation or Table B-2 for a list of commands accessible to
the vm login. This login is disabled from the factory. It must be enabled
and a password chosen before it can be used.

= Sa

This login is used in the Voice Messaging application. It has full customer
administration privileges. See the INTUITY AUDIX documentation or Table
B-2 for a list of commands accessible to this login. This login is disabled
from the factory. It must be enabled and a password chosen before it can
be used.

=>» NOTE:
The stand-alone INTUITY AUDIX system login “sa” normally produces
a menu. This feature is not supported on DEFINITY ONE. All logins
result in a Forms Screen interface.

Table B-2. AUDIX commands versus logins for sa, vm, and browse

Command Login

sa vm browse
add O U
audit O U
change O O]
copy U
display O O ]
exit 0 O 1
get O H
help O O ]
list ad 0 U

Continued on next page
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Table B-2. AUDIX commands versus logins for sa, vm, and browse — Continued

Command Login
sa vm browse
logoff O O 1
print O O |
remove O U
reset O
test O U i
toggle O O 1
trace 0 O 1

Customer Web access logins

The following login groups are used for web access:
« Officeadmin

Login IDs in this group are installed from the factory.This login group
facilitates access via the DEFINITY ONE web interface. Group members
select administrative privileges via the web interface. The NTadmin
account is used to establish an account in this group. Generally, an
account in the Offieceadmin group is used to download DSA from the
DEFINITY ONE Web page.

= Officeuser

Login IDs in this group are installed from the factory. This login facilitates
download of client software, such as Message Manager. Group members
have access for client download only. The NTadmin account is used to
establish an account in this group. An Officeuser group account is
generally used to download Message Manager from the DEFINITY ONE
Web page.

= anonymous

The anonymous login is for very limited access via the web interface to
load a software patch. See [Table B-2 JAUDIX commands versus logins”.
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Table B-3. Web access rights/officeadmin and officeuser access
Directory Use Login group Permissions
c:\LucentWeb\Public DEFINITY ONE anonymous read
Home Page officeuser read
officeadmin read
administrators full control
lucent full control
c:\LucentWeb\admin\audix\html | AUDIX networking HTML anonymous none
pages officeuser none
officeadmin read
administrators full control
lucent full control
c:\LucentWeb\admin\audix\cgi AUDIX networking cgi anonymous none
scripts officeuser none
officeadmin execute
administrators full control
lucent full control
c:\LucentWeb\admin\user\html Pages for non anonymous none
administrator users e.g. !
download officeuser read
officeadmin full control
administrators read
lucent full control
c:\LucentWeb\admin\user\cgi cgi scripts for non anonymous none
administrator users. e.g. )
download officeuser execute
officeadmin execute
administrators full control
lucent full control
c:\LucentWeb\admin\html Platform HTML pages anonymous none
officeuser none
officeadmin read
administrators read
lucent full control

Continued on next page
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Table B-3. Web access rights/officeadmin and officeuser access — Continued
Directory Use Login group Permissions
c:\LucentWeb\admin\cgi platform cgi scripts anonymous none
officeuser none
officeadmin execute
administrators execute
lucent full control
c:\LucentWeb\AdminAll\html Restricted html pages. anonymous none
e.g. activate pcAnywhere officeuser none
officeadmin none
administrators full control
lucent full control
c:\LucentWeb\AdminAll\cgi Restricted html pages. anonymous none
e.g. activate pcAnywhere officeuser none
officeadmin none
administrators full control
lucent full control

Enabling Windows NT customer logins

Only the Administrator can enable customer logins.

Activate pcAnywhere

1. On a DEFINITY ONE LAN workstation enable a web browser and the
DEFINITY ONE web page. Click Administer System on this web page
and login as NTadmin using the default password. On the administration

page click Activate pcAnywhere.

A pcAnywhere client must be installed on the workstation. This client may
be purchased from a local supplier or Symantec Corporation. Alternately,
a JAVA client may be downloaded from the DEFINITY ONE administration
page, the same page the pcAnywhere host is activated in step 1.

2. Activate the pcAnywhere client on the workstation.

3. Login to the DEFINITY ONE system, using the NTadmin account.
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Setup login accounts

1. Start the NT user manager on the DEFINITY ONE desktop. Click (Start >
Programs > Administrative Tools > User Manager)

2. Change the password for the NTadmin account.

3. Activate and set passwords for the browse, vm, and sa accounts. This
also can be done via the command line tool net user. See[“Lucent access|
[controller bash commands”|on page G-1

4. Create three Windows NT accounts in the Officeadmin group for three
application administrators. These accounts are used to download DSA
software. The account names can be chosen as desired. For this example
they are called D1userl, D1luser2, and D1user3.

5. Create one Windows NT account in the Officeuser group for download of
the INTUITY Message Manager Software.The NTadmin account should be
used for NT administration only. The account name can be chosen as
desired. For this example it is called D1WEB.

6. Disconnect from pcAnywhere.
=>» NOTE:

The NTadmin account can be used for download, but should be used for
NT administration only.
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DEFINITY logins for the customer

In addition to the logins maintained in the Windows operating system, there are
customer level logins within the DEFINITY application that do NOT appear as
Windows logins. The default password should be changed by the customer
during installation.

Table B-4. DEFINITY customer logins

DEFINITY Default
customer logins Comments password
deftyl This is the customer level “super user”

login within the DEFINITY application. Its
use should be restricted to the system
administrator. This login can be used to
create additional DEFINITY logins. See the
DEFINITY command add login.

Release 2.0 provides enhanced login/password security by adding a security
feature that allows users to define their own DEFINITY logins/passwords and to
specify a set of commands for each login.

» The system allows up to 14 simultaneous connections (logins) to
DEFINITY ONE. (DEFINITY can have 5 connections, AUDIX can have 4
connections, and the rest of the connections are reserved for shell
commands.)

= Each DEFINITY ONE login name can be customized

— Logins must be 3 to 6 alphabetic/numeric characters, or a
combination of both.

— A password must be from 4 to 11 characters in length and contain
at least 1 alphabetic and 1 numeric symbol.

Password aging is an optional feature that the super-user administering the
logins can activate (see below).

=> NOTE:
If several users are logging in and out at the same time, a user may see the
message: Tr ansi ent command conflict detected; please try
| at er. After the “users” have completed logging in or out, the terminal is
available for use.
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Forced password aging (DEFINITY-specific)

Forced password aging operates as follows:

» The password for each login can be aged starting with the date the
password was created, or changed, and continuing for a specified
number of days (1 to 99).

» 7 days before the password expiration date, the user is notified that the
password is about to expire at the login prompt.

= When the password expires the user is required to enter a new password
into the system before logging in.

» Ifaloginis added or removed, the “Security Measurement” reports are not
updated until the next hourly poll, or a clear measurements
security-violations command is entered.

= Once a non-super-user has changed the password, the user must wait 24
hours to change the password again.

Logoff notification (DEFINITY-specific)

Security is enhanced by providing a logoff natification screen to a system admin-
istrator at log off while either the facility test call or remote access features are still
administered. The administrator can be required to acknowledge the notification
before completing the logoff process. Logoff notification is administered on the
Login Administration screen.

Super_User (DEFINITY)

Lucent delivers Release 2.0 of DEFINITY ONE to the customer with one customer
“super-user” login/password defined. The customer administers additional
login/passwords as needed. The super-user login has full customer permissions
and can customize any login created.

Login permissions for a specified login can be set by the super-user to block any
object that may compromise switch security. Up to 40 administration or
maintenance objects commands can be blocked for a specified login id.
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Administer login command permissions

Users with super-user permissions can set the permissions of logins they create
by performing a change permissions <login-name> command. This causes the
Login Permissions form to display. The Login Permissions form allows the user to
control access to various categories of commands for a given login. It also per-
mits restricting access to objects (forms) on an individual basis for up to 40
objects. Restricting an object means that no commands may be performed on
that object by that login (add, change, remove, etc.) The three main categories of
commands are:

= Common Command
= Administration Commands

» Optional Maintenance Commands

Each category of commands has sub-categories that, when set to y, allow
access to objects associated with that sub-category. If the category is set to n.
the user is not be able to add, remove, or change commands on objects under
that sub-category. If the display category is y, the login will list or display the
object in most cases. If the super-user wants to restrict access to all commands
associated with an individual object in a subcategory, the Additional Restrictions
field is set to y. This causes 2 additional pages to be added to the permissions
form. Scroll these pages and press Help. Individual objects will be displayed in
alphabetical order. Enter the object that you want to restrict access to into the
fields and submit the form. Up to 40 objects may be restricted. A restricted login
cannot access any of the commands associated with that login. Note that
permissions cannot be changed for the login and you cannot create Additional
Restrictions without full super-user permissions.

DEFINITY commands for user login

DEFINITY commands refer to the set of commands that execute under the
DEFINITY application running on the ProductName system platform and which
can be accessed through the SAT session or the DEFINITY Site Administration
application.

These commands are grouped into three command categories. Each of the three
command categories has a group of command subcategories listed under them,
and each command subcategory has a list of command objects that the
commands acts on. A super-user can set a user’'s permissions to restrict or block
access to any command in these categories. These categories are displayed on
the Command Permissions Categories form. The three main categories are:

» Common Commands
— Display Administrative and Maintenance Data

— System Measurements



DEFINITY ONE™ Communications System Release 2.0 Issue 2

Installation and Upgrades 555-233-109 June 2000
Set Up and Use of Customer Logins
DEFINITY logins for the customer B-12

= Administration Commands
— Administer Stations
— Administer Trunks
— Additional Restrictions
— Administer Features
— Administer Permissions
= Maintenance Commands
— Maintain Stations
— Maintain Trunks
— Maintain Systems
— Maintain Switch Circuit Packs

— Maintain Process Circuit Packs

Password expiration

If your password has expired, the following message displays:

/

Login: tel ngr

Passwor d:
Your Password has expired, enter a new one.

Reenter Current Password:

New Passwor d:

k Reent er New Passwor d: /

Figure 10-1. Password expiration screen

If your password is within 7 days of the expiration date, the following message
displays:

WARNI NG Your password will expire in X days

Tableb4 moveb
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Installing and configuring DSA on a
workstation

Installing DSA

An Administrator only can download DSA.

Steps required to obtain DEFINITY Site Administration (DSA) software from the
system are:

1. On a workstation enable a web browser and the DEFINITY ONE web
page. Click Administer System and then login as NTadmin using the
appropriate password. On the administration page, click Download
Software.

2. Onthe Web page, click the selection to download DSA. Select a directory
to save the self extracting file to be downloaded. Place the file in any
temporary directory.

3. When download completes, close all applications and double click the
downloaded file to execute.

4. Follow the screen prompts to complete installation. DSA will install an icon
on the desktop.

Configuring DSA

See['Configure DSA”|on page 7-7 for instructions to configure DSA. When
prompted for logins, use your customer logins where appropriate - vm, sa, or

browse for AUDIX and deftyl or other DEFINITY customer accounts for
DEFINITY.

Downloading Message Manager

The steps required to obtain the INTUITY Message Manager software from the
DEFINITY ONE system are as follows:

1. Onthe desktop where Message Manager is to be installed, activate your
favorite browser and bring up the home page for the DEFINITY ONE
system.

The name or IP address of the DEFINITY ONE system must be obtained
from the administrator of the customer’s network where DEFINITY ONE is
installed.

2. On the DEFINITY ONE home page, click User Services.



DEFINITY ONE™ Communications System Release 2.0 Issue 2

Installation and Upgrades 555-233-109 June 2000
Set Up and Use of Customer Logins
Downloading Message Manager B-14

3. When prompted for a user ID, type DIWEB and use the password
supplied by your system administrator.

Holders of more privileged accounts may also use their IDs, for example,
NTADMIN, Dluserl, etc.

4. Click Download Message Manager.
This down loads a self-extracting file to the desktop.

5. When download is complete, exit all applications on the desktop and
double click the downloaded file.

6. Follow the prompts to complete the installation. See|“Installing Message]
[Manager from a LAN server”|on page 8-14.
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Miscellaneous Procedures

This following provides the procedures used in the installation process.

= Connectivity

— |“Connect the laptop computer to DEFINITY ONE”|on page C-2

— |“Verify the connection from DEFINITY ONE to the laptop computer”|
on page C-11

— |“Restore the laptop settings”|on page C-12

— |“Map DEFINITY ONE to the laptop computer's CD-ROM drive”’|on
page C-13

[“Setting the name of the switch”|on page C-15

= [“Connect to SAT session via Telnet”’|on page C-16

= Backup and Restore

— |“Perform backup’|on page C-18

— [“Backup via the Web interface”|on page C-20

— |“Backup and restore main menu”|on page C-23

— [“Perform immediate backup”lon page C-23

— [“Viewing backup progress”lon page C-25

— [“Backing up to a LAN address”|on page C-25

— |“Viewing scheduled backups”|on page C-27

— |“Adding a new scheduled backup (multiple backup schedules)” on
page C-27
— [“*Accessing backup information”|on page C-28

— [“Perform restore”|on page C-29
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Connect the laptop computer to DEFINITY ONE

Connect the laptop computer to

DEFINITY ONE
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C-2

The technician’s laptop computer (referred to as “laptop”) connects to the
DEFINITY ONE system via a PCMCIA card in the TN795 circuit pack. The laptop
computer requires the following equipment:

Table C-1. Required technician’s laptop equipment checklist

Part number Description Quantity
Laptop computer with PCMCIA network 1
interface card (NIC) running Windows 95/98
3CCFE575BT PCMCIA NIC with RJ45 connector for 1
(cabled version, DEFINITY ONE
hasan RIS on | o000 0de 408276897
end of cable) or
3CXFE57B5T(X
jack)
Cable assembly to connect NICs: 1
» D8W cable
» RJ45 coupler (BRIA4P)
848477634 » RJ45 crossover cable (approx.12 feet)
=>» NOTE:

When changing information, ensure both old and new information is
recorded. The DEFINITY ONE system, configured at the factory, serves as
an endpoint of a private LAN with a PC.

A warRNING:

The “3COM Megahertz 10/100 LAN CardBus” PCMCIA card must be used.
Other types of cards do not work. This card has either part number
3CCFE575BT or 3CXFE575BT, depending on the cable arrangements. In
addition, a special crossover cable, comcode 848477634, must be used.

See
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cydmiap KLC 051499 L =

Figure Notes

1. Laptop computer 5. RJ45 crossover cable
2. PCMCIA NIC 6. PCMCIA NIC (3CXFE575BT shown)
3. D8W cable 7. RJ45 connector

4. RJ45 coupler (BRIA4P)

Figure C-1. Laptop connectivity
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Install the ethernet card

1. Ensure the laptop power is off.

2. Insert a PCMCIA ethernet card into the laptop.

=>» NOTE:
The ethernet card can be any brand or model desired. A card with
100 Megabit capability provides faster response.

3. Insert a 3COM Megahertz 10/100 LAN CardBus Network Interface Card
into the PCMCIA slot of the DEFINITY ONE system. Itis NOT necessary to
power down the DEFINITY ONE before inserting the PCMCIA disk card.

=—>» NOTE:

If you will be performing backup procedures, insert a new PCMCIA
card in the free slot in the TN795 circuit pack. Do not unplug the
flash disk.

4. Using the RJ45 crossover cable, an RJ45 coupler (BRIA4P) and a D8W
cable, connect the 3COM card in the TN795 circuit pack to the Ethernet
card in the laptop. See|Figure C-1.

=>» NOTE:
The green LED on the 3COM Megahertz 10/100 LAN Card Bus PC
card in the TN795 circuit pack should be lit, indicating physical
connectivity. If neither of the 2 LEDs is lit, there is an open circuit
between the laptop and DEFINITY ONE. The top LED on the 3COM
NIC indicates a 10-Mbps connection speed. The bottom LED
indicates al00-Mbps connection speed.

5. Power up the laptop and start Windows 95 or 98.

Configure the PCMCIA ethernet client on the
laptop

1. Right click Network Neighborhood to configure the network PCMCIA
interface to communicate to the DEFINITY ONE system.
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A menu similar to the following displays:

Open
Explore
Eind Computer...

b ap Metwark Drive. ..
Digconnect Metwark Drive...

Create Sharkcut
Rename

Froperties

=>» NOTE:
The following details are for a specific version of Windows 95. Other
system versions may have screens that are slightly different.

2. Click Properties.
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A similar screen displays:

I Network EE |

Configuration I Identificatiu:unl Access EDntru:uI'

The fellowing hetwork components are installed:

i~ NetBEI -> Dial-Up Adapter Al
[ NetBEUI -» Network of #ircom CraditCard 10/100+Moden

W TCRAP -» Dial-Up Adapter
FY_ TCRAP = MNetwork, o com CreditCard 10/100+M odem
s File and printer zharing for Microzoft Metworkz

Add. Remove I Propertiez |

Frimary Metwork Logon:
IEIient for Microzoft Metworks j

File and Print Shating... |

Deseription

TERPAR iz the protocal you use to connect to the Intermet and
wide-area netwarks,

(] Cancel

Issue 2
June 2000
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3. Click the Identification tab.

A similar screen displays:
Metwork

Configuration  |dentification l.i‘-.l:cess I:l:untrl:ull

EJ Windows uzes the following information to identify paur

=) computer on the network,. Pleaze type a name for thiz
computer, the warkgroup it will appear in, and a short
description of the computer.

Computer name: |teu:h'||

Whorkgroup: |$ervices

Cornpriter

Dezcrption: |SEWiEES laptop

Ok | Cancel

4. Record the Computer name and Workgroup entries but DO NOT click OK.
These are techl and services in the above screen. This information is
needed for certain operations, such as software installation.

=>» NOTE:;

The technician’s laptop is set up with the Computer name “CSE” and
the Workgroup “OEM.”

5. Click the Configuration tab.
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A similar screen displays. The contents of this screen varies, depending
on the configuration of the laptop. Select the entry corresponding to the
PCMCIA Ethernet card inserted in step 1 of[Install the ethernet card”|on

page C-4.
Metwork

Configuration l Identificatiun] Booess I:l:untrl:ull

The following network, components are installed:

B Client for Microsoft Metworks

88 2Com Etherlink [I| PCMClA (305894305398
&8 »ircom CreditCard Ethernet Adapter 104100
& TCP/IP -» 3Com Etherlink 111 PCMCIA [3C589/3C5898)
h’_ TCPAP -» Hircom CreditCard Ethernet Adapter 104100

| Add... Bemove | Properties |

Prirmary Metwork Logon;
|Windaws Lagan ﬂ

File and Print Sharing... |

Description

TCF#P ig the protocol pou use to connect ta the Intermet and
wide-area networks.

Ok Cancel

6. Click File and Print Sharing to make file and print sharing active.

7. A similar screen displays:

File and Print Sharing

[V | weant to be able to give others access bo my files.

[ | wart to be able to allow athers bo print b my printes].

Cancel

Check the box: | want to be able to give others access to my files.
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8. Click OK.

Return to the following screen:

Issue 2
June 2000

C-9

Metwork |

Configuration | Identificatinnl Access I:Dntr-:ull

T he following netwaork, components are installed:

Client for Microzoft Metworks

| Add... I Hemowve

S8 3Com Etherlink 11l PCMCIA [3C539/3C589E)
=8 ircom CreditCard Ethemet &dapter 104100
& TCPAP - 3Cam Etherlink 111 PCMCLA [3C589/3C539E)
“_ TCPAP -» #ircom CreditCard Ethernet Adapter 104100

FProperties |

Prirmary Metwark, Logon;

IWindDws Lagan

Eile and Frint Sharing... |

[

Drescription

TCPAP iz the protocol you use bo connect ta the [nternet and

wide-area netwarks.

Cancel

If the “Windows Logon” is not the Primary Network Logon, click the
pull-down menu for the Primary Network Logon and select Windows

Logon.

=>» NOTE:

Before continuing, record the current settings under the Access Control
tab. This information is needed to restore the laptop after work is completed

with DEFINITY ONE.

9. Click Access Control

10. Ensure that Share Level Access Control is selected.

11. Click OK.

If a warning screen displays: Do you want all connections to shared
directories disabled, select Yes. The connections will be restored following

a restart.
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12.

13.

14.

15.

16.
17.

A screen displays: Do you want to restart your computer now. Select No.

Right click on Network Neighborhood and select Properties to return to
the Network screen.

Select TCP/IP Xircom CreditCard Ethernet Adapter 10/100.
Click Properties.
A similar screen displays: Click the IP Address tab.

TCFP/IP Properties
Bindings ] bAdvanced ] DMS Configuration ]
[3 ateway ] WIS Configuration IP Address

An IP addregz can be automatically azsigned ko this complter.
|f wour netwark, does not automatically azzian 1P addreszes, aszk
wour network, adminigtrator for an addrezz, and then tppe it in
the zpace below.

" Obtain an P address automatically

+ Specify an IP address:

IFéddess: (192,11 .13 . 5 |

Subnet Mask: | 255 . 255 . 255,252 |

| k. | Cancel

Record each tab before proceeding.

This information is needed to restore the laptop to its current settings once
work with the DEFINITY ONE system is completed.

Ensure that Specify an IP address is selected. Type 192.11.13.5 as the IP
Address and 255.255.255.252 as the Subnet Mask.

Click on the DNS configuration tab. Click the Disable DNS radio button.

Click on the WINS configuration tab. Click the Disable WINS Resolution
radio button.
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18. Click on the Gateway tab. If a gateway is shown, record the gateway
number. Highlight the gateway and select Remove.

19. Click OK here and in the following windows.

A similar screen displays:

I System Settings Change |
Iri{) “'ou muzt restart pour computer before the new zettings will take effect.
E -

Do you want bo restart vour computer now?

20. Click Yes to restart your computer.

21. When the laptop reboots, verify that it is now connected to the DEFINITY
ONE system. See["Verify the connection from DEFINITY ONE to the laptop|
|[computer”|on page C-11.

Verify the connection from DEFINITY
ONE to the laptop computer

1. Start a DOS shell on the laptop by clicking Start > Programs > MS-DOS.
2. In the DOS window type ping 192.11.13.6 and press (ENTER).

A series of four similar replies indicating successful response should
display:

Reply from 192. 11. 13.6 bytes=32 ti nme=1lns TTL=128
Reply from 192. 11. 13. 6 bytes=32 tinme=1lns TTL=128
Reply from 192. 11. 13.6 bytes=32 tinme=1lns TTL=128
Reply from 192. 11. 13.6 bytes=32 tinme=1lns TTL=128

3. If atimeout reply displays, check cabling or review the previous setup
steps. Also verify that DEFINITY ONE is operating normally and
referencing the LEDs on the front panel of the TN795 circuit pack. See
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Restore the laptop settings

This procedure restores the settings on the technician’s laptop computer to their
state prior to connecting to the DEFINITY ONE system.

1.

Right click Network Neighborhood. Select Properties.
A dialogue box titled Network displays.

Click the Configuration tab on the File and Print Sharing button. Check “I
want to be able to give others access to my files.”

Click the pull-down menu for the Primary Network Logon, and select
Client for Microsoft Networks.

3. Click the Identification tab and enter the Computer name and workgroup.

Click the Access Control tab and check the appropriate boxes so that this
screen matches its earlier settings.

Click the Configuration tab.

» If a dialog box appears notifying you that the security provider
could not be found, click Yes.

» Ifa dialog box called “Authenticator type” appears, select
Windows NT Domain, and click OK.

Double click the modified component in the List Box, “The following
network components are installed”. This should be the TCP/IP Xircom
CreditCard Ethernet Adapter 10/100.

. The screen TCP/IP Properties displays.

Enter the original IP address and subnet mask.

9. Click the DNS Configuration tab to enable DNS. Enter the appropriate

10.

11.

12.
13.

information.

Click the WINS Configuration tab to enable WINS. Enter the appropriate
information.

Click the Gateway tab (if a gateway was used) and enter the appropriate
information.

Click OK to close the TCP/IP dialogue box.

A screen displays: Do you want to restart your computer?. Click Yes.

When rebooted, the laptop returns to its original settings.
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Map DEFINITY ONE to the laptop computer’'s CD-ROM drive

Map DEFINITY ONE to the laptop
computer’s CD-ROM drive

1. On the laptop, double click My Computer. Right click the CD-ROM drive
icon.
2. Select Sharing from the pop-up menu. The following screen displays:

01_0_031_0 [D:] Properties i

General  Sharing ;

Share Marne: iCDHDM

Lomment; I

Access Type:
" Read-Only
f« Full
" Depend: on Password

i Passwnrd: I

xxxxxxx

Passwords:

Fead!

Full Access Pazzword: I

QK ; Cancel l G 1

3. When the screen displays, the default Not Shared will be selected. Click
Shared As and enter a Share Name. Click Full beneath Access Type.

This enables a Full Access Password text box at the bottom of the screen.

4. Enter a password in the above text box.

=> NOTE:

A password is needed to map the network drive from DEFINITY ONE
back to the laptop.
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5. Click Apply to display the password confirmation screen. The following
screen displays:

Password Confirmation

|
Please reenter your passwords to canfirm they are comect,

Cancel

i~ Paszwords:

' Read-Only Pazsword: i

i
{ Full Acceszs Pazaward: 1“’“‘““

6. Click OK on the CD-ROM sharing screen in the Properties dialogue box.
The CD-ROM drive is now shared. The following procedures describe how to
map the CD-ROM drive from DEFINITY ONE to the laptop.

1. Establish a pcAnywhere connection from the laptop to DEFINITY ONE.

2. On the DEFINITY ONE desktop, right click My computer and select Map
Network Drive on the resulting pop-up window. The following screen

displays::

Map Metwork Drive

Dive o [

Carizel

Path:

Help

ddi

Connect Aa:

[+ Beconnect at Logon

Shared Directories:

;{‘(5 Microzoft Windows Metworl,
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3. Select the drive letter indicated or a new one on the Map Network Drive
screen. In the Path field, enter \\xxxx\CDROM where xxxx is the name of
the laptop (noted in an earlier procedure). When shared, the CD-ROM is
the applicable share drive.

Leave the Connect As field blank. Click Reconnect to deselect the login.

5. Click OK. The following dialogue box displays, prompting for login and
password information:

| Enter Network Password
Incarmect password or unknown usemname far:
YWCSESCDRORM Cancel |
Caonnect Az I Help |
Paszsword: I”’1
6. Click OK.

A DEFINITY ONE drive (Drive E in this case) is mapped to the laptop’s CD-ROM
drive.

Setting the name of the switch

Setting the NT name

To set the machine name, in a bash shell, type setip name=machineName. Limit
the machine name to 10 characters. Setip will allow you to enter more charac-
ters, however AUDIX only displays the first 10 characters of the machine name in
its administration window.

Ex: setip name=mysite

After setting the machine name, the setip command displays both the old and
new settings.

Reboot the DEFINITY ONE. Enter reboot nice from a console bash shell.

Updating AUDIX machine name

1. Once NT reboots, Update AUDIX. Enable the DEFINITY ONE web page
using a browser. Click the Administer System hot link. The web page
prompts for login and password. Use the lucent3 login with the new
password supplied by INADS.
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2. Click the AUDIX Networking link. Click the Administrative Menu link after
the page loads. Click the Local Machine Administration link to load the
Local Machine Administration web page. Click the change button in the
middle of the page for AUDIX to re-populate its databases with the current
settings.

3. Exit the web pages and restart AUDIX.

Restarting AUDIX

Enable a telnet session to a LAC bash shell on DEFINITY ONE. Execute a shut-
down AUDIX command at the shell prompt. Select start AUDIX when shutdown
completes. When AUDIX restarts it recognizes the new machine.

Change system name

1. When the system is up, enable a DEFINITY SAT session, using either
telnet or DSA. Login as dinit (lucentl will grant the same permissions) with
the appropriate password.

2. Enter change system-parameters features. On page 4, change the switch
name to match the NT and AUDIX switch names.

Connect to SAT session via Telnet

This method of access is used primarily by technicians who use one of the ser-
vices logins. This connection type will access a SAT emulator to administer and
maintain the DEFINITY ONE.

1. Enter a command to continue after admittance in to the DEFINITY ONE
system. See|"Via a Telnet session”Jon page 2-16. In this example, the

2 1 elnel - Wndh

Commecl Edil Temna Help

Login: lucEnt3
challenge: 183-9616
REspoOnse: 2697369
ENTEr Command:
Laudix bash | omd | definizy | help | exit)
L =]

command entered was definity. The next screen shows the initial
DEFINITY SAT screen

2. Enter the terminal type.
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= Telnet - bosnia = ]|
LConnect  Edit Temminal Help

Login:

Password:

System: G3cfsUB Software Version: G3VU8c.00.8.587.8

Terminal Type (513, 715, 4418, 4425, UT228, NTT, SUNT): [513]

The screen shows login and password fields. You are automatically
logged in to the DEFINITY SAT session by the LAC.

=>» NOTE:
Two new terminal types have been added: NTT and SUNT.
= Use NTT from a Windows platform.
= Use SUNT from a Sun Microsystems platform.

The following screen displays when the terminal type is entered:

Lonneci Edt Jemnal Help

This SysTem 15 restricted To authorized users

ror Eg'L'MQTE bus iness PJ"UZ$E5- T ETT s
accEdd f3 a oriminal violacion of the law.
Copyright {c) 1862 Lucent Technologies

UnpubTished & Mot for Publication

& Rights Reserved

Once you are logged in as user lucentl, lucent2, or lucent3, you can exit the
DEFINITY SAT session and start an AUDIX session without having to
re-authenticate.
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Perform backup

Backup procedures prevent loss of data due to system errors. Backups can be
either immediate or scheduled. You can execute backup procedures to either the
LAN or the PCMCIA flash card from the command line and web browser.

Insert a PCMCIA card into the free slot on the TN795 circuit pack. For alternative
backup, obtain a network location from the customer. The following are bash
shell procedures when using a LAN resident PC that is not DEFINITY ONE but is
connected to the same LAN as DEFINITY ONE.

Click Start > Run from the Windows task bar. The Run dialog box displays:
Run EHE

E===l . Type the name of a program, folder, or document, and
Windows will open it for you,

Open: [telnet 155.132.119.101 =]
¥ Fiumin Separate Memon Space

(] I Cancel | Browsze. .. |

1. Enter telnet {DEFINITY ONE Name, or IP Address}. Click
OK.

2. Atelnet session opens on the desktop. Enter the login and
challenge response at the prompts.

- Telnet - wind5

Cornect  Edit Temingl Help

Login: lucentd
Challenge: 523-629%
Response:
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Once the Lucent Access Control (LAC) process accepts your inputs, it
grants admittance to the DEFINITY ONE system.

- Telnet - Winds

Connect  Edit Temminal Help

Login: Tucent3
Challenge: 183-9616
RESpONSE: 2697369
Enter Command:
Laudix | bash | cmd | definity | help | exit]

Lac =

3. Type bash and press (ENTER).
The machine name and login ID displays as your prompt.

OR:

At a DEFINITY ONE desktop, log in to Windows NT. Click Start > Run from
the Windows task bar. The Run dialog box displays.

Run !

Emwml  Type the name of a program, folder, or document, and
Windows will apern it far pow.

Open: II:uasH j

¥ | B in Separate M emon Space

0k, I Cancel | Browsze. . |

1. Enter bash and click OK.

2. Atelnet session opens on the desktop. Enter User Name and
Password.

The DEFINITY ONE system grants admittance once inputs are accepted.

3. Type dlbackup <data-set> <destination> and press
(ENTER).
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4. Enter one or more of the following parameters (separate
multiple choices with a space) for backup:

Parameter Meaning

deftran DEFINITY Translations

vmnamtran Voice Names and Translations

vmmsgtran Message Bodies and Translations
vmannounce Announcement Sets

vmnammsgtran Voice Names, Messages, and Translations
registry NT registry

sam NT Passwords Login and Policy

defann DEFINITY Announcements

lac Password and License Server File

The destination is pcmcia or a directory name.

If a directory name is entered, a network drive must be mapped as the F:
drive. Use the web interface to map a network drive.

The following is an example of how to enter information for backup
procedures:

LAC:> d1lbackup deftran vmnamtran pcmcia
=>» NOTE:
When executing this command, there may be a delay of 1 to 2

minutes because AUDIX Networking is shutting down and auditing
the AUDIX databases. AUDIX restarts when the backup completes.

Backup via the Web interface

The following are web interface procedures:
1. Open Internet Explorer.

2. Enter http://<IP address> in the address area of the web browser.
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The DEFINITY ONE Home page displays:

Lucent Technologles 6
Beil Labs Innowat o -

DEFINITY ONE™ Communications Sysfem

The singie solution for
your smaii business needs.

Home

Administer
cystem DeriniTy ONE provides you with
a high functionality, cost
effective system enabling you to
meet your current business
challenges head on while
providing the infrastructure to
bridge you to future
opportunities.

User Services

3. Click Administer System.
The following screen displays:

Username and Pazsword Required E3

Enter uzermame for august. dr. lucent. com at
auguzt. dr.lucent. com:

Uzer Mame: ||

Paszword: I

Ok I Cancel I

4. Enter your login ID and password.

The login ID must have the correct backup permissions and be a member
of the DEFINITY ONE Administrator’s login group.

The following displays:
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Home

Administer
System

User
Services

Download
Software

5.

Home

Administer
System

User
Services

Download
Software

NOTICE:
By use of this system, you accept the terms and conditions of the license
agreements for all third party software included with this product. Failure to
comply with these agreements could result in legal action by the third party
vendor(s).

This product is designed for the use of authorized Lucent Technologies
products only. Use of this systern for any other third party applications is
strictly prohibited and will result in the nullification of Lucent Technologies
warranty and post warranty obligations.

This system is restricted to authorized users for legitimate business

purposes. Unauthorized access is a criminal violation of the law. Copyright
{c) 1992 - Lucent Technologies Unpublished & Mot for Publication

[T Don't show this message again

Continue |

Click Continue.

The following screen displays:

System Administration

« DEFINITY ECS on Albania o The first two links will work only
« |Ntuity AUDIX on Albania if you have already installed

=« Default AUDIx Setlings DEFINITY Site Administration

u AUDIK Networking onyour computer.

System Maintenance Click on the

= Backup & Restore Doz Soffware link

s Shutdown or Restart Albania at the left to install

Remote Control - pcAnywhere DEFINITY Site Administration .

u Start Host Service on Albania
s Stop Host Service on Albania
« Start Java Client on your computer

Click Backup and Restore to open main backup menu.
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Backup and restore main menu

Home

Administer
System

User
Services

Download
Software

s Immediate Backup » Last scheduled backup results
s Scheduled Backups « Contents of backup location
s Restore

From the backup and restore main menu, you can:

Perform immediate backups

Schedule multiple backups

Restore backups

Access last scheduled backup information

View contents of backup location

=—>» NOTE:

As you navigate the backup and restore screens, the main menu items
remain available. Use the Back button to return to previous screens.

Perform immediate backup

To perform an immediate backup, click Immediate Backup.

The|[following screen| displays:

Issue 2
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s Immediate Backup » Last scheduled backup results
s Scheduled Backups « Contents of backup location
« Restore
Home Choose items for immediate backup
¥ DEFNITY announcerments
Administer r DEF|N|TY_TransIaT|on files Warning: Before
System [T NT Registry starting this hackup
[T NT passwords & policies operation, any previous
User T LAC password & license server files backup data from the

aEsinaioy will be
erased.

! UDIX announcements

0 AUDIx translations & messages
Download ' AUDIx trans, names & messages
Software € AuDIx translations & names

€ AuDix translations

€ noneg from AUDIx

Destination: |pcmcia 'l 3 Other locations

Services

1. From the Destination menu, select a backup destination.This can be a
LAN address or a PCMCIA Flash Disk

2. Select items for immediate backup.
3. .Click Backup.
=>» NOTE:

When backing up to a LAN address, a shared drive must be installed on a
non- DEFINITY ONE machine.

After you click Backup, the following screen displays:

s Immediate Backup » Last scheduled backup results
s Scheduled Backups « Contents of backup location
s Restore

Home

Backup in progress
Administer ¥ Cancel backup
System

User 2 | View backup progress.
Services

Download
Software
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Viewing backup progress
To view backup progress, click View Backup Progress.

The following screen displays:

s Immediate Backup » Last scheduled backup results
s Scheduled Backups « Contents of backup location
s Restore

Home

Backup in progress
Administer ¥ Cancel backup
System

User Backup in progress. please wait Thu Mar 02 10:12:23 2000
Services

Download
Software For dest = pcmcia, check that PCHCIA card is plugged in and sane.

Check permissions on the pemcia drive (e:)

For a destination that is not a poweia driwve, check that the £: driwve
iz mapped to the network.

Check permissions on mapped network drive (£ drive).

Backing up to a LAN address

You can back up your data to a LAN address using the Other locations feature.
To back up data to a LAN address:

1. Click Other locations.

s Immediate Backup » Last scheduled backup results
s Scheduled Backups « Contents of backup location
s Restore

Home Choose items for immediate backup

I DEFINITY announcaments

Administer r DEF|N|TY_TransIaT|on files Warning: Before
System I NT Registry starting this backup

[T NT passwords & policies operation, any previous
hackup data from the
dastiraton will be
erased.

User
Services

0 AUDIx translations & messages

Download 0 AUDIX Trans, names & messages -
o Backup

Software € AuDIx translations & names -

€ AuDix translations

€ noneg from AUDIx

Destination: |pcmcia 'l 3 Other locations

Click Other locations.
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Home

Administe
System

User
Services

Download
Software

Home

The following screen displays:

s Immediate Backup » Last scheduled backup results

s Scheduled Backups « Contents of backup location

s Restore

example
Enter security information to -
. Ci | 2
r make a new network drive SRS e nere

available for Backup and - Ibk— bidli
Restore operations. arename - [aackup u

Populate each field as shown ~ Domain | drntdomain

inthe awsmed column. Do
not include any extra Username Jjoe kfc
characters like backslashes.

The Jornger field may be Password |“°“°"

left ernpty if the computer

does not participate in a

domain.

2. Enter LAN location information.
3. Click Verify.

The following screen displays:

s Immediate Backup » Last scheduled backup results
s Scheduled Backups « Contents of backup location
s Restore

The security information that you have entered has been verified.

Administer

System

User
Services

Continue

Download
Software

4. Click Continue to return to the Immediate backup screen.

5. Select items to back up and select Backup.

The backup and restore operations now have access to the shared network drive.
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Viewing scheduled backups

To view scheduled backups:

1. Click Scheduled Backups.

Home

Administer
System

User
Services

Download
Software

The following screen displays:

s Immediate Backup » Last scheduled backup results
s Scheduled Backups « Contents of backup location
s Restore

Current list of scheduled backup jobs

Data Set Destination Days  Time
= DEFINITY announcermeants pcmcia Th 6:00
= AUDIX announcements

= DEFINITY annauncements funisat2fbackup Th 8:00

= AUDIX announcements

Issue 2
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1 Add new schedule b - edit - delete

This feature is currently enabled . [ enable H disable

From this screen, you can add, edit, or delete scheduled backups.

Adding a new scheduled backup
(multiple backup schedules)

To add a new scheduled backup to the list:

1. On the Current list of scheduled backup jobs screen, click Add new

schedule.

The following screen displays:

Home

Administer
System

User
Services

Download
Software

s Immediate Backup » Last scheduled backup results
s Scheduled Backups « Contents of backup location
s Restore

Adding a new backup schedule

Backup these items Every At

I DEFNITY announcements r [o8T=] [o0 =] [am =]
W DEFNITY translation files r

[T NT Registry r

[T NT passwords & policies r

[T LAC password & license server files
' AUDIX announcements

0 AUDIx translations & messages

& AuDIx trans, names & messages
 aupix translations & names
© Aupix translations

' none from Aubix

Destination: |pcmcia 'l 3 Other locations
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2. Select backup destination either to a LAN address or a PCMCIA Flash
Disk.

3. Select items for scheduled backup.
4. Select a day and time for the backup.
5. Click Submit.

Accessing backup information
To review previous backups, click Last scheduled backup results.

The following screen displays:

=« Immediate Backup s Last scheduled backup results:
s Scheduled Backups « Contents of backup location
« Restore
Home Results of last scheduled backup
Administer Destination
System
User_ Items backed up File Size Time started
Services
Download Time finished

Software

To view contents click Contents of backup location.

The following screen displays:

s Immediate Backup » Last scheduled backup results
s Scheduled Backups « Contents of backup location
s Restore

Home Display current backup contents in |pcmcia x| | Display |

Administer

.-"nisatZ,-"b ackup
System e

erlocatons

User
Services

Download
Software

Scroll to the location of backup contents and click Display or click Other
locations.
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The following screen displays:

= Inme diate Backup u Last scheduled backup results
o Scheduled Backups o Contents of backup location
= Bestore
Home Cwrrent Contents of Backup in pemeia
Mame Zire Created

Administer
System

User Services

Download
Software

=>» NOTE:

The backup feature can be disabled and later enabled to allow you to
perform another function. If disabled, the current schedules remain intact.

Perform restore
1. Click Restore.

The following screen displays:

= Inme diate Backup u Last scheduled backup results
o Scheduled Backups o Contents of backup location
= Bestore

Home Choose items to restore

[ DerFpaTY announcements g
Warning:

Administer Dmmn{ translation files —
1 e NT Eegistry applications will be
NT SaM database stopped as part of
User Services LaC password & license server files i e
operation.

AUDDE annhouncements

Avpne translations & messages Clear Fields |

AUDDE trans, names & messages
Avpne translations & names

. Restore
Avpne translations —l

none from Avnoe

Source: IpCmCia 'l 5 Other locations

Download
Software

o e e Bie e e S M M S

2. Select the restore source.

3. Select items to restore.
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4. Click Restore.

The following screen displays:

Home
Restore in progress ...

Administer
System

User Source: pcmcia

Services

Download % | View restore progress.
Software

Issue 2
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s Immediate Backup » Last scheduled backup results
s Scheduled Backups « Contents of backup location
s Restore

Note: DEFINITY ONE
applications are being
stopped as part of the restare
operation.

YWhen restore is done, you
will need to reboot the
system.

5. After the restore is completed, reboot the system.

=> NOTE:

C-30

A reboot is required. The restored translations will not be used if the

DEFINITY ONE is not rebooted.
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Recovery

This chapter provides information about system recovery. This chapter is
organized as follows:

= “DEFINITY ONE system level shutdown and restart” on page D-1

« [“DEFINITY software reset (recovery)’|on page D-4

« [‘Reset System 1 (DEFINITY warm start)”|on page D-4
« |‘Reset System 2 (DEFINITY cold start)”|on page D-4
« [‘Reset System 3 (DEFINITY reboot)”lon page D-5

« [‘Reset System 4 (DEFINITY reboot)”lon page D-5

« |‘Reset System 5 (System reboot)”’|on page D-5

When the system is initially powered up, or when an existing system experiences
a catastrophic fault that interrupts its basic functions, the system reboots.

DEFINITY ONE system level
shutdown and restart

The[following table] presents system level shutdown and restart actions that can
be initiated by the system technician, the customer, and by hardware. The state
of the shutdown and restart actions is indicated by the state of the LEDs on the
TN795 processor circuit pack (See [Appendix E).]More details about the use of
the user commands can be found in DEFINITY ONE Communications System
Release 2.0 Maintenance (555-233-111).
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Table D-1. Shutdown and restart actions
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Action Entry Originated by Action Notes

“reboot nice” | command technician Shuts down all Used for a system reboot
line entry applications with after changing an NT

[campon] .
from a bash campon to wait for level parameter that
session AUDIX users to requires a system reboot

logoff. The system

restarts automatically.

This may take an
unacceptably long time
due to campon of AUDIX
logons.

“reboot command technician Shuts down all

immediate” line entry applications without
from a bash waiting for AUDIX
session users to log off. The

system restarts
automatically.

Used for a system reboot
with a guaranteed reboot
time of a few minutes.
This action does not wait
for AUDIX users to be
logged off from AUDIX.

“shutdown command technician Shuts down

all” line entry application software

[campon] from.a bash while Igavmg NT up. )
session An optional “campon

option may be used
to wait for AUDIX
users to log off.

Used for system
upgrade. The campon
option may cause an
unacceptable wait time.
The “start all” command
can be used to restart
the application software.

“shutdown command technician Shuts down AUDIX

audix” line entry while leaving

[campon] from.a bash DEFIN]TY ard NT up;
session An optional “campon

option may be used
to wait for AUDIX
users to log off.

Used to shut down
AUDIX if the machine
name is changed. The
“start audix” command
can be used to restart
AUDIX. The campon
option may cause an
unacceptable wait time.

“shutdown command technician Shuts down the
system” line entry system without
from a bash restarting it An
session optional “campon”
[campon] options may by used

to wait for AUDIX
users to log off. The
system does not
restart automatically.

Used to shut down the
system in preparation for
removing AC power or
removing the TN795
Processor circuit pack.
The campon option may
cause an unacceptable
wait time.The system can
be restarted only by
removing and restoring
power or reseating the
TN795.

Continued on next page
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on the TN795

power.

Table D-1. Shutdown and restart actions — Continued
Action Entry Originated by Action Notes
“delayed web page technician/ Wait for AUDIX users | Used to shut down the
shutdown” from a web customer to log of f before system in preparation for
button browser starting a system removing AC power or
shutdown. The removing the TN795
system may or may Processor circuit pack
not restart
automatically,
depending on a
“restart” option.
“immediate web page technician/ Do not wait for AUDIX | Used to shut down the
shutdown” from a web customer users to log off before | system in preparation for
button browser starting a system removing AC power or
shutdown. The removing the TN795
system may or may Processor circuit pack
not restart
automatically,
depending on a
“restart” option.
shutdown Faceplate of | technician/ Shutdown the system | Used to shut down the
button onthe | the TN795 customer after closing all system in preparation for
faceplate of processor applications. The removing AC power or
the TN795 board system will not restart | removing the TN795
processor automatically. Processor circuit pack.
board The system can be
restarted only by
removing and restoring
power or reseating the
TN795.
Detection of Wiring from Loss of AC Shutdown the system | Provides a graceful
the loss of the UPS power for more | after closing all shutdown when AC
AC power by | Z3A2 alarm than one minute | applications. The power is lost for more
the UPS adapter to system will restart than one minute.
the Major automatically upon
Alarm lead restoration of AC
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DEFINITY software reset (recovery)

There are severe reset levels available to restart DEFINITY software. These resets
can be user initiated with the reset system n command (where n is the reset
level). They may also be automatically initiated by system software in response to
certain error conditions.

A system is reset due to a loss of power, or through:
» Reset commands entered during a SAT terminal session.

» Maintenance software, from which the system can reset itself. (This
process starts when certain software and hardware errors are detected by
the software.)

A WARNING:
When the system is rebooted or reset at level 2, 3, 4, or 5, all voice
terminal and attendant console features are adversely affected.
Users should be advised of services that are lost and that, as a
result, must be reactivated.

The SAT display and circuit pack LEDs indicate the progress of the recovery
process.

Reset System 1 (DEFINITY warm start)

» This recovery takes about 60 seconds.
» All software is reset.

» All stable phone calls remain up.

» In-progress calls are dropped.

» No new calls can be made during this time.

Reset System 2 (DEFINITY cold start)

The following are reset:
» All software
« TDM Bus
= All Port circuit packs

All telephone sessions are dropped. Telephones begin to reconnect to the switch
within 60 seconds.



DEFINITY ONE™ Communications System Release 2.0 Issue 2

Installation and Upgrades 555-233-109 June 2000
Recovery
DEFINITY software reset (recovery) D-5

Reset System 3 (DEFINITY reboot)

This is the same as Reset System 4 (see below). This command is retained for
consistency with other DEFINITY products.

Reset System 4 (DEFINITY reboot)

» Emergency Transfer is invoked in this reset.
= System processes are reloaded from hard disk into memory
= All port circuit packs are reset.

» All telephone sessions are dropped.

Telephones begin to reconnect to the switch within 60 seconds.

Reset System 5 (System reboot)

This is the same as Reset System 4 (see above).



DEFINITY ONE™ Communications System Release 2.0 Issue 2
Installation and Upgrades 555-233-109 June 2000

Recovery
DEFINITY software reset (recovery) D-6



DEFINITY ONE™ Communications System Release 2.0 Issue 2

Installation and Upgrades 555-233-109 June 2000
LED Boot Sequence/TN795 Processor
LED boot sequence E-1

LED Boot Sequence/TN795 Processor

This chapter provides information about the LED boot sequence of the TN795 cir-
cuit pack.

This chapter is organized as follows:

“LED boot sequence” on page E-1

= “TN795 processor circuit pack” on page E-1

= |“TN795 processor circuit pack LEDs (after booting)”|on page E-2

= [‘LED states”]on page E-5

LED boot sequence

The following describes the LED boot sequence.

TN795 processor circuit pack

When power is first applied to DEFINITY ONE, or when the system reboots, the
LEDs on the TN795 circuit pack will light according to this sequence:

1. All lights on the TN795 will rapidly blink in sequence, from bottom to top
(also known as “racing lights”).

2. Within 1 minute, the second light from the top will blink green:
= When the LED is more on than off it indicates BIOS loading
= More off than on indicates NT loading

3. The third LED from the top will blink amber to indicate application firmware
loading.



DEFINITY ONE™ Communications System Release 2.0 Issue 2

Installation and Upgrades 555-233-109 June 2000
LED Boot Sequence/TN795 Processor
LED boot sequence E-2

4. When firmware is loaded, the LEDs will blink in sequence again (racing

lights), then all LEDs will light and then go off.

The DEFINITY ONE system is now under normal operating conditions.
When the system is operating normally the following occurs:

» The amber LED (third from the top) will blink quickly once every 10
seconds, indicating the firmware/NT watchdog processes are
communicating.

» Another blinking LED (clock) flashes when the firmware for the
clock is communicating.

Any other LEDs that are illuminated indicate an alarm or problem with DEFINITY
ONE. For more information about alarms, see Chapter 6, DEFINITY ONE NT Log
Events and Alarms in DEFINITY ONE Communications System Maintenance,
(Document No. 555-233-111).

The emergency transfer LED is on if a reset 4 occurs or if power is cycled.

TN795 processor circuit pack LEDs (after booting)

The front panel has two groups of LEDs. One group indicates the status of the
pack, and the other group (which includes the Major, Minor, and Warning alarms)
reflects maintenance conditions in the entire system.

Red (alarm) — the system has detected a fault in this circuit pack.

=> NOTE:
Alarms on the PROCR, PR-MAINT, SW-CTL, and PKT-INT
maintenance objects are indicated by the red LED on the Processor
circuit pack.

Green (test) — the system is running tests on this circuit pack.

Amber — in an operating system, this LED indicates that the handshaking
between the firmware and the NT operating system is occurring by
flashing briefly once every 10 seconds.

PCMCIA (amber) — the flash disk is in use

MAJOR ALARMS (red)

MINOR ALARMS (red)

CLOCK (amber) — blinks once every 4 seconds.

EM XFER (red) — indicates emergency transfer has been invoked

=>» NOTE:
If the AC power cord is unplugged, the emergency transfer feature
invokes, however the EMERGENCY TRANSFER LED (red) is not lit
due to loss of AC power. The system gracefully shuts down in about
3 minutes.
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» OKREMOVE (green) — steady indicates that it is OK to remove the TN795
processor circuit pack.

A WARNING:

DO NOT REMOVE the TN795 circuit pack unless the Complete
Shutdown LED is illuminated. Failure to heed this warning may result
in loss of data and/or damage to equipment.
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Figure Notes

1. PCMCIA slots 6. Emergency Transfer On/Auto/Off
2. Red LED switch

7. Complete Shutdown — safe to pull
3. Green LED board when green LED is on steady
4. Amber LED 8. Shutdown switch — gracefully shuts
5. PCMCIA In Use LED down system

Figure E-1. TN795 circuit pack faceplate
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LED states

The following table summarizes the TN795 circuit pack LED states.

Table E-1. TN795 circuit pack LED states

Shutdown
Boot Sequence = 3 min., 45 sec. Sequepce Other
1-3min
k)
N
3 &
@ = = ©
£ | S 3 | E 8 g |3 | =
g = B S = S = = B
B 5 | & 8 g S c S g = 5
LED c £ kol ﬁ 2 -§ 2 5 o 8 i 8
I £ S =
LED name color g i o % 3 o § g._)J c % ® @
s | ¢ | E e | £ | 8 g g1 8| g
£ 8 B - E : 2 5 Q =
o po) = = =] ﬁ % é
Q @ v =3 &
0 5 g
o =
Q
(3o
<)
TN795CPA red on on on on on sw on on on on
Alarm
TN795 Test green off on flash flash off sw sw off on flash
1 3 2
TN795In yel- off off off off flash flash sw off on flash
Use low 2 4 2
PCMCIA yel- on on a sw sw sw a sw sw on off on
low w |
- -
2 2
Major Alarm red off off 2 off off off g sw sw off off off
4 o4
Minor Alarm red off off off off off sw sw off off off
Clock Status yel- off off off off off clk clk off off off
low
ETR red on on on on on sw sw on on on
OK to green off on on off off off flash3 on on off
Remove
|| — | @ (b) (© (d) C
40 40 80 30
Sec. sec sec Sec

flashl— 800ms ON, 200ms OFF

flash2— 500ms ON, 500ms OFF

flash3— 200ms ON, 800ms OFF

flash4— 200ms OFF on every sanity heartbeat
flash5— 1 sec ON, 1 sec OFF

sw— Software Controlled

clk— Similar to the TN2182 Tone/Clock LED
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Status LEDs

This chapter provides information about the Status LEDs.

This chapter is organized as follows:

« “Attendant console LEDs” on page F-1

“Other circuit packs” on page F-1

[“Circuit pack status LEDs” [on page F-2

[“Power supply LEDs"|on page F-3

Attendant console LEDs

The console has two red LEDs, labeled ALM and ACK. The left LED lights
steadily when there is a Major or Minor alarm at the switch cabinet. The right LED
lights steadily if the alarm has been successfully reported to INADS. If the system
is unable to report the alarm to INADS, the LED flashes, thus signaling the
attendant to call INADS and report the alarm. The system calls INADS
automatically if it uses a modem.

Other circuit packs

Some LEDs may be lit upon power up on the other circuit packs. Under normal
operation, LEDs should not light on the circuit packs, with the following
exception: A solid green LED on any circuit pack indicates that diagnostic tests
are being executed on that circuit pack.
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Circuit pack status LEDs

Each circuit pack has three LEDs on the front panel visible at the front of the
carrier. On all circuit packs, except the 650A Power Unit, the LEDs indicate:

1. Red (alarm) — If the circuit pack is communicating with the system, the
system has detected a fault in this circuit pack. An on-board alarm for this
circuit pack is displayed in the Alarm Log.

The circuit pack also lights this LED when either the circuit pack has not
yet initialized communication with the system or when the circuit pack
loses contact with the system and stops functioning (circuit pack is said to
be “in reset”). In these cases, there may not be an alarm in the Alarm Log.
To determine if the red LED is lit because the circuit pack is not in contact
with the system, issue the list configuration board PCSS command,
where PCSS refers to the slot containing this circuit pack. If the system
does not detect the circuit pack, this command returns | denti fi er not
assi gned or no board.

If the circuit pack has just been inserted, the system may still be initializing
the circuit pack. If, after 5 minutes, the circuit pack still has not initialized
communications with the system, check the MO for any special
instructions. If the MO does not provide the needed information, perform
the following steps:

» Check the Error Log for TONE-BD and TDM-BUS errors. Follow
appropriate sections for any TONE-BD and TDM-BUS errors.

» Reseat the suspect circuit pack.

A WARNING:
Reseating the TN795 may be very destructive. This should be done
only if the Complete Shutdown LED is illuminated. Otherwise, you
must shut down before reseating.
Wait 5 minutes. Then issue the list configuration board PCSS
command. If the result indicates that the system still has not
registered the circuit pack, go to next step.

» If the system seems to be functioning correctly, but the circuit pack
does not start communicating with the system, replace the circuit
pack.

2. Green (test) — the system is running tests on this circuit pack.

3. Yellow (busy) — indicates that the circuit pack is in use.
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=>» NOTE:

A port circuit pack also lights its red LED when it performs
initialization tests (for example, when the circuit pack is initially
inserted into the system). If all initialization tests pass, the red LED is
turned off. If any initialization tests fail, the red LED remains lighted
and the circuit pack is not placed into service.

During the various states of operation (start-up testing, normal operation,

circuit failure, and so forth) circuit pack status LED indications appear as
shown in Table F-1.

Table F-1. Control and port circuit pack status LEDs

Equipment

type LED Description

Port Circuit Red On briefly during power up, circuit pack
Packs reseating, resetting, and system reset.

Steadily on if circuit pack fails start-up test or
fails while in use. Off during normal
operation.

Green | Briefly on during circuit pack testing
following power up, circuit pack reseating,
and system reset. On during periodic,
scheduled, and system technician
demanded testing. Off during normal
operation.

Yellow | On when any port in the circuit pack is in
use, otherwise, off.

Power supply LEDs

Table F-2shows the LED and alarm conditions for the 650A Power Supply. Ring
voltage and neon bus output do not activate alarm status.
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Table F-2. LED and alarm conditions
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F-4

Condition LED status | Alarm state

Normal Red off; Open
Yellow on

No input power Red off; Closed
Yellow off

DC output not present | Red on; Closed

(except Neon) Yellow off

Fan alarm Red on; Closed

Yellow on
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GAS Commands in the bash shell

This chapter provides information about bash (Bourne Again Shell) commands
that are used in the installation process. It also includes information on the setip
command. These commands are not available to the customer.

Lucent access controller bash

commands

The following commands are useful during installation and maintenance tasks
and are allowed for the lucent logins. After opening the LAC bash shell, enter the
name of the command. Refer to DEFINITY ONE Release 2.0 Communications
System Maintenance (555-233-111) for more detailed information.

Table G-1. bash commands for lucent logins

Command Description

alarmorig Turns on alarm origination from the GAM (INADS)

alarmstat Gives global alarm status (major, minor, or none) for
the GAM, DEFINITY, and AUDIX

autobackup Enables and disables backup commands

backupparams Enables day and time destination

backupsource Selects the data to be backedup

cleargamalarm

Clears all GAM alarms after failure conditions are
repaired

Continued on next page
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Table G-1. bash commands for lucent logins — Continued

Command Description

dlbackup No help

dlrestore No help

dlstat Displays the status of all the application groups

running on the system.

Displays the current status of each application.
Applications states are: Up, Down, or Partially Up.

Displays all the processes associated with an
application regardless of its state.

downloadboot Enables download of boot image to firmware

identbackup No help

installbackup No help

installconfig Installs license file (INADS)

environment Displays the TN795 temperature and voltage ranges

ftpserv Enables the ftp service

fileversion Queries Windows NT for executable file

fwversion Displays command version number

gamalarmstat Displays GAM alarm information formatted as
follows:

mm/dd/yyyy = month/day/year

NT Event Log Name= System | Security |
Application

Alarm Source= NT | GAM | LAC | GSK | VFM | GAS
NT Event Type = Error | Warn | Info

Alarm Type = Major | Minor

Event ID= Event field in NT Event Log

ACKed= ACKed, NACKED, FAILURE, NO_OSS_

RESPONSE
lucent help Lists all bash commands
net user Used to add/activate logins, change passwords
0SS Sets telephone numbers for outgoing INADS calls

Continued on next page
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Table G-1. bash commands for lucent logins — Continued

Command

Description

pcAnywhere

If no argument is given, pcAnywhere will start. If? is
typed, help is displayed, if -v is typed, the version of
the command is displayed, and if -c is typed,
pcAnywhere is stopped.

post

If no argument is given, postcodes are sent to the
860 firmware with the results sent to standard
output.

product id

If no argument is given, the command displays
product-id information for GAM and AUDIX.

rasdrop

If no argument is given, rasdrop schedules the RAS
service to stop and restart in 2 minutes from when it
was run.

reboot

Reboots system as follows:

nice: Shuts down applications and Windows NT in a
graceful manner

immediate: reboots the system without waiting for
the applications to shut down, causing possible loss
of voice messages that are being recorded and all
calls drop

restartcause

Displays the restart causes for system (for
technician/TSC)

serialnumber

Reads and displays the serial number of the circuit
pack

setip Sets the IP address, subnet mask, and default
gateway of the LAN interface to the customer’s LAN
(out the splitter cable). Turns on RAS. Reboot is
required for this to take effect.

shutdown Shuts down:

all: Lucent DEFINITY ONE applications

system: all Lucent DEFINITY ONE applications and
Windows NT

appname: AUDIX. For example: Shutdown AUDIX.

camp-on: (optional AUDIX feature) notifies users
that a system shutdown will happen and waits for
users to end their sessions before shutting down.

Continued on next page
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Table G-1. bash commands for lucent logins — Continued

Command Description

siteconfig Prompts the user with a warning message and
request confirmation

start Called from a bash shell on Contry to start an
application through Watchdog.

swversion

terminate Called from a bash shell on Contry to terminate
applications

versiondiff Compares NT executables against version entered
at the command line

vilog Merges and displays the various log files in the

system

LAC commands

Table G-2. LAC commands

Command Description

AUDIX Connect to INTUITY AUDIX
SAT

bash Invokes the bash shell, The
bash shell has commands
that are useful for
administration and
installation.

DEFINITY Connect to SAT

cmd Brings up a DOS prompt

exit exits the bash shell

installconfig Install configuration

siteconfig Sets passwords for NT

Administrator and Guest
logins (Ntadmin, user)
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setip command

Use the setip command from a LAC bash shell to set certain NT specific set-
tings. To get to a bash shell:

1. Telnet to the DEFINITY ONE over any interface.
2. Login.
3. Enter bash at the LAC prompt.

Once you are in a LAC bash shell you can run setip.

=>» NOTE:

Setip settings require a reboot before taking effect. Set all necessary
parameters before issuing the reboot command.

Displaying current settings

To display current settings, Run setip with no parameters.

Setip allows setting the customer’s LAN address along with subnet mask,
gateway, DNS and WINS settings. It also allows setting the machine name and
the RAS IP addresses.

Setting the machine name in NT
To set the machine name:

1. In abash shell, type setip name=machineName. Limit the machine name
to 10 characters. Setip allows you to enter more characters; however
AUDIX only displays the first 10 characters of the machine name in its
administration window.

Ex: setip name=mysite

=>» NOTE:

After having set the machine name, the setip command displays the
new settings and the old settings.

=>» NOTE:

You will also need to set the host name. See[*Setting DNS addresses|
[and host name” |on page G-6
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Setting RAS IP address

=>» NOTE:
INADS will provide this IP address.

To set the RAS IP address:
1. In a LAC bash shell, type setip ras=<ip-address>

Ex: setip ras=10.21.0. 53

=> NOTE:

This command not only sets the RAS IP address, it also starts the
service. Turn off RAS service if system is set up without a modem.

After having set the RAS IP address, the setip command displays the new
settings and as the old settings.

Setting the customer’s LAN, DNS and WINS
information

Setting LAN address
To set the customer LAN address:

1. Getthe IP address, subnet mask, and default gateway addresses from the
customer.

2. From a LAC bash shell, run the setip cust=ip-addr,netmask[,gateway].
The gateway address is optional but the ip-address and subnet mask are

required.
Ex: setip cust=155.9.162.121,255.255.255.0,155.9.162.2

After setting the customer’s IP address, the setip command displays the new
and the old settings.

Setting DNS addresses and host name

If the customer is using DNS you can set DNS information with the setip
dns=name,domain-name,primary-ns-ip-addr[,secondary-ns-ip-address],
This sets the DNS host name, domain name, and the list of name server IP
addresses.

The customer may have one, two, or more different domain name servers (DNS).

Ex: setip dns=CustomerHost,CustomerDomain.com,155.9.1.10,155.9.15.14

After having set the customer’s DNS IP addresses, the setip command displays
the old settings as well as the new settings.
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Setting WINS addresses

If the customer is using WINS you can set WINS information with the setip
wins=[ip-addr-primary[,ip-addr-backup]]. This will set the IP address of the
primary and secondary IP addresses for the windows NetBios on the TCP name
server.

Ex: setip wins=155.9.145.1,155.9.145.4

After setting the customer’s WINS IP address, the setip command displays the
new and the old settings.

Once you have set all the appropriate settings for your location, enter reboot nice
to restart the system with the new settings.

Other commands

ftpserv command

The ftpserv command is executed from a console bash shell and turns on the
FTP server. If you attempt to ftp into the DEFINITY ONE and receive a connection
refused message, then ftp is not running.

To turn on ftp enter: ftpserv

To turn off ftp enter: ftpserv -c

pcAnywhere command

The pcAnywhere command turns the pcAnywhere host service on and off.
To turn on pcAnywhere enter pcanywhere.
To turn off pcAnywhere enter pcanywhere -c.

dlstat command

The dlstat command is used from a LAC bash shell to determine the current sta-
tus of each application.

Ex. estonia-lucentl>d1stat

NT 11/11 UP
NTr as 2/ 2 UP
NTweb 1/ 1 UP
pcAnywher e 0/ 1 DOMN
NTconsol e 2/ 2 UP
NTpl at f orm 6/ 6 UP
CoResSer v 5/ 5 UP
DEFI NI TY 51/51 UP
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Cor ner St one 4/ 4 UP
AUDI X 15/ 33 PARTI ALLY UP
AUDI XNet 0/ 5 DOWN
M SC 24/ 0 UP

estoni a-l ucent 1>

net user commands
The net user commands manipulate NT level logins on the DEFINITY ONE sys-
tem and can be used to add new logins, change passwords on existing logins, or
simply to enable/disable existing NT accounts.
To add a new user, execute the following command from a bash shell:

net user username password

To change the password of an existing login, execute the following command
from a bash shell:

net user username newpassword

To enable an existing login that is disabled, execute the following command from
a bash shell:

net user username /active
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This appendix provides a tear-out quick reference sheet about connectivity,
including physical connection, access, and login information.

Physical Connection IP Address
Local Monitor/Mouse/Keyboard 127.1
PCMCIA Network Connection 192.11.13.6

RAS Modem (Dial-up)

10.21.0.X (X is Customer
Dependent — Lucent Assigned

Customer’s LAN

Customer Dependent (default login
value of 192.11.13.9)

Once connected, there are several ways to access DEFINITY ONE, as shown in

the next table.

Access Method

Telnet

<ip addr> [Start > Run...]

DSA

using appropriate ip-addrs

Web Browser

http://<ip-addr>

pcAnywhere

use appropriate ip-addrs
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The following table shows Lucent Personnel Login information.

Logins to enter

Logins to enter

system DEFINITY Logins to enter AUDIX
lucentl dinit atsc

lucent2 dinads acraft

lucent3 dcraft acraft

» Each row of logins has the same password. For example, the lucentl,
dinit, and atsc logins all have the same password.

» The lucent logins are used for web browser and pcAnywhere access.

= All logins can be used for telnet access.

» The d and a logins (columns 2 and 3) are used for DSA access.
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A
AAR

See Automatic Alternate Routing (AAR).

AC
1. Alternating current.

2. See analog.

Access Security Gateway (ASG)
A feature built into the Lucent Access Control (LAC) module that authenticates and protects logins
to the LAC.

administer
To access and change parameters associated with the services or features of a system.

analog
The representation of information by continuously variable physical quantities such as amplitude,
frequency, and phase. See also

analog data
Data that is transmitted over a digital facility in analog (PCM) form. The data must pass through a
modem either at both ends or at a modem pool at the distant end.

analog telephone
A telephone that receives acoustic voice signals and sends analog electrical signals along the
telephone line. Analog telephones are usually served by a single wire pair (tip and ring). The
model-2500 telephone set is a typical example of an analog telephone.

ARS
SeeAutomatic Route Selection (ARS).

ASCII (American Standard Code for Information Interchange)
The standard code for representing characters in digital form. Each character is represented by an
8-bit code (including parity bit).

Audio Information Exchange (AUDIX)
A fully integrated voice-mail system. Can be used with a variety of communications systems to
provide call-history data, such as subscriber identification and reason for redirection.

AUDIX
See Audio Information Exchange (AUDIX).

Automatic Alternate Routing (AAR)
A feature that routes calls to other than the first-choice route when facilities are unavailable.

Automatic Route Selection (ARS)
A feature that allows the system to automatically choose the least-cost way to send a toll call.
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B

Basic Rate Interface (BRI)
A standard ISDN frame format that specifies the protocol used between two or more communica-
tions systems. BRI runs at 192 Mbps and provides two 64-kbps B-channels (voice and data) and
one 16-kbps D-channel (signaling). The D-channel connects, monitors, and disconnects all calls.
It also can carry low-speed packet data at 9.6 kbps.

Bash (Bourne Again Shell)
Unix-like command line interpreter.

C

cabinet
Housing for racks, shelves, or carriers that hold electronic equipment.

cable
Physical connection between two pieces of equipment (for example, data terminal and modem) or
between a piece of equipment and a termination field.

cable connector
A jack (female) or plug (male) on the end of a cable. A cable connector connects wires on a cable
to specific leads on telephone or data equipment.

call accounting system (CAS)
This software feature provides recording, costing, and reporting of call detail records. Recording
includes the capability to set record discard criteria that allow the customer to specify the data
recorded. Costing uses tariff databases and user-defined parameters. Reporting produces both
periodic reports for individual users, organizations, accounts, user-defined criteria, and demand
statistics.

Call Detail Recording (CDR)
Textual Representation of call traffic

carrier
An enclosed shelf containing vertical slots that hold circuit packs.

CAS
See call accounting system (CAS)

central office (CO)
The location housing telephone switching equipment that provides local telephone service and
access to toll facilities for long-distance calling.

central office (CO) codes
The first three digits of a 7-digit public-network telephone number in the United States.

central office (CO) trunk
A telecommunications channel that provides access from the system to the public network through
the local CO.

circuit
1. An arrangement of electrical elements through which electric current flows.
2. A channel or transmission path between two or more points.
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circuit pack

A card on which electrical circuits are printed, and IC chips and electrical components are
installed. A circuit pack is installed in a switch carrier.

communications system
The software-controlled processor complex that interprets dialing pulses, tones, and keyboard
characters and makes the proper connections both within the system and external to the system.
The communications system itself consists of a digital computer, software, storage device, and
carriers with special hardware to perform the connections. A communications system provides
voice and data communications services, including access to public and private networks, for
telephones and data terminals on a customer’s premises. See also

compact modular cabinet (CMC)
The chassis and shelf hardware used to support the DEFINITY ONE hardware platform, derived
from (actually the same as) the DEFINITY ProLogix cabinet.

digital
The representation of information by discrete steps. See also

digital trunk
A circuit that carries digital voice and/or digital data in a telecommunications channel.

E

El
A digital transmission standard that carries traffic at 2.048 Mbps. The EL1 facility is divided into 32
channels (DS0s) of 64 kbps information. Channel 0 is reserved for framing and synchronization
information. A D-channel occupies channel 16.

F

FAC
Feature Access Code

FAS
Facility-associated signaling

G

GAS
See Global Administration Subsystem (GAS)

GEDI
Graphically Enhanced DEFINITY interface. Is an enhanced system access terminal (SAT) with a
Windows look.

Global Administration Subsystem (GAS)
A module that provides command line access to certain administration and maintenance functions
needed by services tools and provides administration support for parameters in the
DEFINITY ONE system that are not otherwise provided by the DEFINITY ONE applications.
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Global Alarm Module (GAM)
A Windows NT process that coordinates alarm reporting for the DEFINITY ONE platform. Its pri-
mary functions are to accept and forward alarms from the applications, generate alarms for Win-
dows NT, and manage the communication links to the Operations Support Systems (OSSs) via the
Windows NT TAPI interface.

Global Sanity Keeper (GSK)
A module that ensures that all authorized Lucent applications are executing on a DEFINITY ONE
server. It contains two major components, a watchdog process and a license server.

Glue Application/Module
A DEFINITY ONE application whose purpose is to integrate functionality for most or all other
DEFINITY ONE applications. Examples include Watchdog, Lucent Access Control (LAC), Global
Alarm Module (GAM), Global Administration Subsystem (GAS), and Backup/Restore.

Graphical User Interface (GUI)
The use of pictures rather than just words to represent the input and output of a program. A pro-
gram with a GUI runs under some windowing system (for example, X Window System, Microsoft
Windows, Acorn RISC OS, and NEXTSTEP). The program displays certain icons, buttons, dialogue
boxes etc., in its windows on the screen and the user controls it mainly by moving a pointer on the
screen (typically controlled by a mouse) and selecting certain objects by pressing buttons on the
mouse while the pointer is pointing at them.

Integrated Services Digital Network (ISDN)
A public or private network that provides end-to-end digital communications for all services to
which users have access by a limited set of standard multipurpose user-network interfaces
defined by the CCITT. Through internationally accepted standard interfaces, ISDN provides digital
circuit-switched or packet-switched communications within the network and links to other ISDNs to
provide national and international digital communications. See also Integrated Services Digital
Network Basic Rate Interface (ISDN-BRI) and Integrated Services Digital Network Primary Rate
Interface (ISDN-PRI).

Integrated Services Digital Network Basic Rate Interface (ISDN-BRI)
The interface between a communications system and terminal that includes two 64-kbps B-chan-
nels for transmitting voice or data and one 16-kbps D-channel for transmitting associated B-chan-
nel call control and out-of-band signaling information. ISDN-BRI also includes 48 kbps for
transmitting framing and D-channel contention information, for a total interface speed of 192 kbps.
ISDN-BRI serves ISDN terminals and digital terminals fitted with ISDN terminal adapters. See also
Integrated Services Digital Network (ISDN) andintegrated Services Digital Network Primary Rate
Interface (ISDN-PRI).

Integrated Services Digital Network Primary Rate Interface (ISDN-PRI)
The interface between multiple communications systems that in North America includes 24
64-kbps channels, corresponding to the North American digital signal level-1 (DS1) standard rate
of 1.544 Mbps. The most common arrangement of channels in ISDN-PRI is 23 64-kbps B-channels
for transmitting voice and data and 1 64-kbps D-channel for transmitting associated B-channel call
control and out-of-band signaling information. With nonfacility-associated signaling (NFAS),
ISDN-PRI can include 24 B-channels and no D-channel. See alsolntegrated Services Digital Net-
work (ISDN) andIntegrated Services Digital Network Basic Rate Interface (ISDN-BRI).

INTUITY AUDIX
The INTUITY AUDIX application resides on DEFINITY ONE with the Cornerstone platform to provide
subscriber messaging capabilities, including call answering and voice mailbox services.
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INTUITY Message Manager
A Windows-based software product that allows INTUITY AUDIX users to receive, store, and send
their voice/fax messages from a PC. The software also enables users to create and send multime-
dia messages that include voice, fax, text, and file attachment components

ISDN
See|Integrated Services Digital Network (ISDN).|

L

LAC
See Lucent Access Control (LAC)

LED
See light-emitting diode (LED).

License Server
A component of the Global Sanity Keeper (GSK) that looks for a special encrypted control file
whose contents indicate which serial number of the TN795 Processor card is permitted to execute
on and which application are allowed to run. If the file is not present, no licenses are granted. If the
file is present, the license information is read from the file.

light-emitting diode (LED)
A semiconductor device that produces light when voltage is applied. LEDs provide a visual indica-
tion of the operational status of hardware components, the results of maintenance tests, the alarm
status of circuit packs, and the activation of telephone features.

local area network (LAN)
A networking arrangement designed for a limited geographical area. Generally, a LAN is limited in
range to a maximum of 6.2 miles and provides high-speed carrier service with low error rates.
Common configurations include daisy chain, star (including circuit-switched), ring, and bus.

Lucent Access Control (LAC)
A module that governs maintenance access to the Lucent application software.

M

maintenance
Activities involved in keeping a telecommunications system in proper working condition: the detec-
tion and isolation of software and hardware faults, and automatic and manual recovery from these
faults.

major alarm
An indication of a failure that has caused critical degradation of service and requires immediate
attention. Major alarms are automatically displayed on LEDs on the attendant console and mainte-
nance or alarming circuit pack, logged to the alarm log, and reported to a remote maintenance
facility, if applicable.

MAPD
Multiapplication platform for DEFINITY

memory
A device into which information can be copied and held, and from which information can later be
obtained.
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minor alarm
An indication of a failure that could affect customer service. Minor alarms are automatically dis-
played on LEDs on the attendant console and maintenance or alarming circuit pack, sent to the
alarm log, and reported to a remote maintenance facility, if applicable.

modem
A device that converts digital data signals to analog signals for transmission over telephone cir-
cuits. The analog signals are converted back to the original digital data signals by another modem
at the other end of the circuit. (MOdulator-DEModulator)

multileg cable, also called an octopus cable or a splitter cable
Processor interface cable

N

NFAS
See Nonfacility-associated signaling (NFAS).

node
A switching or control point for a network. Nodes are either tandem (they receive signals and pass
them on) or terminal (they originate or terminate a transmission path).

Nonfacility-associated signaling (NFAS)
A method that allows multiple T1 and/or E1 facilities to share a single D-channel to form an
ISDN-PRI. If D-channel backup is not used, one facility is configured with a D-channel, and the
other facilities that share the D-channel are configured without D-channels. If D-channel backup is
used, two facilities are configured to have D-channels (one D-channel on each facility), and the
other facilities that share the D-channels are configured without D-channels.

NT Operating System
The Windows 32-bit operating system engineered by Microsoft. NT Servers provided centralized
security, fault tolerance and additional connectivity while managing NT Workstations over a net-
work.

O

Oryx APl (OAPI)
Terminates the Oryx calls from the DEFINITY application and converts them to Windows NT primi-
tives. Provides information through optical calls (for example, time of day and RYON board serial
number) and supports the DEFINITY SAT interface.

0SS
Operations Support System

Ossl
Operational Support System Interface

P

PCMCIA
Personal Computer Memory Card International Association
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port
A data- or voice-transmission access point on a device that is used for communicating with other
devices.

port network (PN)
A cabinet containing a TDM bus and packet bus to which the following components are con-
nected: port circuit packs, one or two tone-clock circuit packs, a maintenance circuit pack, service
circuit packs, and (optionally) up to four expansion interface (El) circuit packs in DEFINITY ECS.
Each PN is controlled either locally or remotely by a switch processing element (SPE).

port-network connectivity
The interconnection of port networks (PNs), regardless of whether the configuration uses direct or
switched connectivity.

Primary Rate Interface (PRI)
A standard ISDN frame format that specifies the protocol used between two or more communica-
tions systems. PRI runs at 1.544 Mbps and, as used in North America, provides 23 64-kbps
B-channels (voice or data) and one 64-kbps D-channel (signaling). The D-channel is the 24th
channel of the interface and contains multiplexed signaling information for the other 23 channels.

processor interface cable

Octopus cable, splitter cable, or multileg cable. See|Chapter 1.

processor port network (PPN) control carrier
A carrier containing the maintenance circuit pack, tone/clock circuit pack, and SPE circuit packs
for a processor port network (PPN) and, optionally, port circuit packs.

R

remote maintenance board (RMB)
A board provided in adjunct processors that intelligently monitors the system hardware for health
status. These include environmental conditions, PC heartbeat, and sanity checks. The RMB func-
tionality also allows modem access to the TN parent board.

RS-232C
A physical interface specified by the Electronic Industries Association (EIA). RS-232C transmits
and receives asynchronous data at speeds of up to 19.2 kbps over cable distances of up to 50
feet.

S

Sanity Keeper
See Global Sanity Keeper.

single-carrier cabinet
A combined cabinet and carrier unit that contains one carrier. See also |mu|ti|eg cable, also called|
lan octopus cable or a splitter cable|

Station Message Detail Recording (SMDR)
This software feature transmits detailed information on all incoming and outgoing calls on speci-
fied trunk groups through an switch processing element (SPE) port to an external output device,
that logs the data. SMDR is one facet of the more general Call Detail Recording (CDR) feature.

switch
Any kind of telephone switching system. See also [communications system |
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switch-processing element (SPE)
A complex of circuit packs (processor, memory, disk controller, and bus-interface cards) mounted
in a PPN control carrier. The SPE serves as the control element for that PPN and, optionally, for one
or more EPNSs.

system administrator
The person who maintains overall customer responsibility for system administration. Generally, all
administration functions are performed from the Management Terminal. The switch requires a spe-
cial login, referred to as the system administrator login, to gain access to system-administration
capabilities.

T

TCP/IP
Transmission Control Protocol/Internet Protocol

U

Update
A modification to a release of software, such as applying patches to a DEFINITY ONE Release 2.0
system.

Upgrade
Replacement of an existing system software release with a later release, such as upgrading from
DEFINITY ONE Release 1.0 to Release 2.0.

Vv

Virtual Fabric Manager (VFM)
A module that allows the use of DEFINITY ECS code in a hardware environment that differs from
the one for which it was designed. One side of the VFM talks to DEFINITY ECS in protocols it
understands and changes these into methods and messages to perform needed operations in the
DEFINITY ONE environment.

w

Watchdog
A component of the Global Sanity Keeper (GSK) that is responsible for starting up the DEFINITY
ONE application software, including the downloading of the MPC860 application firmware. Watch-
dog is the first DEFINITY ONE process to run.
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25-pair cable pinout,[1-70

302C1 attendant consoles,|1-40

367A adapter,|1-61

3-pair and 4-pair modularity, [1-49

400B2 adapters,|1-42

A

AC load center,[1-12

AC power

checking,[1-12

ground wiring,[1-16

AC power and ground,|1-12

AC power supply.[1-12

AC voltage test,[1-12

accounting

set up system,[3-11

adapters

400B2,L1-

BR851-B,|1-60

adding

circuit packs,|6-2

CO trunk,[6-2

code calling access |6-6

DID trunk,[6-3

FX trunk,[6-2

PCOL trunk,|6-2

pooled modem,|6-7

remote machines,|4-12

speech synthesis,|6-6

tie trunk,L6-

WATS trunk,(6-2

adjunct power, [1-42

adjunct power connection, [1-42

administering

DEFINITY for AUDIX initialization,|3-13

administering circuit packs,[3-10

administration

AUDIX, [3-22

initial tasks,|4-2

digital networkin -1
modem,|9-5

alarm

connections,[1-53

origination disable procedure,|9-5

relay contact,|1-53

alarm output,|1-53

analog tie trunk,[1-45

APP connector inforI&tioIQMW-lﬂtolA-lg
approved grounds,|1-13,11-16
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attendant console,[1-40

302C1,l1-40

maximum cabling distance, [1-40

attendant consoles

302C1,]1-40

LEDs,[E-1

AUDIX administration,|3-22

AUDIX commands,|3-23

AUDIX initialization,[3-13

add stations,[3-17

add test plans,[3-22

change coverage plan,[3-21

check class of restriction,|3-15

check class of SIM,MS-M
check dial plan,13-13

check hunt groups,|3-13

make a hunt group,13-20

AUDIX networking, [4-1

auxiliary equipment pin designations,|A-17[to|A-1

auxiliary equipment pinout information,[1-40,1A-6 JA-13

auxiliary power, [1-55

B

backup procedures,[C-18

bit rate

setting, |A-4

BR851-B adapter,|1-60

BRI

multipoint cabling distances,|1-62

terminating resistor,|1-56

building steel

grounding,|1-13

C

cabinets

cross connecting to MDF,[1-24

floor-mounting,[1-7

power switches,|1-15

wall mounting, [1-8

cable

diagrams,|1-40

pinout

25-pair,|];-7o
cable pinouts,[A-1

cables

diagrams, |A-6,|A-13,| A-17| to |A-19
call accounting,|3-11

Call Accounting System (CAS) for Windows,[3-11

carrier address 1D

setting,[1-6

CAS for Windows

setting, [3-11

change machine command, |4_7
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change machine remote_machine_name,|4-15

change machine remote_machine_name command,{4-15

change system-parameter limits command,|4-5

changing customer options,[3-7

check AC power,[1-12

Circuit Pack

TN750C,|6-9

circuit pack

TN795,|5-2

Circuit packs

slot loading,|1-29

circuit packs

adding,16-2

administering,[3-10

allowable for CMC,|1-24
complete list,|1-24

installation,|1-29

installation order,|1-31

LEDs,[E-2
pin designations,|A-17]to|A-19

status LEDs,[E-3

TN2185 ISDN-BRI 4-wire S Interface |A-12

TN2224 Digital Line,[A-10,]A-16

TN744D call classifier/tone detector,[1-29

TN795 processor,|1-29

circuit protection

off premises,[1-33

CMC cabinet

equipment packed with,[1-3

CMCs

allowable circuit packs,[1-24

CO trunk, adding,|6-2

code calling access, adding,[6-6

cold starts

with translations loading,[D-5

comcodes

equipment packed with CMC,|1-4

commands,[4-15

categories,|B-11

change machine,[4-7

change system-parameter limits,[4-5

DEFINITY for user,|B-11

commercial AC power,|1-12

components

unique to DEFINITY ONE,|1-2
concrete encased ground,|1-13

configuring

customer LAN,|2-11

Connect

laptop,[3-2

connect

adjunct power, [1-42

connect AC power,|1-12

connect power cords,[I-18

connecting

management terminal,|1-40

connecting laptop computer,|C-2

connections
ITS

network,|6-16
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copy protection,[10-2
coupled bonding conductor,[1-17.{1-18

coupled bonding conductors (CBC)

installing,[1-18

Create a connection icon for DEFINITY ONE,[2-3
customer LAN

configuring,[2-11

customer options

changing,[3-7

customer’s order

checking,[1-2

D

date

setting,[3-6

DC power

signaling leads [A-1

DEFINITY logins,|B-9

DEFINITY Site Administration, [Z-1

DEFINITY Site Administration (DSA)| 7-1

defragment

Diskeeper,[5-6

digital networking,4-1

adding remote machines,|4-12

administering networking channels,|4-6

changing local machine information,|4-7

changing local machine profiles,|4-Z

completing remote machine profiles, [4-15
feature options,|4-3

initial administration, [4-1

local machine information,|4-7

networking channels,|4-6

number of users,|4-5

remote machine Qrofiles,|4-15
remote users,|4-5

verifying purchased options.[4-3

digital tie trllm,udg
Diskeeper,|5-6

DSA[Z-1

adding new switch configuration,|7-8

adding new voicemail item.[7-16

components,[7-4

configuring,|7-7

download,|3-25

hardware configuration,|7-2

help,|7-7

launching emulation session, [/-22

launching GEDI session,[7-21

launching voicemail administration session,l 7-23

logins, [B-13

start a session,|3-30

switches, [7-2

voicemail [ 7-2
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electrical connection[1-12

emergency transfer power panel1-55]1-68
emergency transfer telephone, [L-75

equipment

checking,[1-2

comcodes for CMC equipment,[1-4
packed with CMC cabinet,{1-3

unpacking,[1-2

equipment checklist,|C-2

equipment room hardware

installing,[1-24

error messages

installation wizard,[9-2

external modem

installing,[1-23

U.S. Robotics,[1-23 [T-77

external modem option settings,[1-23J1-77

external modems

type-approved,|1-23

F

faceplates

TN795 processor circuit packs,|1-39.IF-4

feature protection,[10-1

flash disk

replace,|5-6

floor grounds,[1-14

floor-mount cabinet,[1-7

FX trunk, adding,|6-2

G

ground

rings,[1-13

Ground Block Installation to Right Panel, |1-16

ground blocks

installing,|1-16

ground wiring

AC,[1-16

grounds

approved floor,|1-14

building steel,[1-13

concrete encased,|1-13

water pipes, [1-13
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H
hard disk

replacing,[5-4 |
hardware

additions, [6-1 |
hunt groups,[3-13 |
|

impedance, setting,[A-4

INADS

Modem,|9-5

initialization

AUDIX, [3-22

install circuit packs,[1-29

install coupled bonding conductors,|1-18

install equipment room hardware [1-24

install external modem,|1-23

install ground block,[1-16

install main distribution frame and external modem,[1-21

install sneak fuse panels,[1-

install system cabinet,{1-6

install telephones,|1-40

installation error messages,| 9-2

integration process
connecting

ITS components,|6-16

ITS to the network,|6-16

Internet Telephony Server

connecting components, |6-16

logging on, 6-17

network services, changing,[6-18

IP address

assign,| 6-18

IP Trunk,|6-13

ISDN
BRI

fanout of multipoint installations,| 1-62

terminating resistor,[1-56

L

label main distribution frames,|1-37

labels

main distribution frame,|1-37

LAN

IP Trunk,|6-13

LAN connection,|6-20
LAN interface,|3-7
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connecting,[C-2

mapping DEFINITY ONE to CD-ROM drive,|C-13

verifying connection,|C-11

lead designations,|A-6

port board, [1-55

telephones,[1-55

LEDs

alarms,[E-2

attendant console,|F-1

circuit packs,lE-2

indicators on maintenance/processor circuit packs,|E-2

power supply,lE-3

TN795 processor circuit packs, [E-2

License File,|3-3

local machines

changing information,[4-7

logging on to the ITS,16-17

login groups,|B-3

login names,|B-3

logins

administering command permissions, [B-11

AUDIX,|3-5

AUDIX commands, [B-4

AUDIX with ASG enabled,[7-9.17-17

customer,[3-5,13-6

customer AUDIX,[B-

customer DEFINITY,|B-9

customer Web access,|B-5

customer Windows NT,[B-3.1B-7

web,[3-6

M

main distribution frames

installing_external modem,|1-21

labeling,|1-37

major alarm contact,| 1-53

mapping

DEFINITY ONE to laptop computer's CD-ROM drive,[C-13

Material Stocking Location (MSL),[1-2

MDF mounting,[1-21

MDFs

cross connecting cabinet,[1-24

measurements

security,[B-10

Message Manager

automated installation |8-15

downloading,[B-13

features,|8-1

install [3-25

installation types,|8-4

installing,[8-1

installing from LAN ser\I/e_r,]ﬁ;ﬁ_[ﬁ;u
installing shared copy,18-10

introduction, [8-1

operating system considerations,|8-4
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pre-installation procedures,|8-2

single user installation,|8-8

uninstalling,|8-7

updating site-specific information,[8-17

upgrades,|8-6

modem

administration,[9-5

external, switch settings,[1-23 [1-77

INADS.19-5

setup,l9-5

modem, pooled,[6-7

modems

installing external,[1-23

modularity

3-pair,[1-49

4-pair,11-49

Mounting MDFs, [1-21

multipoint

figure,|1-62

multipoint adapters,|1-60

N

name
domain,[6-17 |
server,|6-17 |

National Electrical Code (NEC)

grounding rules,[1-12

National Fire Protection Agency (NFPA),[1-12

neon voltage (ring ping),[1-78

network
configuration

changing network services,|6-18

logging on,[6-17

ITS

connecting,|6-16

networking channels

digital networking,[4-6

nonadministered remote users

deleting,|4-21
NT1 network interface [ 1-56

@)

off-premises circuit protection,|1-33

off-premises stations,|1-63

order,|[1-31
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P

Password Expiration screen,|B-12

PCMCIA Flash disk

replace, [5-6

PCOL trunk, adding,[6-2

pin designations

auxiliary equipment,lA-17/tolA-19

circuit packs,@tolA-lQ
pinout information

auxiliary equiplm'ﬂﬁ?_h-_ﬁ_lﬁ-l?,
circuit packs,1-40 JA-6 JA-13
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